Magnetic Property Measurement System

MPMS MultiVu Application User’s Manual

Part Number 1014-110C
Quantum Design
6325 Lusk Blvd.
San Diego, CA 92121
USA
Technical support (858) 481-4400
(800) 289-6996
Fax (858) 481-7410


Trademarks
All product and company names appearing in this manual are trademarks or registered trademarks of their respective holders.

U.S. Patents
4,791,788 Method for Obtaining Improved Temperature Regulation When Using Liquid Helium Cooling
4,848,093 Apparatus and Method for Regulating Temperature in a Cryogenic Test Chamber
5,053,834 High Symmetry DC Squid System
5,110,034 Superconducting Bonds for Thin Film Devices
5,139,192 Superconducting Bonds for Thin Film Devices
5,311,125 Magnetic Property Characterization System Employing a Single Sensing Coil Arrangement to Measure AC Susceptibility and DC Moment of a Sample (patent licensed from Lakeshore)
5,319,307 Geometrically and Electrically Balanced DC Squid System Having a Pair of Intersecting Slits
5,647,228 Apparatus and Method for Regulating Temperature in Cryogenic Test Chamber

Foreign Patents
U.K. 9713380.5 Apparatus and Method for Regulating Temperature in Cryogenic Test Chamber
Canada 2,089,181 High Symmetry DC Squid System
Japan 2,533,428 High Symmetry DC Squid System
Japan 2,533,428 High Symmetry DC Squid System
PREFACE  
Contents and Conventions .............................................................................................................................. xiii  
P.1 Introduction ..................................................................................................................................................... xiii  
P.2 Scope of the Manual ........................................................................................................................................ xiii  
P.3 Contents of the Manual .................................................................................................................................. xiii  
P.4 Conventions in the Manual ............................................................................................................................ xiv  

CHAPTER 1  
Introduction to MPMS MultiVu ......................................................................................................................... 1-1  
1.1 Introduction ..................................................................................................................................................... 1-1  
1.2 Overview of the MPMS MultiVu Application .............................................................................................. 1-1  
1.2.1 Immediate Mode and Sequence Mode Operation ..................................................................................... 1-1  
1.2.2 Data Viewing ............................................................................................................................................. 1-2  
1.2.3 Comparison with the MPMSR2 DOS Software ....................................................................................... 1-2  
1.3 Starting Up MPMS MultiVu ........................................................................................................................... 1-3  

CHAPTER 2  
MPMS MultiVu Interface .................................................................................................................................. 2-1  
2.1 Introduction ..................................................................................................................................................... 2-1  
2.2 Function of the MPMS MultiVu Interface ...................................................................................................... 2-1  
2.2.1 MDI Application Interface ....................................................................................................................... 2-1  
2.3 Features of the MPMS MultiVu Interface ..................................................................................................... 2-2  
2.3.1 Menu Bar .................................................................................................................................................. 2-3  
2.3.2 Pop-up Menus .......................................................................................................................................... 2-3  
2.3.3 Tool Bar .................................................................................................................................................. 2-4  
2.3.4 Control Center ....................................................................................................................................... 2-6  
2.3.5 Status Bar ............................................................................................................................................... 2-7  
2.3.5.1 Sequence Status Panels ..................................................................................................................... 2-7  
2.3.5.2 Field Status Panels ......................................................................................................................... 2-8  
2.3.5.3 Temperature Status Panels ........................................................................................................... 2-8  
2.3.5.4 Chamber Status Panels .............................................................................................................. 2-9  
2.3.6 Data File Windows ................................................................................................................................ 2-9  
2.3.7 Sequence Windows ................................................................................................................................ 2-9
CHAPTER 3
Sample Measurement

3.1 Introduction ................................................................. 3-1
3.2 Overview of Sample Measurements ................................. 3-1
3.3 Measuring the Sample .................................................. 3-1
  3.3.1 Attach the Sample .................................................. 3-2
  3.3.2 Insert the Sample .................................................... 3-3
  3.3.3 Define the Sample Parameters ................................. 3-5
  3.3.4 Center the Sample ................................................... 3-6
    3.3.4.1 Initialize the Sample Transport ......................... 3-7
    3.3.4.2 Define the Parameters ..................................... 3-8
    3.3.4.3 Run the Centering Measurement ..................... 3-9
    3.3.4.4 Adjust the Sample Position .............................. 3-11
  3.3.5 Measure the Sample ............................................... 3-12
    3.3.5.1 Define the Parameters ..................................... 3-12
    3.3.5.2 Select the Data Files ....................................... 3-13
    3.3.5.3 Run the Measurement ...................................... 3-14
    3.3.5.4 View the Data Files ........................................ 3-14
3.4 Measurement Algorithms ............................................... 3-15
  3.4.1 Iterative Regression Algorithm .................................. 3-15
  3.4.2 Linear Regression Algorithm .................................... 3-16
  3.4.3 Full Scan Algorithm ............................................... 3-16
3.5 Measurement Considerations .......................................... 3-17
3.6 Multiple Measure Sequence Command ................................ 3-17
  3.6.1 Compatibility ....................................................... 3-17
  3.6.2 Accessing and Using Multiple-Measure Command ........ 3-18
  3.6.3 Checking the Status of a Multiple-Measure Command ... 3-20
  3.6.4 Reading the Statistical Data (.ndat) File ..................... 3-21

CHAPTER 4
Data Files

4.1 Introduction ................................................................. 4-1
4.2 Overview of Data Files ................................................ 4-1
  4.2.1 File Format .......................................................... 4-1
  4.2.2 Naming Conventions ............................................... 4-2
    4.2.2.1 Example: Naming Data Files That Save Sequence Measurement Data .................. 4-3
    4.2.2.2 Example: Naming Data Files That Save Immediate Measurement Data ............. 4-3
  4.2.3 Active Data Files .................................................... 4-4
  4.2.4 Template Files ........................................................ 4-4
4.3 Types of Data Files .................................................... 4-5
  4.3.1 Sample Measurement Data Files ............................... 4-5
    4.3.1.1 Measurement Data Files .................................. 4-6
    4.3.1.2 Scan Data Files .............................................. 4-6
    4.3.1.3 Raw Data Files .............................................. 4-7
    4.3.1.4 Diagnostic Data Files ..................................... 4-7
  4.3.2 Helium Data File ..................................................... 4-7
  4.3.3 Environment Log Files ............................................. 4-7
  4.3.4 Field Profile Scan Files .......................................... 4-8
  4.3.5 EDC Data Files ....................................................... 4-8
4.4 Data File Management .................................................. 4-9
  4.4.1 Creating a Measurement Data File ......................... 4-9
    4.4.1.1 Creating a Measurement Data File to Save Immediate Measurement Data ........ 4-9
CHAPTER 5
Sequence Files ................................................................. 5-1
5.1 Introduction .................................................................. 5-1
5.2 Overview of Sequence Files ........................................... 5-1
  5.2.1 Sequence Commands ................................................ 5-1
  5.2.2 Sequence Command Bar .......................................... 5-2
  5.2.3 Sequence Editor ...................................................... 5-2
  5.2.4 Naming Conventions ................................................. 5-3
  5.2.5 Selected Sequence and Active Sequence .................. 5-3
5.3 Sequence File Management ........................................... 5-4
  5.3.1 Creating a Sequence ................................................ 5-4
  5.3.2 Editing a Sequence .................................................. 5-4
  5.3.3 Modifying Command Parameters within a Sequence .... 5-5
  5.3.4 Printing a Sequence ................................................ 5-5
  5.3.5 Locking Sequence Status ........................................ 5-6
  5.3.6 Unlocking Sequence Status ..................................... 5-6
5.4 Running a Sequence: An Example ................................. 5-7
  5.4.1 Prepare for the Measurement ................................. 5-8
  5.4.2 Create the Sequence .............................................. 5-8
  5.4.3 Select the Data File ................................................ 5-9
  5.4.4 Run the Sequence .................................................. 5-10
    5.4.4.1 Pausing, Resuming, or Aborting a Sequence Run .... 5-10
    5.4.4.2 Viewing Data Files .......................................... 5-10
  5.5 Running a Partial Sequence ......................................... 5-11
  5.6 Editing a Paused Sequence Run ................................... 5-11

4.4.1.2 Creating a Measurement Data File to Save Sequence Measurement Data ........................................ 4-10
4.4.1.3 Creating a Measurement Data File within a Sequence ................................................................. 4-10
4.4.2 Creating an Environment Log File ................................ 4-11
4.4.3 Changing the Sequence Base Data File Name ................ 4-12
4.4.4 Creating a Graph Template File .................................. 4-13
4.4.5 Applying a Graph Template File ................................. 4-13
4.4.6 Printing a Graph ...................................................... 4-13
4.5 Data-Viewing Formats .................................................. 4-14
  4.5.1 Graph View ............................................................. 4-14
  4.5.2 Record View ............................................................ 4-15
  4.5.3 Table View .............................................................. 4-16
  4.5.4 Raw Data View ......................................................... 4-16
4.6 Graph Formats ............................................................ 4-17
# CHAPTER 6

## Sequence Commands

6.1 Introduction ............................................................................................................... 6-1

6.2 Overview of Sequence Commands........................................................................... 6-1

6.2.1 End Sequence Command...................................................................................... 6-1

6.2.2 Similarities between Sequence Commands and Menu Options...................... 6-2

6.2.3 Guide to Location of Commands in Chapter...................................................... 6-3

   6.2.3.1 System Commands ......................................................................................... 6-3

   6.2.3.2 Center Commands ......................................................................................... 6-3

   6.2.3.3 Measure Commands ....................................................................................... 6-3

   6.2.3.4 Bridge Channel Diagnostic Commands......................................................... 6-3

   6.2.3.5 Calibration Factor Diagnostic Commands...................................................... 6-4

   6.2.3.6 Chamber Diagnostic Commands ................................................................ 6-4

   6.2.3.7 Driver Channel Diagnostic Commands......................................................... 6-4

   6.2.3.8 Magnet Diagnostic Commands...................................................................... 6-5

   6.2.3.9 SQUID Diagnostic Commands.................................................................... 6-5

   6.2.3.10 Data Logging Commands.......................................................................... 6-5

   6.2.3.11 Transport Diagnostic Commands............................................................... 6-5

   6.2.3.12 Voltmeter Diagnostic Commands.............................................................. 6-6

6.3 Scan Commands......................................................................................................... 6-7

   6.3.1 Operation of Control Loop.............................................................................. 6-7

   6.3.2 End Scan Command ......................................................................................... 6-8

6.4 System Commands..................................................................................................... 6-9

   6.4.1 Move Sample.................................................................................................... 6-9

      6.4.1.1 Movement Modes ....................................................................................... 6-10

   6.4.2 Remark ........................................................................................................... 6-10

   6.4.3 Run Sequence.................................................................................................. 6-10

   6.4.4 Scan Field........................................................................................................ 6-10

      6.4.4.1 Spacing Modes ......................................................................................... 6-11

      6.4.4.2 Steps Modes ............................................................................................ 6-12

      6.4.4.3 Approach Modes ..................................................................................... 6-12

      6.4.4.4 Resolution Modes .................................................................................. 6-12

   6.4.5 Scan Rotation.................................................................................................. 6-13

      6.4.5.1 Spacing Modes ......................................................................................... 6-13

      6.4.5.2 Steps Modes ............................................................................................ 6-14

   6.4.6 Scan Temperature............................................................................................. 6-14

      6.4.6.1 Spacing Modes ......................................................................................... 6-15

      6.4.6.2 Steps Modes ............................................................................................ 6-15

      6.4.6.3 Approach Modes ..................................................................................... 6-15

   6.4.7 Set Field.......................................................................................................... 6-16

   6.4.8 Set Temperature Undercool............................................................................. 6-16

   6.4.9 Set Temperature.............................................................................................. 6-16

   6.4.10 Wait For......................................................................................................... 6-17

6.5 Center Commands..................................................................................................... 6-18

   6.5.1 Adjust Position ............................................................................................... 6-18

   6.5.2 DC Center.................................................................................................... 6-18

   6.5.3 DC Parameters.............................................................................................. 6-18

      6.5.3.1 EMU Modes ............................................................................................ 6-19

   6.5.4 Full DC Scan................................................................................................. 6-19

   6.5.5 Initialize Transport ....................................................................................... 6-19

6.6 Measure Commands ................................................................................................. 6-20

   6.6.1 Measure DC.................................................................................................. 6-20

   6.6.2 Set Datafile.................................................................................................. 6-21

6.7 Diagnostic Commands............................................................................................... 6-21
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.7.1 Bridge Channels Commands</td>
<td></td>
<td>6-21</td>
</tr>
<tr>
<td>6.7.1.1 Autorange</td>
<td></td>
<td>6-21</td>
</tr>
<tr>
<td>6.7.1.2 Autoscan</td>
<td></td>
<td>6-22</td>
</tr>
<tr>
<td>6.7.1.3 Max Excitation</td>
<td></td>
<td>6-22</td>
</tr>
<tr>
<td>6.7.1.4 User Mode</td>
<td></td>
<td>6-22</td>
</tr>
<tr>
<td>6.7.2 Calibration Factor Commands</td>
<td></td>
<td>6-22</td>
</tr>
<tr>
<td>6.7.2.1 Magnet</td>
<td></td>
<td>6-22</td>
</tr>
<tr>
<td>6.7.2.2 SQUID</td>
<td></td>
<td>6-23</td>
</tr>
<tr>
<td>6.7.2.3 Field Penetration</td>
<td></td>
<td>6-23</td>
</tr>
<tr>
<td>6.7.2.4 SQUID Extended Range</td>
<td></td>
<td>6-23</td>
</tr>
<tr>
<td>6.7.2.5 SQUID Regression</td>
<td></td>
<td>6-23</td>
</tr>
<tr>
<td>6.7.2.6 Minimum Data Points</td>
<td></td>
<td>6-23</td>
</tr>
<tr>
<td>6.7.2.7 Transverse Rotator Steps/Degree</td>
<td></td>
<td>6-23</td>
</tr>
<tr>
<td>6.7.2.8 SQUID Settle Time</td>
<td></td>
<td>6-23</td>
</tr>
<tr>
<td>6.7.2.9 Temperature Tolerance</td>
<td></td>
<td>6-24</td>
</tr>
<tr>
<td>6.7.2.10 Low Temperature</td>
<td></td>
<td>6-24</td>
</tr>
<tr>
<td>6.7.2.11 Fill Temperature</td>
<td></td>
<td>6-24</td>
</tr>
<tr>
<td>6.7.2.12 Fill Time</td>
<td></td>
<td>6-24</td>
</tr>
<tr>
<td>6.7.2.13 Fill Power</td>
<td></td>
<td>6-24</td>
</tr>
<tr>
<td>6.7.2.14 Oven Factor</td>
<td></td>
<td>6-24</td>
</tr>
<tr>
<td>6.7.2.15 Maximum Temperature</td>
<td></td>
<td>6-24</td>
</tr>
<tr>
<td>6.7.2.16 Minimum Warming Rate</td>
<td></td>
<td>6-25</td>
</tr>
<tr>
<td>6.7.2.17 Maximum Rate on Pot</td>
<td></td>
<td>6-25</td>
</tr>
<tr>
<td>6.7.2.18 Low-Temperature Heater Factor</td>
<td></td>
<td>6-25</td>
</tr>
<tr>
<td>6.7.2.19 Reservoir Fill</td>
<td></td>
<td>6-25</td>
</tr>
<tr>
<td>6.7.2.20 Thermometer Consistency Tolerance</td>
<td></td>
<td>6-25</td>
</tr>
<tr>
<td>6.7.2.21 Inductance</td>
<td></td>
<td>6-26</td>
</tr>
<tr>
<td>6.7.2.22 Charge Rate</td>
<td></td>
<td>6-26</td>
</tr>
<tr>
<td>6.7.2.23 Quench Time</td>
<td></td>
<td>6-26</td>
</tr>
<tr>
<td>6.7.2.24 Cool Time</td>
<td></td>
<td>6-26</td>
</tr>
<tr>
<td>6.7.3 Chamber Commands</td>
<td></td>
<td>6-26</td>
</tr>
<tr>
<td>6.7.3.1 Cooling Valve</td>
<td></td>
<td>6-26</td>
</tr>
<tr>
<td>6.7.3.2 Flush Valve</td>
<td></td>
<td>6-26</td>
</tr>
<tr>
<td>6.7.3.3 Impedance Heater</td>
<td></td>
<td>6-27</td>
</tr>
<tr>
<td>6.7.3.4 Level Meter</td>
<td></td>
<td>6-27</td>
</tr>
<tr>
<td>6.7.3.5 Start Valve Sequence</td>
<td></td>
<td>6-27</td>
</tr>
<tr>
<td>6.7.3.6 Valve Sequencing</td>
<td></td>
<td>6-28</td>
</tr>
<tr>
<td>6.7.3.7 Valve/Heater Select</td>
<td></td>
<td>6-28</td>
</tr>
<tr>
<td>6.7.3.8 Vent Valve</td>
<td></td>
<td>6-28</td>
</tr>
<tr>
<td>6.7.4 Driver Channels Commands</td>
<td></td>
<td>6-28</td>
</tr>
<tr>
<td>6.7.4.1 Assigned Input</td>
<td></td>
<td>6-28</td>
</tr>
<tr>
<td>6.7.4.2 Balance Point</td>
<td></td>
<td>6-29</td>
</tr>
<tr>
<td>6.7.4.3 Feedback Mode</td>
<td></td>
<td>6-29</td>
</tr>
<tr>
<td>6.7.4.4 Maximum Power</td>
<td></td>
<td>6-29</td>
</tr>
<tr>
<td>6.7.4.5 Minimum Power</td>
<td></td>
<td>6-29</td>
</tr>
<tr>
<td>6.7.4.6 Output Range</td>
<td></td>
<td>6-30</td>
</tr>
<tr>
<td>6.7.4.7 Output Power</td>
<td></td>
<td>6-30</td>
</tr>
<tr>
<td>6.7.4.8 PID Differentiator</td>
<td></td>
<td>6-30</td>
</tr>
<tr>
<td>6.7.4.9 PID Gain</td>
<td></td>
<td>6-30</td>
</tr>
<tr>
<td>6.7.4.10 PID Integrator</td>
<td></td>
<td>6-31</td>
</tr>
<tr>
<td>6.7.4.11 PID Preset</td>
<td></td>
<td>6-31</td>
</tr>
<tr>
<td>6.7.4.12 Updates</td>
<td></td>
<td>6-31</td>
</tr>
</tbody>
</table>
CHAPTER 7
System Operations ................................................................. 7-1
  7.1 Introduction ........................................................................ 7-1
  7.2 Setting the Temperature ..................................................... 7-1
  7.3 Setting the Magnetic Field .................................................. 7-2
  7.4 Controlling the Chamber Atmosphere ................................ 7-3
  7.5 Tuning the SQUID .............................................................. 7-3
  7.6 Monitoring Helium Transfers .............................................. 7-5
  7.7 Entering Standby Mode ....................................................... 7-5
  7.8 Advanced System Operations ............................................ 7-6
    7.8.1 Correcting the Field-Intensity Data ............................. 7-6
    7.8.2 Resetting the Magnet .................................................. 7-6
    7.8.3 Logging Data Parameters .......................................... 7-6
    7.8.4 Reviewing Calibration Factors ..................................... 7-7
    7.8.5 Configuring the Message Display ............................... 7-10
    7.8.6 Logging Events ......................................................... 7-11
    7.8.7 Installing and Activating Options ............................... 7-12
    7.8.8 Converting MPMSR2 DOS Files ................................. 7-12

CHAPTER 8
Diagnostics ................................................................................... 8-1
  8.1 Introduction ........................................................................ 8-1
  8.2 Overview of Diagnostics .................................................... 8-1
  8.3 Bridge Channel Diagnostics ................................................. 8-2
  8.4 Chamber Diagnostics ......................................................... 8-3
  8.5 Driver Channel Diagnostics ............................................... 8-5
  8.6 GPIB Diagnostics ............................................................... 8-7
    8.6.1 Viewing GPIB Activity ............................................... 8-7
    8.6.2 Sending GPIB Commands .......................................... 8-7
  8.7 Magnet Diagnostics ........................................................... 8-8
  8.8 Serial Port Diagnostics ....................................................... 8-9
  8.9 SQUID Diagnostics ............................................................. 8-10
  8.10 Transport Diagnostics ....................................................... 8-11
  8.11 Voltmeter Diagnostics ...................................................... 8-14
  8.12 Temperature Control ........................................................ 8-15

APPENDIX A
Installation Instructions ............................................................... A-1
  A.1 Introduction ........................................................................ A-1
  A.2 Overview of Installation .................................................... A-1
    A.2.1 Configuration Files and the Machine State .................... A-1
  A.3 Installing MPMS MultiVu .................................................... A-2
    A.3.1 Install the GPIB Software .......................................... A-2
    A.3.2 Install the GPIB Board ............................................... A-2
    A.3.3 Install MPMS MultiVu .............................................. A-2
    A.3.4 Change the EPROMs ............................................... A-3
    A.3.5 Update the Calibration Files ..................................... A-3
    A.3.6 Set the SQUID Drive and Tune Levels ....................... A-3
## APPENDIX B

### Data File Format

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>B.1 Introduction</td>
<td>B-1</td>
</tr>
<tr>
<td>B.2 Overview of Data File Format</td>
<td>B-1</td>
</tr>
<tr>
<td>B.3 Data File Header</td>
<td>B-2</td>
</tr>
<tr>
<td>B.4 Data Section</td>
<td>B-3</td>
</tr>
<tr>
<td>B.4.1 Data Section Field Names in Each Type of Data File</td>
<td>B-3</td>
</tr>
<tr>
<td>B.5 Data Types</td>
<td>B-5</td>
</tr>
<tr>
<td>B.5.1 Numerical Data</td>
<td>B-5</td>
</tr>
<tr>
<td>B.5.2 Strings</td>
<td>B-5</td>
</tr>
<tr>
<td>B.5.3 Boolean</td>
<td>B-5</td>
</tr>
<tr>
<td>B.5.4 Additional Information</td>
<td>B-5</td>
</tr>
</tbody>
</table>

### References

References-1

### Index

Index-1
Figures

Figure 1-1. System Startup Dialog Box ................................................................. 1-3
Figure 2-1. MPMS MultiVu Interface ................................................................. 2-2
Figure 2-2. Control Center ................................................................................. 2-6
Figure 2-3. Status Bar Maximized .................................................................... 2-7
Figure 3-1. Correctly Positioned Sample .......................................................... 3-2
Figure 3-2. Sample Transport and Electronic Control Assembly ..................... 3-3
Figure 3-3. O-Rings on Socket Block Assembly .............................................. 3-4
Figure 3-4. Sample Description Dialog Box ..................................................... 3-5
Figure 3-5. DC Centering Dialog Box ............................................................... 3-7
Figure 3-6. DC Center Parameters Dialog Box ............................................... 3-8
Figure 3-7. DC Centering Measurement and Measured SQUID Voltage Response ......................................................... 3-10
Figure 3-8. Adjust Sample Position Dialog Box .............................................. 3-11
Figure 3-9. Measure DC Dialog Box ............................................................... 3-12
Figure 3-10. MPMS MultiVu Window, Sequence Commands Panel and New Sequence File ........................................ 3-18
Figure 3-11. Multiple Measurement Dialog Box Set Up to Perform RSO Measurements ...................................................... 3-18
Figure 3-12. Measure RSO Dialog Box for Setting Measurement Parameters .......................................................... 3-19
Figure 3-13. Multiple Measurement Command Dialog Box After the Advanced Button has been selected .......................... 3-19
Figure 3-14. MPMS MultiVu Window Showing Control Center Panel, Sequence Commands, and Sequence File06 Chapter 3.doc ................................................................. 3-21
Figure 3-15. Contents of the Statistical Data File for Record #10 of QuartzVR1.rso ................................................................. 3-22
Figure 4-1. General Tab in Log Data Dialog Box .............................................. 4-11
Figure 4-2. Standard Items Tab in Log Data Dialog Box ................................. 4-12
Figure 4-3. Graph View ..................................................................................... 4-14
Figure 4-4. Record View .................................................................................... 4-15
Figure 4-5. Table View ..................................................................................... 4-16
Figure 4-6. Plot Appearance Dialog Box .......................................................... 4-17
Figure 4-7. Data Selection Dialog Box ............................................................. 4-18
Figure 5-1. Sequence Command Bar ................................................................ 5-2
Figure 5-2. Sequence Editor ............................................................................. 5-3
Figure 5-3. Lock Sequence Dialog Box ............................................................ 5-6
Figure 5-4. Status Information Appearing in Control Center While Sequence Runs ......................................................... 5-7
Figure 5-5. Example Sequence File .................................................................. 5-9
Figure 5-6. Run Sequence Pop-up Dialog Box ................................................ 5-11
Figure 5-7. Sequence Status Dialog Box While Running Sequence Is Paused .......................................................... 5-11
Figure 5-8. Sequence Editor Showing Example of Command List Sequence File ................................................................. 5-12
Figure 6-1. Illustration of Control Loop in Sequence Editor ............................. 6-7
Figure 6-2. Move Transport Dialog Box ............................................................ 6-9
Figure 6-3. Scan Field Dialog Box ................................................................... 6-11
Figure 6-4. Scan Rotation Dialog Box .............................................................. 6-13
Figure 6-5. Scan Temperature Dialog Box ...................................................... 6-14
Figure 6-6. Wait For Dialog Box ...................................................................... 6-17
Figure 6-7. DC Center Parameters Dialog Box .............................................. 6-18
Figure 6-8. Measure DC Dialog Box for Sequence Measurement ................... 6-20
**Table of Figures**

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7-1</td>
<td>Temperature Parameters Dialog Box</td>
<td>7-1</td>
</tr>
<tr>
<td>7-2</td>
<td>Magnetic Field Dialog Box</td>
<td>7-2</td>
</tr>
<tr>
<td>7-3</td>
<td>Chamber Dialog Box</td>
<td>7-3</td>
</tr>
<tr>
<td>7-4</td>
<td>SQUID Tuning Dialog Box Showing Longitudinal Tab</td>
<td>7-3</td>
</tr>
<tr>
<td>7-5</td>
<td>Helium Fill Status Screen</td>
<td>7-5</td>
</tr>
<tr>
<td>7-6</td>
<td>General Tab in Log Data Dialog Box</td>
<td>7-6</td>
</tr>
<tr>
<td>7-7</td>
<td>Standard Items Tab in Log Data Dialog Box</td>
<td>7-7</td>
</tr>
<tr>
<td>7-8</td>
<td>Configure Error Handling Dialog Box</td>
<td>7-10</td>
</tr>
<tr>
<td>7-9</td>
<td>Event Log</td>
<td>7-11</td>
</tr>
<tr>
<td>7-10</td>
<td>Configure Logging Dialog Box</td>
<td>7-11</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8-1</td>
<td>Bridge Channel Diagnostics Dialog Box</td>
<td>8-2</td>
</tr>
<tr>
<td>8-2</td>
<td>Chamber/Gas Control Diagnostics Dialog Box</td>
<td>8-3</td>
</tr>
<tr>
<td>8-3</td>
<td>Bridge Driver Diagnostics Dialog Box</td>
<td>8-5</td>
</tr>
<tr>
<td>8-4</td>
<td>GPIB Status Dialog Box</td>
<td>8-7</td>
</tr>
<tr>
<td>8-5</td>
<td>Send GPIB Commands Dialog Box</td>
<td>8-7</td>
</tr>
<tr>
<td>8-6</td>
<td>Magnet Diagnostics Dialog Box</td>
<td>8-8</td>
</tr>
<tr>
<td>8-7</td>
<td>Monitor Communication Port Dialog Box</td>
<td>8-9</td>
</tr>
<tr>
<td>8-8</td>
<td>Longitudinal Tab in SQUID Diagnostics Dialog Box</td>
<td>8-10</td>
</tr>
<tr>
<td>8-9</td>
<td>Sample Transport Tab in Transport Diagnostics Dialog Box</td>
<td>8-12</td>
</tr>
<tr>
<td>8-10</td>
<td>Motor Configuration Dialog Box</td>
<td>8-13</td>
</tr>
<tr>
<td>8-11</td>
<td>Voltmeter Diagnostics Dialog Box</td>
<td>8-14</td>
</tr>
<tr>
<td>8-12</td>
<td>Temperature Control Dialog Box</td>
<td>8-15</td>
</tr>
</tbody>
</table>
## Tables

Table 1-1. New Features in MPMS MultiVu .......................................................................................................... 1-2
Table 2-1. MPMS MultiVu Menus ................................................................................................................. 2-3
Table 2-2. MPMS MultiVu Tool Bar Buttons ............................................................................................... 2-4
Table 2-3. Equivalent Tool Bar Button and Menu Commands ................................................................. 2-5
Table 2-4. Data in Sequence Status Panels .............................................................................................. 2-7
Table 2-5. Data in Field Status Panels ........................................................................................................ 2-8
Table 2-6. Data in Temperature Status Panels .......................................................................................... 2-8
Table 2-7. Data in Chamber Status Panels ............................................................................................. 2-9
Table 3-1. Sample Parameters ....................................................................................................................... 3-5
Table 3-2. Scan Parameters ......................................................................................................................... 3-6
Table 3-3. SQUID Parameters .................................................................................................................... 3-6
Table 3-4. Summary of Functions of Measurement Algorithms .............................................................. 3-15
Table 4-1. Components of Data File Names ............................................................................................... 4-2
Table 4-2. File Extensions ............................................................................................................................ 4-2
Table 4-3. Name and Function of Data File Types ................................................................................... 4-5
Table 6-1. Suggested Use of Field Approach Modes ................................................................................ 6-12
Table 6-2. Suggested Use of Temperature Approach Modes ................................................................. 6-15
Table 6-3. System Conditions Affected by Wait For Command ............................................................... 6-17
Table 6-4. Operating Modes for Impedance Heater ................................................................................ 6-27
Table 6-5. Maximum Output Range .......................................................................................................... 6-30
Table 6-6. Magnet Polarity Modes .............................................................................................................. 6-32
Table 6-7. Reset Modes for SQUID ............................................................................................................ 6-35
Table 7-1. Suggested Use of Field Approach Modes ................................................................................ 7-2
Table 7-2. Standard MPMS Calibration Factors ....................................................................................... 7-8
Table 7-3. Default Values for Standard MPMS Calibration Factors ....................................................... 7-9
Table 7-4. System Messages ....................................................................................................................... 7-10
Table 8-1. Physical Channel Control Parameters .................................................................................... 8-3
Table 8-2. Settings for Gas System ............................................................................................................ 8-4
Table 8-3. Driver Control Settings ............................................................................................................ 8-6
Table 8-4. Control Parameters Settings .................................................................................................. 8-6
Table 8-5. Magnet Control Parameters ...................................................................................................... 8-8
Table 8-6. SQUID Control Commands ................................................................................................... 8-10
Table 8-7. Movement Control Commands .............................................................................................. 8-12
Table 8-8. Motor Configuration Parameters .......................................................................................... 8-13
Table 8-9. Voltmeter Diagnostic Parameters .......................................................................................... 8-14
PREFACE

Contents and Conventions

P.1 Introduction
This preface contains the following information:

- Section P.2 discusses the overall scope of the manual.
- Section P.3 briefly summarizes the contents of the manual.
- Section P.4 illustrates and describes conventions that appear in the manual.

P.2 Scope of the Manual
This manual discusses the MPMS MultiVu application, which is the software running the Magnetic Property Measurement System (MPMS) and the MPMS options. This manual describes how you install and how you use MPMS MultiVu.

The MPMS MultiVu application must run on Windows 95. This manual assumes you are familiar with Windows 95.

For information about the MPMS hardware, refer to the MPMS Hardware Reference Manual. For specific information about any of the MPMS options, refer to the appropriate option manual.

P.3 Contents of the Manual

- Chapter 1 introduces the MPMS MultiVu application.
- Chapter 2 discusses the MPMS MultiVu interface.
- Chapter 3 explains how to use MPMS MultiVu to take a sample measurement.
- Chapter 4 discusses MPMS MultiVu data files.
- Chapter 5 discusses MPMS MultiVu sequence files and sequence operation.
- Chapter 6 discusses MPMS MultiVu sequence commands.
Chapter 7 explains how to use MPMS MultiVu to perform basic system operations.

Chapter 8 explains how to use MPMS MultiVu to perform diagnostic functions.

Appendix A explains how to install MPMS MultiVu.

Appendix B explains the format of MPMS MultiVu data files.

---

**P.4 Conventions in the Manual**

**File menu**

Bold text distinguishes the names of menus, options, buttons, and panels appearing on the PC monitor.

**File►Open**

The►symbol indicates that you select multiple, nested software options.

*.dat*

The Courier font distinguishes code and the names of files and directories.

<Enter>

Angle brackets distinguish the names of keys located on the PC keyboard.

<Alt+Enter>

A plus sign connecting the names of two or more keys distinguishes keys you press simultaneously.

A pointing hand introduces a supplementary note.

An exclamation point inside an inverted triangle introduces a cautionary note.

A lightning bolt inside an inverted triangle introduces a warning.
CHAPTER 1

Introduction to MPMS MultiVu

1.1 Introduction

This chapter contains the following information:

- Section 1.2 presents an overview of the MPMS MultiVu application.
- Section 1.3 explains how to start up MPMS MultiVu.

1.2 Overview of the MPMS MultiVu Application

MPMS MultiVu is a 32-bit, Windows 95-based application that controls and monitors the operation of the MPMS hardware and the operation of installed MPMS options. MPMS MultiVu integrates all system operations into one versatile and easy-to-use Windows 95 interface (see figure 2-1). System operation is simplified; multiple commands that open files, run measurements, or set parameters are always enabled. The control center and status bar in the MPMS MultiVu interface always display status information.

MPMS MultiVu functions like any Windows 95 application and uses all Windows 95 conventions. Windows 95 utilities may be used to control and manage MPMS MultiVu file folders without exiting MPMS MultiVu. MPMS MultiVu may run simultaneously with other applications.

NOTE

This manual generally describes one method of performing a specific task in MPMS MultiVu. However, different MPMS MultiVu commands can often be used to perform the identical task. As you work with MPMS MultiVu, you will discover multiple ways of performing identical tasks.

1.2.1 Immediate Mode and Sequence Mode Operation

MPMS MultiVu supports manual, or immediate, tasks and automated, or sequence, tasks. Menu options and control center commands execute immediately. Sequence commands execute only when the sequence file in which the commands are included runs, but while the sequence runs, the commands are executed automatically. If you select a measurement command in the MPMS MultiVu
Measure menu, you are taking a measurement in immediate mode. If you add a measurement sequence command to a sequence file and then run the sequence, you are taking a measurement in sequence mode.

### 1.2.2 Data Viewing

MPMS MultiVu offers tremendous flexibility in data-viewing options. When you open a data file, you see a plot of the actual data stored in the file. You can modify the appearance of the graph view of the file and select which types of data are plotted in the graph. You can also use tables or a text editor to examine the data, and you can import the data file into another graphics application. MPMS MultiVu automatically saves all system-generated data to data files.

### 1.2.3 Comparison with the MPMSR2 DOS Software

MPMS MultiVu simplifies many of the tasks performed in the MPMSR2 DOS software and includes new features that make it easier to work with the MPMS.

<table>
<thead>
<tr>
<th>TASK</th>
<th>WHAT MPMS MULTIVU DOES</th>
<th>MANUAL REFERENCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storing Data</td>
<td>Stores data in data files and prevents data files from being overwritten. Allows data files to be opened at any time.</td>
<td>Section 4.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Section 4.3</td>
</tr>
<tr>
<td>Viewing Data</td>
<td>Allows graph of data file to be modified and data to be examined in different viewing formats.</td>
<td>Section 4.5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Section 4.6</td>
</tr>
<tr>
<td>Automating Operation</td>
<td>Edits, executes, and controls sequence files.</td>
<td>Section 5.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Section 5.4</td>
</tr>
<tr>
<td>Recording Events</td>
<td>Includes event log that records error, information, and sequence events.</td>
<td>Section 7.8.6</td>
</tr>
<tr>
<td>Recording System Data</td>
<td>Includes environment log file that can store system data indefinitely.</td>
<td>Section 4.3.3</td>
</tr>
<tr>
<td>Tuning SQUID</td>
<td>Allows SQUID coils to be tuned automatically.</td>
<td>Section 7.5</td>
</tr>
<tr>
<td>Running Control Loop</td>
<td>Includes scan sequence commands that create execution loops.</td>
<td>Section 6.3</td>
</tr>
<tr>
<td>Performing Diagnostics</td>
<td>Includes Diagnostics dialogs that list all diagnostic parameters and allow parameters to be modified.</td>
<td>Chapter 8</td>
</tr>
</tbody>
</table>

MPMS MultiVu allows you to convert MPMSR2 DOS sequence files and data files to the MPMS MultiVu format.

- Select the **Utilities ➤ Convert Sequence** menu option to convert an MPMSR2 DOS sequence.
- Select the **Utilities ➤ Convert Data File** menu option to convert an MPMSR2 DOS data file.
1.3 Starting Up MPMS MultiVu

1. Do one of the following: (a) select the MPMS MultiVu icon that is on the desktop or (b) open the Windows 95 Start menu and then locate and select the MPMS MultiVu option. The MPMS MultiVu option may be located in the Programs→Quantum Design folder.

2. Wait for MPMS MultiVu to start up. The MPMS MultiVu interface opens, and in the center of the interface, the System Startup dialog box appears. The System Startup dialog box identifies each task the system performs as part of start-up. The dialog box disappears as soon as start-up is complete.

Figure 1-1. System Startup Dialog Box
CHAPTER 2

MPMS MultiVu Interface

2.1 Introduction

This chapter contains the following information:

- Section 2.2 summarizes the function of the MPMS MultiVu interface.
- Section 2.3 discusses the main features of the MPMS MultiVu interface.

2.2 Function of the MPMS MultiVu Interface

Menu options and command buttons in the MPMS MultiVu interface perform all manual and automated MPMS tasks. Immediate instrument status feedback information displayed in the interface indicates the current system status. The interface allows immediate control of the MPMS for performing a wide variety of standard tasks, such as changing the temperature or magnetic field, running measurements, or logging system data. The interface also allows most functions of the MPMS and the MPMS options to be automated by using a series of simple commands, called a sequence. MPMS MultiVu provides the sequence editor and the commands that initiate and control the running sequence.

The MPMS MultiVu interface simplifies data collection and data viewing. Data can be viewed in a graphic, tabular, or raw data format. Data can be viewed in real time during automated operation, or it can be viewed after it has been collected.

2.2.1 MDI Application Interface

MPMS MultiVu is a multiple document interface (MDI) Windows application. In MPMS MultiVu, multiple documents may be open for viewing and editing at any one time, and a single document can be viewed in multiple ways. For example, a data file can be viewed in a graph, table, record, or raw data window. Each different view presents the same information in a unique manner. The name of the active document appears in the title bar of the main MPMS MultiVu window. To activate a document, you simply click anywhere within its window.
2.3 **Features of the MPMS MultiVu Interface**

The MPMS MultiVu menu options and command buttons provide multiple ways of performing many basic tasks, such as opening files and running sequences. The menu options and command buttons that are available depend on the active file and the task being performed and also on the installed hardware options. Figure 2-1 illustrates the basic elements of the MPMS MultiVu interface. Other windows may be visible, depending on the task being performed.

---

**Figure 2-1. MPMS MultiVu Interface**
2.3.1 Menu Bar

All MPMS MultiVu functions are accessible through the menus in the menu bar. The available menus and menu options vary, based on the current task, active file, and installed MPMS options. Some options add items to the menus.

<table>
<thead>
<tr>
<th>MENU</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Contains standard Windows commands that create, open, or close files.</td>
</tr>
<tr>
<td>Edit</td>
<td>Contains standard Windows editing commands that edit sequence files. Menu is available only when sequence file is active.</td>
</tr>
<tr>
<td>View</td>
<td>Options show or hide parts of interface or select data-viewing formats.</td>
</tr>
<tr>
<td>Sample</td>
<td>Options summarize sample parameter and sample installation data.</td>
</tr>
<tr>
<td>Sequence</td>
<td>Options control sequence operation.</td>
</tr>
<tr>
<td>Center</td>
<td>Options control centering operation.</td>
</tr>
<tr>
<td>Measure</td>
<td>Options control measurement operation.</td>
</tr>
<tr>
<td>Graph</td>
<td>Options open and modify graph configuration files and create and apply graph template files.</td>
</tr>
<tr>
<td>Instrument</td>
<td>Options control basic operation of MPMS hardware.</td>
</tr>
<tr>
<td>Utilities</td>
<td>Options are tools that help operate MPMS or are diagnostics that directly control MPMS hardware.</td>
</tr>
<tr>
<td>Window</td>
<td>Contains standard Windows organization commands that arrange icons or windows. Menu is available only when sequence or data file is active.</td>
</tr>
<tr>
<td>Help</td>
<td>Standard Windows Help menu.</td>
</tr>
</tbody>
</table>

2.3.2 Pop-up Menus

In addition to the menus in the menu bar, MPMS MultiVu includes a Graph pop-up menu and an Edit pop-up menu, which provide shortcuts to data-viewing commands and editing commands, respectively. The Graph pop-up menu is available only when the graph view of a data file is active. The Edit pop-up menu is available only when a sequence file is active.

You open the Graph pop-up menu by right-clicking the mouse inside a graph window. If you right-click anywhere inside the graph window except immediately above or below the graph, then all menu options, including X Axis Auto Scale and Y Axis Auto Scale, are available.

Graph pop-up menu options and Graph menu options are nearly identical. Options in both menus modify graph configuration files and create and apply graph template files. However, Graph pop-up menu options emphasize modifying the graph format and selecting data-viewing formats. Graph menu options emphasize opening and saving files.

You open the Edit pop-up menu by right-clicking the mouse inside a sequence editor window. Edit pop-up menu options and Edit menu options are identical. Both menus contain standard Windows editing commands that you apply to sequence files.
2.3.3 Tool Bar

The tool bar buttons provide shortcuts that let you initiate many of the more frequently performed MPMS MultiVu functions without having to select multiple, nested menu options. The buttons are grouped according to function. The active file and the current state of sequence operation determine which buttons are enabled.

You may move, resize, dock, hide, or display the tool bar. The View ➤ Tool Bar toggle option hides or displays the tool bar.

If the mouse pointer pauses over a tool bar button, a ToolTip pops up to display the name of the button.

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="New Sequence File" /></td>
<td>Creates and opens new sequence file by opening sequence editor window for file.</td>
</tr>
<tr>
<td><img src="image" alt="Open Sequence File" /></td>
<td>Opens sequence file by opening sequence editor window for file.</td>
</tr>
<tr>
<td><img src="image" alt="Save Sequence File" /></td>
<td>Saves active sequence file. Button is enabled only when sequence file is active.</td>
</tr>
<tr>
<td><img src="image" alt="Open Graph File" /></td>
<td>Opens data file whose graph format is defined by selected graph configuration file.</td>
</tr>
<tr>
<td><img src="image" alt="Open Data File" /></td>
<td>Opens data file.</td>
</tr>
<tr>
<td><img src="image" alt="Cut" /></td>
<td>Removes command or commands selected in sequence file. Button is enabled only when sequence file is active.</td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copies command or commands selected in sequence file. Button is enabled only when sequence file is active.</td>
</tr>
<tr>
<td><img src="image" alt="Paste" /></td>
<td>Pastes last cut or copied command or commands into sequence file. Button is enabled only when sequence file is active.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Prints active sequence file or graph view of active data file.</td>
</tr>
<tr>
<td><img src="image" alt="About" /></td>
<td>Identifies which version of MPMS MultiVu is running.</td>
</tr>
<tr>
<td><img src="image" alt="Run Sequence" /></td>
<td>Runs selected sequence. Button is enabled only when sequence status is unlocked and no sequence is running.</td>
</tr>
<tr>
<td><img src="image" alt="Pause Sequence" /></td>
<td>Pauses or resumes unlocked sequence run. Button is enabled only when unlocked sequence runs.</td>
</tr>
<tr>
<td><img src="image" alt="Resume Sequence" /></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Abort Sequence" /></td>
<td>Aborts unlocked sequence run. Button is enabled only when unlocked sequence runs.</td>
</tr>
<tr>
<td><img src="image" alt="Lock\Unlock Sequence" /></td>
<td>Locks or unlocks current sequence status.</td>
</tr>
</tbody>
</table>
Table 2-3. Equivalent Tool Bar Button and Menu Commands

<table>
<thead>
<tr>
<th>TOOL BAR BUTTON</th>
<th>EQUIVALENT MENU COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Sequence File</td>
<td>File ➤ New Sequence</td>
</tr>
<tr>
<td>Open Sequence File</td>
<td>File ➤ Open ➤ Sequence</td>
</tr>
<tr>
<td>Save Sequence File</td>
<td>File ➤ Save</td>
</tr>
<tr>
<td>Open Graph File</td>
<td>File ➤ Open ➤ Graph</td>
</tr>
<tr>
<td>Open Data File</td>
<td>File ➤ Open ➤ DataFile</td>
</tr>
<tr>
<td>Cut</td>
<td>Edit ➤ Cut</td>
</tr>
<tr>
<td>Copy</td>
<td>Edit ➤ Copy</td>
</tr>
<tr>
<td>Paste</td>
<td>Edit ➤ Paste</td>
</tr>
<tr>
<td>Print</td>
<td>File ➤ Print</td>
</tr>
<tr>
<td>About</td>
<td>Help ➤ About</td>
</tr>
<tr>
<td>Run Sequence</td>
<td>Sequence ➤ Control ➤ Run</td>
</tr>
<tr>
<td>Pause Sequence</td>
<td>Sequence ➤ Control ➤ Pause</td>
</tr>
<tr>
<td>Resume Sequence</td>
<td>Sequence ➤ Control ➤ Resume</td>
</tr>
<tr>
<td>Abort Sequence</td>
<td>Sequence ➤ Control ➤ Abort</td>
</tr>
<tr>
<td>Lock Sequence</td>
<td>Sequence ➤ Control ➤ Options ➤ Lock</td>
</tr>
<tr>
<td>Unlock Sequence</td>
<td>Sequence ➤ Control ➤ Options ➤ Unlock</td>
</tr>
</tbody>
</table>
2.3.4 Control Center

The control center summarizes sequence status information and allows you to control sequence operation without having to select menu options. The status panels and command buttons in the control center are grouped according to function and are arranged, from top to bottom, in the order you normally review or select them.

The Sample panel at the top of the control center displays the name of the sample. You select the Sample Change button to review or redefine the sample parameters.

The Selected Sequence panel displays the name of the selected sequence, which is the sequence file that runs the next time an MPMS MultiVu Run command is issued. The Edit button opens the selected sequence, and the Selected Sequence Change button lets you choose another sequence to run.

The Sequence Base Data File Name panel displays the base name of the data files that will store the sequence measurement data. The View button opens the graph view of one of these files. The Sequence Base Data File Name Change button lets you select another data file to store the measurement data.

The Sequence Status panel indicates the status of the selected sequence—Idle, Running, or Paused—and when the sequence runs, displays (1) the command line number, as indicated in the sequence editor, and name of the sequence command being executed; (2) the name of the running sequence; and (3) the base name of the active data files. Clicking once in the Sequence Status panel opens the Sequence Status dialog box.

Run and Abort buttons as well as Pause or Resume and Lock or Unlock toggle buttons are at the bottom of the control center.

The View►Control Center toggle option hides or displays the control center. Clicking once on any sequence status panel in the MPMS MultiVu status bar (see section 2.3.5.1) also displays the control center. You may move or dock the control center.
2.3.5 Status Bar

The status bar displays the sequence status and the status of the magnetic field, system temperature, and MPMS sample chamber. Panels displaying the same type of information are grouped together.

You may minimize, maximize, hide, display, or move the status bar. By default, the status bar is maximized to show the maximum amount of status information. The View Status Bar Minimum option minimizes the status bar so that it shows a minimal amount of information. View Status Bar None hides the status bar. View Status Bar Maximum displays the entire status bar.

Each field, temperature, and chamber status panel in the status bar is also a command button that opens the Magnetic Field, Temperature Parameters, or Chamber dialog box, respectively. These dialog boxes display status information and let you change the system state.

![Sequence Status Panels](image)

### 2.3.5.1 SEQUENCE STATUS PANELS

The sequence status panels indicate whether a sequence is running. The top or first panel always indicates the sequence status: Idle, Running, or Paused. During the run, the sequence status panels display the name of the running sequence and the base name of the active data files. If another sequence is selected for editing while a sequence is running, the sequence status panels continue to show the name of the running sequence and the base name of the data files storing the measurement data from the current sequence run.

Clicking once on any sequence status panel displays the control center.

<table>
<thead>
<tr>
<th>PANEL</th>
<th>DISPLAYED DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top or Left</td>
<td>- Sequence status: “Idle,” “Running,” or “Paused”</td>
</tr>
<tr>
<td></td>
<td>- Sequence name and status during sequence run</td>
</tr>
<tr>
<td></td>
<td>- “none” and “Idle” if sequence is idle</td>
</tr>
<tr>
<td>Middle or Right</td>
<td>- Sequence name during sequence run</td>
</tr>
<tr>
<td></td>
<td>- “none” if sequence is idle</td>
</tr>
<tr>
<td></td>
<td>- Data file name if sequence is running</td>
</tr>
<tr>
<td></td>
<td>- “none” if sequence is idle</td>
</tr>
<tr>
<td>Bottom</td>
<td>- Data file name if sequence is running</td>
</tr>
<tr>
<td></td>
<td>- “none” if sequence is idle</td>
</tr>
</tbody>
</table>
2.3.5.2 FIELD STATUS PANELS

The field status panels display the current magnetic field and indicate the state of field control. Clicking once on any field status panel opens the Magnetic Field dialog box.

<table>
<thead>
<tr>
<th>PANEL</th>
<th>DISPLAYED DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top</td>
<td>Field set point</td>
</tr>
<tr>
<td>Middle</td>
<td>Current field</td>
</tr>
<tr>
<td>Bottom</td>
<td>State of field control</td>
</tr>
</tbody>
</table>

Table 2-5. Data in Field Status Panels

2.3.5.3 TEMPERATURE STATUS PANELS

The temperature status panels display the current system temperature and indicate the state of temperature control. Clicking once on any temperature status panel opens the Temperature Parameters dialog box.

<table>
<thead>
<tr>
<th>PANEL</th>
<th>DISPLAYED DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top</td>
<td>Current system temperature</td>
</tr>
<tr>
<td>Middle</td>
<td>Temperature set point and sweep rate</td>
</tr>
<tr>
<td>Bottom</td>
<td>State of temperature control</td>
</tr>
</tbody>
</table>

Table 2-6. Data in Temperature Status Panels
2.3.5.4 CHAMBER STATUS PANELS

The chamber status panels display the state of the sample chamber status and indicate the level of helium in the dewar.

Clicking once on any chamber status panel opens the Chamber dialog box.

Table 2-7. Data in Chamber Status Panels

<table>
<thead>
<tr>
<th>PANEL</th>
<th>DISPLAYED DATA</th>
<th>STATUS BAR MAXIMIZED</th>
<th>STATUS BAR MINIMIZED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top</td>
<td>Helium level in dewar</td>
<td>Helium level in dewar</td>
<td></td>
</tr>
<tr>
<td>Middle</td>
<td>State of sample chamber</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bottom</td>
<td>Status of impedance heater, driver, and cooling valve</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When the EverCool option is active, the MPMS MultiVu status bar can display EverCool system status data instead of sample chamber status data. Refer to the Magnetic Property Measurement System: EverCool Dewar Option User’s Manual.

2.3.6 Data File Windows

MPMS MultiVu documents include data files. You may examine data files in graph, table, record, or raw data windows. You may move, minimize, and maximize these windows. Any number of these windows may be open at one time.

Chapter 4 discusses data files and data-viewing formats in detail.

2.3.7 Sequence Windows

MPMS MultiVu documents include sequence files. A sequence editor window displays the sequence commands and command parameters comprising one sequence file. The sequence command bar displays all available sequence commands. Any number of sequence editor windows may be open at one time. You may move, minimize, or maximize the sequence editor window. You may edit a sequence within the sequence editor window. You may move, dock, hide, or display the sequence command bar.

Chapter 5 discusses sequence files and sequence operation in detail.
Sample Measurement

3.1 Introduction

This chapter contains the following information:

- Section 3.2 presents an overview of the sample measurement process.
- Section 3.3 explains how to take a DC sample measurement in immediate mode.
- Section 3.4 describes the measurement algorithms.
- Section 3.5 discusses factors to consider when performing a measurement.

3.2 Overview of Sample Measurements

MPMS MultiVu measures the magnetic moment of a sample by reading the output of the SQUID detector while the sample moves upward, from the initialization position, through the SQUID pickup coils. This upward movement through the SQUID pickup coils completes one vertical scan. Voltage readings that are taken as a function of the sample’s position in the coils comprise the raw measurement data. At each position in the coils, MPMS MultiVu typically reads the SQUID output voltage several times, and MPMS MultiVu can average together multiple scans in order to improve the measurement resolution. MPMS MultiVu saves the raw measurement data to the active raw data, or .raw, file. After collecting the raw voltages, MPMS MultiVu computes the magnetic moment of the sample and saves the magnetic moment to the active measurement data, or .dat, file.

The magnetic moment calibration for the MPMS is determined by measuring a palladium standard over a range of magnetic fields and by then adjusting the system calibration factors to obtain the correct moment for the standard. The standard is a right circular cylinder approximately 3 mm in diameter \( \times 3 \) mm in height. Due to the geometry of the SQUID pickup coils, samples of this size or smaller are effectively point sources to an accuracy of approximately 0.1%.
3.3 Measuring the Sample

The procedures in this section explain how you use the standard sample transport to perform a manual, or immediate, DC sample measurement. Section 5.4 explains how you automate DC measurements by running a sequence. The *Magnetic Property Measurement System: AC Option User’s Manual* explains how you perform an AC sample measurement. The *Magnetic Property Measurement System: Reciprocating Sample Option User’s Manual* explains how you perform an RSO sample measurement and how you use the RSO sample transport.

3.3.1 Attach the Sample

The type, size, and geometry of a sample determine the method you use to attach it to the sample rod. This section explains how you use a clear plastic drinking straw to attach a sample. The straw has minimal magnetic susceptibility and is thus a useful means of attaching a sample. The *MPMS Hardware Reference Manual* describes other techniques you can use to attach samples.

Complete the following steps to attach the sample to the sample rod:

1. Cut off a small section of a clear plastic drinking straw. The section must be small enough to fit lengthwise inside the straw.

2. Weigh and measure the sample. After you insert the sample into the sample chamber, you can use the Sample> Description option to define the sample's mass, in milligrams, and its diameter and length, in millimeters.

3. Use phenolic tweezers to place the sample inside the small straw segment.

4. Hold the straw segment so that its two open ends are vertical.

5. Place the straw segment inside the drinking straw, and move the segment until it is in approximately the middle of the length of the straw. Verify that the walls of the straw obstruct the open ends of the segment. Refer to figure 3-1.

6. Wrap a sufficient amount of tape around the brass-colored end of the sample rod so that the drinking straw will fit snugly over the rod. Quantum Design recommends using Kapton tape.

7. Place the end of the drinking straw over the tape on the sample rod, and then use additional tape to securely attach the straw to the rod.

8. Place a small piece of tape over the exposed end of the drinking straw. This extra piece of tape prevents a loose sample from falling into the sample chamber.

9. Move the slide seal plug up and down part of the sample rod to verify that the rod is well lubricated. If the plug does not move easily, apply a small amount of Apiezon H Grease to the rod. Run your fingers along the length of the rod to ensure a light, even coating of grease.
3.3.2 Insert the Sample

1. Turn the airlock lever on the electronic control assembly counterclockwise so that it is horizontal and in the “Closed” position (see figure 3-2). The MPMS vents the airlock space, which is the portion of the sample chamber located above the airlock valve.

When the airlock lever is closed, it closes the airlock value that is near the top of the sample chamber, thus protecting the lower portion of the chamber from air flowing into the top of the chamber.

2. Wait for the MPMS to vent the airlock space. The yellow “Venting” LED (figure 3-2) flashes on and off while the system vents the space and remains off when the space is vented. The green “Ready” LED does not turn on.

3. Push the two slide seal clamps on the socket block assembly (see figures 3-2 and 3-3) so that the handles of the clamps face the front of the MPMS. When the clamp handles face the front of the MPMS, the airlock plug is unlocked and may be removed from the opening of the airlock space.

4. Remove the airlock plug, which has an anodized, blue coating. Store the plug in a safe place.
5. Verify that three O-rings are on top of the socket block assembly (see figure 3-3). If necessary, stand on a stool or small ladder so that you can examine the top of the socket block. Reinsert any missing O-rings.

The large O-ring at the mouth of the airlock space occasionally sticks to the sample rod when the rod is removed from the sample chamber.

WARNING

Never insert the sample rod into the sample chamber if the O-rings on the top of the socket block assembly are missing. The O-rings prevent air from pumping into the chamber. Air pumped into the chamber can damage the vacuum pump and freeze the sample.

Figure 3-3. O-Rings on Socket Block Assembly

6. Move the slide seal plug down the sample rod until the plug rests just above the sample holder.
7. Lower the sample rod into the airlock space.
8. Move the slide seal plug down the sample rod until the plug rests on top of the socket block assembly. If necessary, adjust the position of the slide seal clamps to correctly seat the plug.
9. Turn the slide seal plug until the white dot on the plug faces the front of the MPMS. When the white dot faces the front of the MPMS, the proper amount of gas flows through the slide seal.
10. Push the two slide seal clamps completely outward or inward. When the handles of the clamps do not face the front of the MPMS, the clamps lock the slide seal plug in position by forcing it downward against the three O-rings.
11. Press the “Purge Airlock” button on the electronic control assembly (see figure 3-2). The MPMS purges the airlock space and cycles through the purge sequence four times. The yellow “Venting” LED turns on during the purge.
12. Wait for the MPMS to purge the airlock space. The green “Ready” LED turns on when the purge sequence is complete.

If the “Ready” LED does not turn on, the airlock space may have a leak. Missing or improperly seated O-rings may cause the leak. Perform the following steps to check for a leak: (a) Select Instrument〉Chamber〉Vent Sample Space to vent the sample chamber; (b) remove the sample rod when the “Venting” LED turns off; and (c) verify that the O-rings are properly seated and lubricated. If necessary, correctly seat and lubricate the O-rings.
13. Turn the airlock lever clockwise so that it is vertical and in the “Open” position. When the lever is in the “Open” position, it opens the airlock value.

14. Lower the sample rod gently and slowly until the black slide clamp on the rod engages the actuator shoe on top of the sample transport. Figure 3-2 illustrates the actuator shoe. When the slide clamp engages the actuator shoe, the rod is fully inserted into the sample chamber. The knurled nut must be near the top of the sample rod or you will be unable to fully insert the rod into the sample chamber. If necessary, loosen the nut, and then move it until it is 1 to 2 inches from the top of the rod.

15. Loosen the two clip screws on top of the actuator shoe until the screw threads are visible. Do not remove the screws.

16. Rotate the slide clamp so that its two curved slots hook around the clip screws. If necessary, continue to loosen the clip screws until the slide clamp is properly seated.

17. Tighten the clip screws. The clip screws secure the sample rod to the actuator shoe, so the sample transport can move the rod vertically.

3.3.3 Define the Sample Parameters

Defining the sample parameters is optional; MPMS MultiVu does not read the parameters during the measurement. However, if you want to save the parameters to a measurement data file, you must define them before specifying the base name of the data file and before running the measurement. MPMS MultiVu saves sample parameter data to a data file header only while creating the data file.

Complete the following steps to define the sample parameters:

1. Select **Sample ➤ Description**. The **Sample Description** dialog box opens.

2. Verify that the **Sample Installed** check box is selected. If necessary, click once on the check box.

3. Enter a descriptive name for the sample. **Unknown** is the default name until a name is specified. The name you enter is the name under which MPMS MultiVu stores all information about the sample and the measurement.

4. Enter the mass, in milligrams, of the sample.

5. Enter the diameter, in millimeters, of the sample.

6. Enter the length, in millimeters, of the sample.

7. Define the shape of the sample.

8. Enter a comment if you want to include a comment in the data file header. A comment may have up to 63 characters.

9. Select **OK**.
3.3.4  **Center the Sample**

The sample must be centered in the SQUID pickup coils to ensure that all four coils sense the magnetic moment of the sample. If the sample is not centered, the coils read only part of the magnetic moment.

The MPMS can run a full DC centering measurement or a partial DC centering measurement. System operation during a full centering measurement is factory defined; the MPMS scans the entire length of the sample transport’s vertical travel path, and MPMS MultiVu reads the maximum number of data points. System operation during a partial centering measurement is defined by the values you set for the scan and SQUID parameters. During a partial centering measurement, the MPMS scans only the distance you specify, and MPMS MultiVu reads only the number of data points you specify.

The parameter values set for a partial centering measurement are set for any subsequent sample measurements. A partial centering measurement therefore indicates whether the sample will be centered during the sample measurement. Before you measure the sample, you should run a partial centering measurement.

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>ACCEPTED VALUES</th>
<th>DEFINITION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scan Length</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CENTERING SCAN</td>
<td>0.1–12 cm</td>
<td>Length of sample transport’s vertical travel path that is scanned. Sample is centered when it is in middle of scan length.</td>
</tr>
<tr>
<td>FULL SCAN</td>
<td>12 cm</td>
<td></td>
</tr>
<tr>
<td><strong>Data Points</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CENTERING SCAN</td>
<td>2–64</td>
<td>Individual voltage readings plotting response curve in centering scan data file.</td>
</tr>
<tr>
<td>FULL SCAN</td>
<td>64</td>
<td></td>
</tr>
<tr>
<td><strong>Autotracking</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CENTERING SCAN</td>
<td>Enabled</td>
<td>Automatic tracking and adjustment of sample position to keep sample centered in SQUID coils. Auto-tracking compensates for thermal expansion and contraction in sample rod.</td>
</tr>
<tr>
<td>FULL SCAN</td>
<td>Disabled</td>
<td></td>
</tr>
</tbody>
</table>

**Table 3-3. SQUID Parameters**

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>ACCEPTED VALUES</th>
<th>DEFINITION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Measurement Axis</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CENTERING SCAN</td>
<td>Longitudinal</td>
<td>SQUID axis from which measurements are taken.</td>
</tr>
<tr>
<td>FULL SCAN</td>
<td>Transverse</td>
<td></td>
</tr>
<tr>
<td><strong>EMU Range</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CENTERING SCAN</td>
<td>Autoranging</td>
<td>Autoranging allows EMU range to be changed as necessary so that it is appropriate for SQUID output. EMU range is sensitivity value indicating maximum magnetic moment MPMS can measure without saturating SQUID detector.</td>
</tr>
<tr>
<td>FULL SCAN</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Extended</td>
<td></td>
</tr>
</tbody>
</table>

Sections 3.3.4.1 through 3.3.4.4 explain how you center the sample.
3.3.4.1 INITIALIZE THE SAMPLE TRANSPORT

1. Select Center >> DC. The DC Centering dialog box opens. The Status panel at the top of the dialog box indicates the status of an on-going centering measurement and the result of the last centering measurement. The Control panel contains the centering command buttons. The function of each button is summarized to the right of the button.

![DC Centering Dialog Box](image)

Figure 3-5. DC Centering Dialog Box

2. Select Initialize Transport. The MPMS initializes, or calibrates, the sample transport by first lowering it to the lower-travel-limit switch, which is defined as zero, and then raising it until it is in a known position that is just above the lower-travel-limit switch. When the transport is in this known position, it is correctly located to begin centering the sample. The initialization position places the sample far enough below the pickup coils that the SQUID does not detect the sample moment.

If autotracking is enabled when you initialize the transport, the MPMS initializes the transport by moving it to a position far enough above the lower-travel-limit switch in order to allow adjustments for any shrinkage that occurs in the sample rod. This position corresponds to a 0.5-cm offset when the sample chamber is at room temperature. To enable autotracking, select Center >> DC >> Parameters >> Autotracking. Refer to section 3.3.4.2 below.
3.3.4.2 DEFINE THE PARAMETERS

1. Select **Parameters** in the **DC Centering** dialog box. The **DC Center Parameters** dialog box opens and displays the value of each scan and SQUID parameter MPMS MultiVu uses during a partial centering measurement.

![DC Center Parameters Dialog Box](image)

**Figure 3-6.** **DC Center Parameters** Dialog Box

2. Enter the length, in centimeters, of the scan. The default length of a partial centering measurement is 6 cm. During a full centering measurement, the MPMS scans the complete travel path, which is 12 cm.

3. Enter the number of data points that MPMS MultiVu reads during the scan. The default number of data points read during a partial centering measurement is 32. During a full centering measurement, MPMS MultiVu reads the maximum number of data points, which is 64.

4. Verify that autotracking is enabled. If necessary, click once on the **Autotracking** check box.

**NOTE**

Disable autotracking only if you are working with a sample that is very sensitive to centering or if you are using a custom-built sample rod. Quantum Design used a normal sample rod and a quartz sample holder to develop the sample-tracking algorithms. Sample holders and rods that respond to temperature differently than brass, steel, or quartz exhibit greater variations in the position of the sample.

5. Select the SQUID axis from which MPMS MultiVu takes measurements. The **Transverse** axis option is enabled only if the Transverse SQUID is installed. During a full centering measurement, MPMS MultiVu uses the longitudinal SQUID axis.

6. Verify that autoranging is enabled. If necessary, click once on the **Use Autoranging** check box.

**NOTE**

Disable autoranging only if you know the sample’s approximate EMU value and you want to define the normal or extended EMU range most closely matching that value. The **Extended** EMU range option is enabled only if the Extended Range (EDR) option is installed.

7. Select **OK**. The **DC Center Parameters** dialog box closes, and the **DC Centering** dialog box appears again.
### 3.3.4.3 RUN THE CENTERING MEASUREMENT

1. Select **Full DC Scan** or **Center** in the **DC Centering** dialog box.
   - **Full DC Scan** runs a full centering measurement, which covers the complete length of the sample transport’s travel path. A full centering measurement always locates the sample.
   - **Center** runs a partial centering measurement. A partial centering measurement locates the sample only if the sample is within the section of the travel path that is scanned.

   As soon as you initiate the centering measurement, the sample transport moves upward, carrying the sample through the pickup coils. While the sample moves through the coils, MPMS MultiVu measures the SQUID’s response to the magnetic moment of the sample and saves all data from the centering measurement to the centering scan data, or `center.dc.lastscan`, file. Status messages appearing at the top of the **DC Centering** dialog box identify the specific task MPMS MultiVu is performing. Figure 3-7 on the following page illustrates the progress of a centering measurement.

   During a partial centering measurement, MPMS MultiVu uses the iterative regression algorithm to calculate the magnetic moment of the sample. During a full centering measurement, MPMS MultiVu uses the full scan algorithm. If the iterative regression algorithm cannot center the signal, MPMS MultiVu substitutes the linear regression algorithm. The centering measurement continues uninterrupted. Section 3.4 discusses the measurement algorithms in detail.

2. Examine the plot of the `center.dc.lastscan` file to determine whether the sample is centered in the SQUID pickup coils. Refer to figure 3-7. The sample is centered when the peak of the large, middle curve is within 0.05 cm of the half-way point of the scan length. In a 6-cm scan, for example, the sample is centered when the peak of the middle curve is within 0.05 cm of the 3-cm point.

   The shape of the plot is a function of the geometry of the pickup coils. The coils are wound in a second-derivative configuration in which the single-turn, positively charged upper and lower coils are counterwound with respect to the two-turn, negatively charged center coil. In the plot, the large, middle curve is the reading from the two center coils. The smaller first and third curves are the readings from the first and fourth coils, respectively.

   The second-derivative configuration strongly rejects interference from nearby magnetic sources and lets the MPMS function without a superconducting shield around the pickup coils.

3. Select **Full DC Scan** if the MPMS just ran a partial centering measurement but did not locate the sample. After the full centering measurement runs, examine the plot of the `center.dc.lastscan` file. Refer to step 2.

4. Select **Center** if the MPMS just ran a full centering measurement or has not yet run a partial centering measurement. After the partial centering measurement runs, examine the plot of the `center.dc.lastscan` file. Refer to step 2.

You may abort a centering measurement at any time. Simply select the **Abort** button located at the bottom of the **DC Centering** dialog box. After the measurement aborts, **Measurement aborted** appears in the **Status** panel at the top of the dialog box.
Figure 3-7. DC Centering Measurement and Measured SQUID Voltage Response

Figure 3-7a illustrates the sample moving upward through the SQUID pickup coils. Figure 3-7b illustrates MPMS MultiVu measuring the SQUID response while the sample moves through the coils. Figure 3-7c plots the SQUID response against the scan length; the output in figure 3-7c indicates that the sample is too high and must be lowered. Figure 3-7d illustrates a centered sample. In figure 3-7d, the scan begins one-half scan length below the center coils.
3.3.4.4 ADJUST THE SAMPLE POSITION

1. Select **Adjust Position** in the **DC Centering** dialog box if the sample is not centered in the SQUID pickup coils. **Adjust Position** opens the **Adjust Sample Position** dialog box.

![Adjust Sample Position Dialog Box](image)

2. Enter, in centimeters, the correct position of the sample if the computed position displayed in the **Sample Location** text box is incorrect.

3. Verify that the **Perform scan after adjustment** check box is selected. If necessary, click once on the check box.

4. Select **Adjust Automatically**. The MPMS adjusts the position of the sample so that the center peak of the SQUID’s voltage response is within 0.1 cm of half the length of the scan. The MPMS then runs a partial centering measurement. A plot of the **center.dc.lastscan** file opens when the centering measurement is complete.

   If automatic adjustment is outside the limits of the transport mechanism and the RSO option is not installed, a pop-up message tells you to adjust the position manually. Select **Adjust Manually** in the **Adjust Sample Position** dialog box and then follow the on-screen instructions.

   - Lower the sample if the peak of the large, middle curve in the **center.dc.lastscan** file is to the left of the half-way point of the scan length.
   - Raise the sample if the peak is to the right of the half-way point of the scan length.

5. Select **Close**, and then select **Close** again to close the **DC Centering** dialog box.
3.3.5 Measure the Sample

When you initiate an immediate-mode measurement, MPMS MultiVu measures the sample at the current system conditions without waiting for any conditions to stabilize. If you want to ensure that system conditions are stable when the measurement begins, run the measurement in a sequence and use appropriate sequence commands to stabilize system conditions. Refer to section 5.4.

Sections 3.3.5.1 through 3.3.5.3 explain how you run a measurement in immediate mode. Before running a measurement, you may want to refer to section 3.5, “Measurement Considerations.”

3.3.5.1 DEFINE THE PARAMETERS

1. Select Measure DC. The Measure DC dialog box opens. The Status panel at the top of the dialog box indicates the status of an on-going measurement and the result of the last measurement. The Control panel lists the scan and SQUID parameters MPMS MultiVu uses during a measurement and identifies which data files will store the measurement data.

Table 3-2 defines the scan parameters. Table 3-3 defines the SQUID parameters.

Avoid radically modifying the scan and SQUID parameters before you run the sample measurement. By using identical parameter values for the partial centering measurement and the sample measurement, you help ensure that the sample remains centered and that the partial centering measurement accurately reflects the conditions of the sample measurement.

Figure 3-9. Measure DC Dialog Box

2. Enter the length, in centimeters, of the scan if the specified scan length is inappropriate for the measurement.

3. Enter the number of scans that MPMS MultiVu runs and averages together. The MPMS can run from 1 to 50 scans. Specify a large number if the sample is data sensitive or has an extremely small signal. Specify a small number if the sample or experiment is time sensitive. A large number of scans, by including changes that occur in the data, produces more reliable data. When two or more scans run as part of one measurement, MPMS MultiVu computes the average sample moment and standard deviation of each scan and then averages the values of the scans.
4. Enter the number of data points that MPMS MultiVu reads during the scan if the specified number is inappropriate for the measurement. The data points plot the response curve appearing in the active measurement data, or .dat, file.

5. Verify that autotracking is enabled. If necessary, click once on the Autotracking check box.

**NOTE**

Disable autotracking only if you are working with a sample that is very sensitive to centering or if you are using a custom-built sample rod. Quantum Design used a normal sample rod and a quartz sample holder to develop the sample-tracking algorithms. Sample holders and rods that respond to temperature differently than brass, steel, or quartz exhibit greater variations in the position of the sample.

6. Select the SQUID axis from which MPMS MultiVu takes measurements. The Transverse axis option is enabled only if the Transverse SQUID option is installed.

7. Select the measurement algorithm MPMS MultiVu uses to calculate the magnetic moment of the sample. Section 3.4 discusses the measurement algorithms in detail.

8. Verify that autoranging is enabled. If necessary, click once on the Use Autoranging check box.

**NOTE**

Disable autoranging only if you know the sample’s approximate EMU value and you want to define the normal or extended EMU range most closely matching that value. The Extended EMU range option is enabled only if the Extended Range (EDR) option is installed.

### 3.3.5.2 SELECT THE DATA FILES

1. Select Change if you want to save measurement data to a file other than the measurement data, or .dat, file currently selected to store immediate-mode measurement data. The name of the selected .dat file appears in the Data File panel, which is to the left of the Change button.

Change opens the Select or Enter a New DC Data File dialog box. The dialog box lists the names of all .dat files. You can select a file and then select Open, or you can enter the base name of a file in the File name text box, and then select Open. The full name of the .dat file you select or create appears in the Data File panel.

You must create a new .dat file if you want to save the sample parameter data you entered in section 3.3.3 to a .dat file. MPMS MultiVu saves sample parameter data to a data file header only while creating the .dat file. Consequently, there may not be an existing data file containing sample parameter data identifying your sample. If you want to append data to an existing .dat file, try to select a file whose header information identifies your sample.

2. Verify that the Include Diagnostics Data check box is selected if you want to save diagnostic measurement data to a diagnostic data, or .diag, file. If necessary, click once on the check box.

3. Verify that the Include Raw Data check box is selected if you want to save raw measurement data to a raw data, or .raw, file. If necessary, click once on the check box.
3.3.5.3 RUN THE MEASUREMENT

To run a measurement, select **Measure** in the **Measure DC** dialog box. The measurement begins. The sample transport moves upward, carrying the sample through the pickup coils. While the sample moves through the coils, MPMS MultiVu measures the SQUID’s response to the magnetic moment of the sample. If autoranging is disabled, the MPMS repeats each measurement until it locates the EMU range that accommodates the SQUID’s sensitivity. MPMS MultiVu saves all data from the measurement to the active data files. Status messages appearing at the top of the **Measure DC** dialog box identify the specific task MPMS MultiVu is performing.

If the iterative regression algorithm is selected but iterative regression cannot center the signal, MPMS MultiVu substitutes the linear regression algorithm. The measurement continues uninterrupted.

When the measurement is complete, the **Moment** box in the **Measure DC** dialog box displays the new sample moment, and the **Standard Deviation** box displays the new standard deviation.

You may abort a measurement at any time. Simply select the **Abort** button located at the bottom of the **Measure DC** dialog box. The measurement aborts as quickly as possible, although it does not abort in the middle of a scan, but waits until the scan is complete. MPMS MultiVu collects all available data from the aborted measurement and stores the data in the active data files. After the measurement aborts, **Measurement aborted** appears in the **Status** panel at the top of the **Measure DC** dialog box.

3.3.5.4 VIEW THE DATA FILES

Selecting the **View** button in the **Measure DC** dialog box can open any data file that is selected to store the immediate-mode measurement data. **View** opens the **Select a Data File** dialog box. By default, the dialog box lists the names of only the files that are either actively storing measurement data or that will store data the next time a measurement runs. The files share the identical base name. When you select a data file, and then select the **Open** button, the graph view of the data file opens.

You may open a new data file you have selected to store immediate-mode measurement data even before you run a measurement. If you specify a new base file name and then select the **View** button, MPMS MultiVu creates the .dat file and the file’s associated .lastscan file. MPMS MultiVu also creates the .diag and .raw files if you have selected the **Include Diagnostics Data** and **Include Raw Data** options. All the new files are blank; they contain only the header information, which defines the default graph format. Once you open a new file, you can modify the default graph format. New files remain blank until you run a measurement.
3.4 Measurement Algorithms

After MPMS MultiVu collects the raw measurement data, it uses a measurement algorithm to compute the sample’s magnetic moment. Three measurement algorithms are available: iterative regression, linear regression, and full scan. The algorithms should work effectively if MPMS MultiVu collects 24 data points during the scan, although MPMS MultiVu can collect up to 64 data points.

Table 3-4 summarizes the operation of the measurement algorithms and indicates when you should use each algorithm. The following sections discuss the algorithms in more detail.

Table 3-4. Summary of Functions of Measurement Algorithms

<table>
<thead>
<tr>
<th>ALGORITHM</th>
<th>DEFINITION</th>
<th>WHEN TO USE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Iterative Regression</td>
<td>Calculates magnetic moment by mathematically fitting analytical curve to measurement response data. Default measurement algorithm during partial centering measurement.</td>
<td>• To perform short, high-precision scans with few data points.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To perform fast measurements that are relatively insensitive to noise and drift.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To measure very small, noisy, or off-center signals.</td>
</tr>
<tr>
<td>Linear Regression</td>
<td>Calculates magnetic moment by mathematically fitting analytical curve to measurement response data and by assuming sample is properly centered. Used during partial centering measurement if iterative regression cannot center signal.</td>
<td>• To perform short, high-precision scans with few data points.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To measure very small, noisy, or off-center signals.</td>
</tr>
<tr>
<td>Full Scan</td>
<td>Calculates magnetic moment by building response curve as sample moves through full length of pickup coils and by then computing weighted summation of all points in scan. Default measurement algorithm during full centering measurement.</td>
<td>• To perform full centering measurement.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To locate sample within pickup coils.</td>
</tr>
</tbody>
</table>

3.4.1 Iterative Regression Algorithm

The iterative regression algorithm calculates the magnetic moment of the sample by mathematically fitting an analytical curve to the measurement response data. By fitting the curve to the data, the iterative regression algorithm can accommodate variations in the sample’s position that are caused by the thermal expansion of the sample rod. The use of an analytical curve also allows short, high-precision scans that have relatively few data points. The iterative regression algorithm thus permits fast measurements that are less sensitive to noise and drift than measurements performed with the full scan algorithm.
The iterative regression algorithm is the default measurement algorithm during a partial centering measurement. MPMS MultiVu substitutes the linear regression algorithm only if the iterative regression algorithm cannot center the signal. Iterative regression cannot locate the signal if the signal is beyond a certain tolerance.

During a measurement, you select the iterative regression algorithm if you require short, high-precision scans with few data points, or if you require fast measurements that are relatively insensitive to noise and drift. You also select the iterative regression algorithm if you are measuring very small, noisy, or off-center signals. You should avoid selecting the iterative regression algorithm if the scan length includes most of the sample transport’s travel path. Iterative regression—because it tries to fit data to an ideal curve—has difficulty calculating the sample moment when the scan length is large.

### 3.4.2 Linear Regression Algorithm

The linear regression algorithm calculates the magnetic moment of the sample by mathematically fitting an analytical curve to the measurement response data and by assuming the sample is properly centered. The use of an analytical curve allows short, high-precision scans that have relatively few data points. Regression calculations eliminate noise effectively. The linear regression algorithm thus permits fast measurements that are less sensitive to noise and drift than measurements performed with the full scan algorithm. MPMS MultiVu substitutes the linear regression algorithm if the iterative regression algorithm cannot center the signal.

During a measurement, you select the linear regression algorithm if you require short, high-precision scans with few data points, or if you are measuring very small, noisy, or off-center signals.

### 3.4.3 Full Scan Algorithm

The full scan algorithm calculates the magnetic moment of the sample by building a response curve as the sample moves through the full length of the SQUID pickup coils and by then computing a weighted summation of all points in the scan. The sample moment is computed as the square root of the sum of the squares, normalized for the number of data points and the system calibration factors. This analysis works well when the signal is larger than the noise in the system. However, when the response of the sample is comparable to the system noise, the full scan algorithm, because of its squaring process, effectively sums the system noise as well as the sample response instead of trying to average the noise to zero.

The full scan algorithm is the default measurement algorithm during a full centering measurement. The MPMS always locates the sample during a full scan, so MPMS MultiVu never substitutes another algorithm while a full scan is in progress.

During a measurement, you select the full scan algorithm if the MPMS will perform a full scan of the sample transport’s travel path, or if the MPMS has not located the sample within the pickup coils. You select the iterative regression algorithm or linear regression algorithm instead of the full scan algorithm if you are measuring very small, noisy, or off-center signals. The full scan algorithm does not analyze very small signals as effectively as the iterative regression and linear regression algorithms.
3.5 Measurement Considerations

If a single scan takes too long, low-frequency drifts, which degrade the data, occur in the SQUID detector. Consequently, you should average together several short scans rather than try to collect a large number of data points during a single, lengthy scan. Quantum Design recommends that you average at least 10 to 12 readings at each point. You want to take as much data as possible during a single scan without unduly extending the time required to complete the scan. An individual reading of the SQUID output takes approximately 5 milliseconds, and it takes approximately 1 second to move the sample and allow the filter in the SQUID electronics to settle. The time required to move the sample can be reduced somewhat, but this reduction does not decrease the filter settling time for the SQUID electronics. The scan length and the number of data points collected determine the spacing between each pair of data points.

Collecting a number of data points that is an integral power of 2 may be advantageous if you anticipate that more unusual data processing may be performed on the raw data at a later date. Using an integral power of 2 for the number of data points may be required when you use Fast Fourier Transform routines. Otherwise, the MPMS has no specific requirement on the number of data points collected.

The values defining the measurement parameters significantly affect the accuracy of a measurement when you measure samples producing signals that are either slightly larger or slightly smaller than the instrument noise. The values defining the measurement parameters affect the accuracy of a measurement less significantly when you measure samples producing large signals.

3.6 Multiple Measure Sequence Command

A new feature—the Multiple Measure sequence command—has been implemented in revision 1.52 of the MPMS MultiVu software. The Multiple Measure sequence command performs a user-specified number of measurements (of type DC or RSO) and reports the average moment, standard error, and other statistical figures for the population of those measurements. With this command, the user can collect time-dependent statistical measurement data from the MPMS instrument. In addition, the user can set the command to reject measurements that deviate from the average of the overall data set. Thus, the feature allows the user to reject spurious measurements (noise or artifacts) from the data population. Such problem measurements may arise from magnet-flux jumps, external vibrations, and so on, which are most commonly observed when running magnetization versus field loops (see MPMS Application Note #1014-820) while detecting low-moment samples (see MPMS Application Note #1014-822).

3.6.1 Compatibility

The Multiple Measure command does not alter the way that the MPMS system performs the actual measurement. It only coordinates the running and collection of the measurement data and the calculation of the statistics for that collection. The statistical data is recorded in a file that is separate from the measurement file. The new data file has the same base name as the measurement data file but the file extension is .ndat (e.g., mydata.dc.ndat). One line item is written to the .ndat file for every Multiple Measure command that is completed.
The **Multiple Measure** command is compatible with the **Automated Background Subtraction** feature of the MPMS system. However, there are difficulties in using the **In Order** search method when applying a background data file, because the **Multiple Measure** command can reject a deviant measurement and collect another as a substitute. Such substitute measurements may not track with the correct data in the background data file. Therefore, it is recommended that the **In Order** search method not be used with the **Multiple Measure** command. All other search methods will work properly.

### 3.6.2 Accessing and Using Multiple Measure Command

The **Multiple Measure** command is a sequence command. Hence, it is located in the **Measure Commands** section of the **Sequence Command** bar, which is shown in Figure 3-10. The following section explains how to access and use the **Multiple Measure** command.

1. In the main MultiVu window, select **File >> New Sequence** (or **Sequence >> New**).
2. When the **Sequence Command** panel opens, click on the plus (+) sign next to the **Measure Commands** section.
3. When the list of commands appears, double click on the **Multiple Measure** command. The **Multiple Measurement Command** dialog box will open (see Figure 3-11).

The **Multiple Measurement Command** dialog box is used to specify the **Type of measurement** to perform and the **Number of measurements** to be collected.

![Figure 3-10. MPMS MultiVu Window, Sequence Commands panel, and new sequence file](image)

![Figure 3-11. Multiple Measurement dialog box set up to perform RSO measurements.](image)
In Figure 3-11, the dialog box is set to perform 10 RSO measurements. Additional specifications can be made by using the Parameters and Advanced buttons on the right side of the dialog box.

Clicking on the Parameters button opens the standard dialog box for the type of measurement you chose. Here you can specify details about the measurements that you want taken.

For example, because the Multiple Measurement Command dialog box in Figure 3-11 is set up for RSO measurements, clicking on the Parameters button produces the Measure RSO dialog box, as shown in Figure 3-12. In this example, a typical RSO measurement will consist of a 4 cm center scan at 1 Hz with 5 cycles per scan and 3 scans per measurement. For every measurement, the usual information will be recorded in the .dat, .raw, and .diag files.

The Advanced button acts differently. If you click on the Advanced button, the Multiple Measurement Command dialog box (Figure 3-11) expands to show a Measurement Rejection Criteria panel (see Figure 3-13). In this panel you can specify the criteria that will be used to reject individual measurements from the data that is collected. You can set two rejection criteria:

- the maximum number of measurements that are to be rejected
- the number of standard deviations that is permitted before a measurement moment is a candidate for rejection

For your reference, the Multiple Measurement Command dialog box also shows an estimate (Est. maximum time to complete) of the time that it will take to perform the number of measurements you
specified. This estimate includes the time that will be needed to take any necessary extra measurements.

As depicted in Figure 3-13, the **Multiple Measurement Command** is set to perform 10 RSO type measurements. The **Multiple Measurement Command** also is set to reject a maximum of two deviant measurements and to reject measurement values that are more than two standard deviations from the mean.

After the measurements have been completed, the program computes the average ($M_{\text{bar}}$) and standard deviation ($SD_M$) from the collection of moment values. Next, the program determines the moment value that deviates most from the average. If the value deviates by more than the maximum limit that the user set, that moment value is removed from the array of data. Then the program initiates another RSO measurement, which is added to the collection, and $M_{\text{bar}}$ and $SD_M$ are recomputed.

As long as the user-specified number of rejections has not been reached, the program will again determine the most deviant moment value. If the deviant value exceeds the average by more than the specified number of standard deviations, it is rejected, another measurement is made, and $M_{\text{bar}}$ and $SD_M$ are recomputed. If necessary, this process continues until the maximum number of data rejections has been reached. The final $M_{\text{bar}}$ and $SD_M$ are recorded in the .ndat file.

For the data collected with the settings in Figure 3-13, a maximum of two measurements could be removed, and a measurement would have to be more than two standard deviations larger or smaller than the mean value before it would be rejected.

### 3.6.3 Checking the Status of a Multiple-Measure Command

When a Multiple Measure sequence command is executed, the command continues until the specified number of measurements has been completed.

To see the status of the current sequence command, open the Control Center (View >> Control Center), which appears at the left of the MultiVu window. The Control Center shows whether a command is running or complete; the type of measurement being taken; the sequential number of that measurement; and if extra measurements were taken.

As illustrated in Figure 3-14, the Sample is Unnamed, and the name of the Selected Sequence, Sequence1.seq, is that of the open sequence file.

The Sequence Base Data File Name is TestData1. As each of the 10+ measurements is completed, it is stored in a standard data file named TestData1.rso.dat.
When the Multiple Measurement Command has performed the specified number of measurements and ended, the statistical data will be stored in a data file named TestData1.rso.ndat.

The Sequence Status section of the Control Center shows that the command is "Running"; that RSO measurements are being made; and that the measurement is number 1 of 10 (e.g., MeasRSO 1/10). If one extra (substitute) measurement had been taken, the MeasRSO status reading would be 11/10 (i.e., MeasRSO 11/10).

If a measurement meets the rejection criteria and is removed from the array of data that was used to compute $M_{\text{bar}}$ and $SD_M$, an entry is made in the Event Log:

```
00:45:13 06/08/01 INFO    Rejectable measurement found at position: 1, timestamp: 991986148.703000
00:45:13 06/08/01 INFO    Measurement rejected.
```

The position of the rejected measurement is relative to its order in the data. The timestamp corresponds to the time that is recorded in the measurement .dat file for that measurement.

### 3.6.4 Reading the Statistical Data (.ndat) File

Recall that the Multiple Measure command records the results of a statistical analysis of the population of measurement results into a file that has the base name of the individual measurement data file (.dat), but the statistical data file ends with the .ndat extension.

One data line (or record) is written to the .ndat file for each completed Multiple Measure command. To see the statistical data for the measurements, open the .ndat file and select View >> Record. Figure 3-15 illustrates a data record and its layout. The data fields are defined as follows:
Time: The time stamp corresponding to the completion of the first measurement in the collection

Comment: The measurements, if any, that were deviant and rejected. In the example, the 6th value was rejected, then the 10th value was rejected.

Field: The magnetic field present when the Multiple Measure command started.

Avg. Temperature: The average of all the temperatures for the individual measurements in the collection.

Avg. Moment: The average of all the moment values for the individual measurements in the collection.

Avg. Scan Std. Dev.: The average of all the scan standard deviation values for the individual measurements in the collection.

Standard Error: The standard deviation of the individual measurements in the collection from the mean of the population moment ($m$) values, computed using the following equation:

$$S.E. = \sqrt{\frac{1}{n-1} \left[ \sum_{i=1}^{n} m_i^2 - \frac{1}{n} \left( \sum_{i=1}^{n} m_i \right)^2 \right]}$$

Note: This value is not to be confused with the average of the scan standard deviations.

Number of Measurements: The number of measurements (as specified in the Multiple Measurement Command dialog box)

Maximum Num. Meas. to Reject: The maximum number of measurements that could be rejected (as specified in the Multiple Measurement Command dialog box)

Num. Std. Dev. for Reject: The rejection criterion (the allowable number of standard deviations before a measurement is rejected, as specified in the Multiple Measurement Command dialog box). If an individual moment value deviates from the average moment of the collection by more than this value, it will be removed from the collection if the Maximum Num. Meas. to Reject value has not already been reached.

Number Meas. Rejected: The number of individual moment values that were rejected and removed from the collection, causing additional measurements to be taken. This number cannot exceed Maximum Num. Meas. to Reject.
**Deviate Meas. Exists:** The presence of at least one moment value within the collection that still meets the rejection criterion (exceeds the specified maximum number of standard deviations from the average moment) after the maximum number of moment values has been rejected. Note, the position of this deviant measurement will be listed last in the Comment filed.

**RSO Position** (Data field 15) — *Scans per Measurement* (Data field 19): Measurement-specific (DC or RSO) parameters

**Delta Temp (K):** The difference between the largest and smallest temperatures reported for all the measurements in the collection

**Error:** The presence of a measurement error for at least one measurement in the collection. If an error is reported for a measurement in the collection, the measurement will be rejected (just as a deviant measurement moment value would be) and the program will perform an additional measurement, unless the Maximum Num. Meas. to Reject has been reached. Errant measurements are rejected from the list before deviant measurement values.

**Using ABS:** The use of Automated Background Subtraction for the population of measurements.
CHAPTER 4

Data Files

4.1 Introduction

This chapter contains the following information:

- Section 4.2 presents an overview of data files.
- Section 4.3 discusses the various types of data files.
- Section 4.4 discusses data file management.
- Section 4.5 discusses the data-viewing formats.
- Section 4.6 discusses how to change graph formats.

4.2 Overview of Data Files

Multiple types of data files store all measurable data generated by sample measurements, system parameters, and helium fills. Each type of data file stores a specific type of data. Stored data may be examined in several different data-viewing formats, and the plot of the data may be modified. Every data file opens as a graph. A template automatically saves the graph view of a data file.

Data generated by the measurement options is stored in up to four different data files. This multiple-file storage system is in direct contrast to the single-file storage system used in the MPMSR2 DOS software. By separating the measurement data into several files, MPMS MultiVu allows you to easily import the files into other graphics applications.

Data files storing measurement data cannot be overwritten, and no data file can be deleted from within MPMS MultiVu. To delete a data file, you must open the Windows directory that stores the file, and then delete the file from within that directory.

4.2.1 File Format

Every data file consists of two main sections: the header and the data section. The data file header defines the type of data file and the type of data stored in the file as well as the file’s default graph format. Data file headers contain the identical type of information. The data section lists the actual data stored in the file. Data sections list data that is specific to the measurement option that generated the data and to the type of data the file stores.
The format of the data files is designed such that the files may be easily imported by other graphic applications, such as Microsoft Excel. The data file format is comma delimited. Appendix B discusses the data file format in more detail.

### 4.2.2 Naming Conventions

You specify the base name of any data file you want to create. When MPMS MultiVU creates the file, it adds file extensions to the base name. One file extension always identifies which type of data the file stores. When appropriate, a second file extension identifies which type of measurement option generated the data. The generic format of a data file name is thus

```
BaseName.DataType or
BaseName.MeasurementType.DataType.
```

The addition of the file extensions means that multiple data files may share a base name. When you specify a base name for a new measurement data, or .dat file, MPMS MultiVU uses that name to create the base names of the other data files that also store data while the new .dat file is active. If the base name of a new .dat file is `testdata`, MPMS MultiVU saves DC sample measurement data to the `testdata.dc.dat` file and DC centering scan data to the `testdata.dc.lastscan` file. The file extensions identify and organize the related files. The file extensions also protect the function of each data file, ensuring that the file stores only the appropriate type of data.

Table 4-1. Components of Data File Names

<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>SIGNIFICANCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base Name</td>
<td>Defines base file name and can be shared by multiple data files storing different types of data. Base name is user specified and can be any valid Windows 95 file name.</td>
</tr>
<tr>
<td>Measurement Type</td>
<td>Indicates type of measurement option generating data. Measurement type is system specified.</td>
</tr>
<tr>
<td>Data Type</td>
<td>Indicates type of data stored in file. Data type is system specified.</td>
</tr>
</tbody>
</table>

Table 4-2. File Extensions

<table>
<thead>
<tr>
<th>FILE EXTENSION</th>
<th>VALID ENTRIES</th>
<th>WHAT ENTRY INDICATES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measurement Type</td>
<td>.dc</td>
<td>DC measurement</td>
</tr>
<tr>
<td></td>
<td>.rso</td>
<td>RSO measurement</td>
</tr>
<tr>
<td></td>
<td>.ac</td>
<td>AC measurement</td>
</tr>
<tr>
<td></td>
<td>.pfl</td>
<td>Field-profiling measurement</td>
</tr>
<tr>
<td>Data Type</td>
<td>.dat</td>
<td>Measurement data</td>
</tr>
<tr>
<td></td>
<td>.lastscan</td>
<td>Last scan data</td>
</tr>
<tr>
<td></td>
<td>.diag</td>
<td>Summary data from scans</td>
</tr>
<tr>
<td></td>
<td>.raw</td>
<td>Raw SQUID voltages from scans</td>
</tr>
<tr>
<td></td>
<td>.env</td>
<td>System parameter data</td>
</tr>
</tbody>
</table>
4.2.2.1  EXAMPLE: NAMING DATA FILES THAT SAVE SEQUENCE MEASUREMENT DATA

If you specify a new base data file name called PbtoAu_Test1 and then run a sequence that includes DC measurement commands but no other type of measurement command, MPMS MultiVu creates the following two data files when it finishes taking the first measurement in the sequence run:

PbtoAu_Test1.dc.dat
PbtoAu_Test1.dc.lastscan

MPMS MultiVu adds the file extensions to the base file name. By default, the data files reside in the C:\QdMpms\Data directory.

If you specify a new base data file name called PbtoAu_Test2, then modify the DC measurement commands in the selected sequence so that MPMS MultiVU saves diagnostic and raw data, and then run the sequence, MPMS MultiVu creates the following four data files when it finishes taking the first measurement in the sequence run:

PbtoAu_Test2.dc.dat
PbtoAu_Test2.dc.diag
PbtoAu_Test2.dc.raw
PbtoAu_Test2.dc.lastscan

If you specify a new base data file name called PbtoAu_Test3, then modify the selected sequence so that it includes RSO measurement commands, and then run the sequence, MPMS MultiVU creates the following six data files when it finishes taking the first measurement in the sequence run:

PbtoAu_Test3.dc.dat
PbtoAu_Test3.dc.diag
PbtoAu_Test3.dc.raw
PbtoAu_Test3.dc.lastscan
PbtoAu_Test3.rso.dat
PbtoAu_Test3.rso.lastscan

4.2.2.2  EXAMPLE: NAMING DATA FILES THAT SAVE IMMEDIATE MEASUREMENT DATA

If you specify, in the Measure DC dialog box, a new base data file name called CuMagProperties and then run an immediate DC sample measurement, MPMS MultiVU creates the following two data files when it finishes taking the measurement:

CuMagProperties.dc.dat
CuMagProperties.dc.lastscan

When you specify the base file name, MPMS MultiVU adds the file extensions to the name immediately because it knows which type of measurement option will generate the data.

By default, the data files reside in the C:\QdMpms\Data directory.
4.2.3 Active Data Files

The active data files are the files actively storing the measurement data as the data is generated. A data file that is selected to store measurement data does not become “active” until a sequence or immediate measurement begins to run. An active file remains active until the sequence or immediate measurement is aborted or completes or until MPMS MultiVu reads a Set Datafile sequence command.

MPMS MultiVu identifies the data files that either are active or that will be active. The sequence status panels in the status bar and the Sequence Status panel in the control center display the base name of the files storing sequence measurement data. The Sequence Base Data File Name panel in the control center displays the base name of the files storing sequence measurement data or that will store data the next time a sequence runs. The Data File panel in the Measure dialog box displays the full name of the .dat file storing immediate-mode measurement data or that will store data the next time a measurement runs. Figure 5-4 illustrates the control center. Figure 3-9 illustrates the Measure DC dialog box.

The Set Datafile sequence command instructs MPMS MultiVu to make new data files the active data files. The base name of the new files appears in the Sequence Status panel and the sequence status panels, but does not appear in the Sequence Base Data File Name panel.

4.2.4 Template Files

Two types of template files save the defined graph format of data files. A graph configuration, or .gph, file is the template saving the most recently defined graph format of a data file. A graph template, or .tpl, file is a template you create to save the defined graph format of a data file. The graph format is the physical appearance of the graph; that is, the data parameters the graph plots and the gridlines and data indicators the graph uses to plot the data points.

A .gph file is associated with each data file you have opened and then closed. MPMS MultiVu creates the .gph file the first time you close the file. MPMS MultiVu uses the base name of the data file to create the base name of the .gph file. The first time you close the testdata.dc.dat file, MPMS MultiVu creates the testdata.dc.dat.gph file. Every time you reopen and close a data file, MPMS MultiVu updates the associated .gph file. The .gph file ensures that any changes you make to the graph format are saved and reappear when you reopen the data file.

You create .tpl files. You can create a .tpl file of the defined graph format of any data file and then apply that .tpl file to any data file, including the file from which you created the .tpl file. If you apply a .tpl file created from a data file storing one type of measurement data to a file storing a different type of measurement data, MPMS MultiVu may not copy the full format of the template to the other file, because the other file may be unable to use all format items defined in the template. Section 4.4.4 explains how you create .tpl files. Section 4.4.5 explains how you apply .tpl files.
4.3 Types of Data Files

Each type of MPMS MultiVu data file performs a unique function by storing a specific type of measurement data. A file extension, which MPMS MultiVu adds to the base file name at the time the file is created, identifies the type of data file and protects the function of the file, ensuring that it saves only the type of measurement data it was created to save.

<table>
<thead>
<tr>
<th>DATA FILE</th>
<th>FILE EXTENSION</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measurement Data</td>
<td>.dat</td>
<td>Stores pertinent data from measurement.</td>
</tr>
<tr>
<td>Scan Data</td>
<td>.lastscan</td>
<td>Stores raw SQUID voltages from data points read during last scan.</td>
</tr>
<tr>
<td>Raw Data</td>
<td>.raw</td>
<td>Stores raw SQUID voltages from data points read during any number of scans.</td>
</tr>
<tr>
<td>Diagnostic Data</td>
<td>.diag</td>
<td>Stores summary data from any number of scans.</td>
</tr>
<tr>
<td>Helium Data(^1)</td>
<td>.dat</td>
<td>Records level of helium in dewar.</td>
</tr>
<tr>
<td>Environment Log</td>
<td>.env</td>
<td>Stores specified system parameters.</td>
</tr>
<tr>
<td>Field Profile Scan(^2)</td>
<td>.pfl.dat</td>
<td>Stores pertinent data from field profile scan.</td>
</tr>
<tr>
<td>EDC Data</td>
<td>.edc</td>
<td>Generated by EDC program.</td>
</tr>
</tbody>
</table>

\(^1\) MPMS MultiVu has one helium data file. The base name of the file is heliumgr.

\(^2\) The field profile scan data file is available only if the Low Field Profiling option or Ultra Low Field option is installed.

4.3.1 Sample Measurement Data Files

For any sample measurement, MPMS MultiVu may save measurement data in up to four different data files, called the sample measurement data files. The measurement data, scan data, raw data, and diagnostic data files are the sample measurement data files. MPMS MultiVu automatically saves sample measurement data to a measurement data file and data from the last scan to a scan data file. MPMS MultiVu creates the raw data and diagnostic data files and then saves data to those files only if you instruct it to do so.

Each sample measurement data file saves data from only one type of measurement. The name of the file indicates which measurement option generated the data stored in the file. The abbreviation of the measurement option—dc, rso, or ac—appears immediately after the base name of the file. For example, the testdata.dc.dat file stores data from a DC sample measurement. The testdata.rso.dat file stores data from an RSO sample measurement. MPMS MultiVu adds file extensions to the base name of the file when it creates the file.
4.3.1.1 MEASUREMENT DATA FILES

A measurement data, or .dat, file stores all pertinent data generated by any number of sample measurements taken by one type of measurement option. The first type of measurement option to save data to a .dat file determines the type of measurement option data the file stores.

A .dat file stores measurement data only when it is active, and only one .dat file is active at a time. MPMS MultiVu uses the base name of the active .dat file to create the base names of the other files that are active while the .dat file is active. The Sequence Base Data File Name panel in the control center displays the base name of the .dat file that is active during a sequence run or that will be active when a sequence runs. The Data File panel in the Measure dialog box displays the full name of the .dat file that is active during an immediate measurement or that will be active when an immediate measurement runs.

A .dat file contains one line of data for every identical type of measurement taken while the .dat file is active. If a sequence run includes five DC measurement commands, the active .dat file has five new lines of data. MPMS MultiVu appends data to a .dat file and never overwrites a .dat file.

MPMS MultiVu includes a default .dat file, called data0000. You may create any number of additional .dat files. Section 4.4.1 explains how you create .dat files.

4.3.1.2 SCAN DATA FILES

A scan data, or .lastscan, file stores the raw SQUID voltages from the individual data points read during only the last scan taken as part of a measurement. When the same measurement option runs another measurement, MPMS MultiVu updates the .lastscan file, overwriting the file with the data from the last scan.

One .lastscan file is associated with each .dat file, and the files share the identical base name. MPMS MultiVu creates the .lastscan file the first time a measurement runs while the .dat file is active. MPMS MultiVu overwrites the .lastscan file whenever another measurement runs while the same .dat file is active.

One centering scan data, or center.lastscan, file is associated with each measurement option. MPMS MultiVu creates and names the center.lastscan file the first time the measurement option runs a centering measurement. MPMS MultiVu overwrites the center.lastscan file whenever the same option runs another centering measurement.

A .lastscan file contains one line of data for every data point read during the last scan taken as part of a measurement. The lines summarizing data include the average voltage and the average detrended and demeaned voltage as well as the average regression, detrended, and demeaned fit of all data points in the file. If a .lastscan file includes data from a scan that has 32 data points, the file has 32 lines of data.

The .lastscan file performs the same function as the SQUID response graph that was generated by the MPMSR2 DOS software.
4.3.1.3 **RAW DATA FILES**

The raw data, or `.raw`, file stores the raw SQUID voltages from the individual data points read during any number of scans taken by one type of measurement option. MPMS MultiVu creates a `.raw` file only if you instruct it to do so. Each `.raw` file you create is associated with one `.dat` file, and the files share the identical base name. MPMS MultiVu saves data to the `.raw` file only while the file’s associated `.dat` file is active.

A `.raw` file contains one line of data for every data point read during every scan run while the file is active. The lines summarizing data from the last scan that was run include the average voltage and fit of all data points in the `.raw` file. If a `.raw` file includes data from two scans and each scan has 10 data points, the file has 20 lines of data, and lines 11 through 20 include the average voltage and the average detrended and demeaned voltage as well as the average regression, detrended, and demeaned fit of all data points in the file. MPMS MultiVu always appends data to a `.raw` file and never overwrites a `.raw` file.

4.3.1.4 **DIAGNOSTIC DATA FILES**

The diagnostic data, or `.diag`, file stores summary data from any number of scans taken by one type of measurement option. MPMS MultiVu creates a `.diag` file only if you instruct it to do so. Each `.diag` file you create is associated with one `.dat` file, and the files share the identical base name. MPMS MultiVu saves data to the `.diag` file only while the file’s associated `.dat` file is active.

The `.diag` file contains one line of data for every scan performed while the file is active. If a `.diag` file includes data from 10 scans, the file has 10 lines of data. MPMS MultiVu always appends data to a `.diag` file and never overwrites a `.diag` file.

4.3.2 **Helium Data File**

The helium data, or `heliumgr.dat`, file stores the helium-level data from the last helium fill. The file plots the level of helium in the dewar against the length of time of the helium-filling operation. The Utilities►Helium Fill option opens the graph view of the `heliumgr.dat` file. MPMS MultiVu has one `heliumgr.dat` file that it overwrites whenever you run another helium fill.

The `heliumgr.dat` file has one line of data for every helium level recorded during the last helium fill. Each line has two data entries: the timestamp and the helium level. The MPMS system defines the time interval at which the `heliumgr.dat` file stores data.

4.3.3 **Environment Log Files**

The environment log, or `.env`, file stores time-based system data parameters. Once a `.env` file begins to store data, it stores data until it is instructed to stop.

You create all `.env` files (see section 4.4.2). You specify which system data parameters MPMS MultiVu saves to the `.env` file, and you specify the time interval at which MPMS MultiVu saves the data. Only one `.env` file stores data at a time.
The `.env` file has one line of data for each data reading. The number of data readings is determined by the specified time interval. The content of each line of data is determined by the specified data parameters. By default, MPMS MultiVu appends data to a `.env` file. You can instruct MPMS MultiVu to overwrite a `.env` file.

The `.env` file is also referred to as the log MPMS file.

### 4.3.4 Field Profile Scan Files

The field profile scan, or `.pfl`, file stores all pertinent data from a field profile scan. MPMS MultiVu creates a `.pfl` file during a field profile scan. The `.pfl` files are available only if the Low Field Profiling option or the Ultra Low Field option is installed.

The `.pfl` file contains one line of data for every field recorded during the field profile scan. By default, MPMS MultiVu appends data to a `.pfl` file. You can instruct MPMS MultiVu to overwrite the file.

### 4.3.5 EDC Data Files

Data files created in an EDC program by using the EDC data file commands use the same format and naming conventions as all other MPMS MultiVu measurement data files, but add the `.edc` extension to the data file name. The *Magnetic Property Measurement System: External Device Control Language User’s Manual* discusses the EDC data files in detail.
4.4 Data File Management

4.4.1 Creating a Measurement Data File

If you specify the base name of a new .dat file before you run a measurement, you can save data from that measurement to the new file.

The following procedures explain how you create a .dat file to store DC measurement data. The procedures you use to create a .dat file to store RSO measurement data or AC measurement data are nearly identical.

4.4.1.1 CREATING A MEASUREMENT DATA FILE TO SAVE IMMEDIATE MEASUREMENT DATA

1. Select Measure ▶ DC. The Measure DC dialog box opens (see figure 3-9).
2. Select Change. The Select or Enter a New DC Data File dialog box opens. By default, the dialog box lists all .dat files.
3. Select the directory in which the data files will reside, if necessary. The default directory is C:\QdMpms\Data. If you select a directory, all new data files will reside in that directory.
4. Enter only the base name of the new .dat file, and then select Open. The Select or Enter a New DC Data File dialog box closes, and the Measure DC dialog box appears again. The full name of the .dat file, including the file extensions, appears in the Data File panel in the Measure DC dialog box.
5. Select the Include Diagnostics Data and Include Raw Data check boxes if you want MPMS MultiVu to create the .diag and .raw files.
6. Do the following if you want to modify the default graph format of any data file that will store the immediate measurement data: (a) select View, (b) select the file, (c) select Open, and then (d) modify the graph format as necessary. Refer to section 4.6.
   Selecting View prompts MPMS MultiVu to create the .dat and .lastscan files and—if the Include Diagnostics Data and Include Raw Data check boxes are selected—the .diag and .raw files. The new files contain only header information, which defines the default graph format.
7. Select Measure to run the measurement. If you did not select View, MPMS MultiVu creates the data files when it completes the first measurement. If you run multiple measurements while the same data files are active, MPMS MultiVu appends data to the files.
4.4.1.2 CREATING A MEASUREMENT DATA FILE TO SAVE SEQUENCE MEASUREMENT DATA

1. Select the Sequence Base Data File Name Change button in the control center. The Select a Data File dialog box opens. By default, the dialog box lists all .dat files.

2. Select the directory in which the data files will reside, if necessary. If you select a directory, all new data files will reside in that directory.

3. Enter only the base name of the new .dat file, and then select Open. The Select a Data File dialog box closes. The base name of the .dat file appears in the Sequence Base Data File Name panel in the control center. MPMS MultiVu has deleted any file extensions you added to the base file name.

4. Open the selected sequence file if you want to modify the DC measurement commands. In the command dialog box, select the Include Diagnostic Data and Include Raw Data check boxes if you want MPMS MultiVu to create the .diag and .raw files. Section 5.3.2 explains how you edit a sequence.

5. Save the selected sequence file if you have edited it.

6. Select the Run button in the control center in order to run the sequence. MPMS MultiVu creates the .dat and .lastscan files when it completes the first measurement in the sequence. MPMS MultiVu also creates the .diag and .raw files if you instructed it to do so. MPMS MultiVu creates the files and adds the file extensions to the base file names when it knows which type of measurement data the files will store.

Once a measurement is complete, you may open any of the active data files. Do the following: (a) select the Sequence Base Data File Name View button in the control center, (b) select a data file in the Select a Data File dialog box, and then (c) select Open.

If you run multiple sequences while the same data files are active, MPMS MultiVu appends data to those files.

4.4.1.3 CREATING A MEASUREMENT DATA FILE WITHIN A SEQUENCE

1. Select the Selected Sequence Edit button in the control center. A sequence editor opens and lists all commands in the selected sequence. The sequence command bar also opens unless it is hidden or already open.

2. Double-click on the Set Datafile command, which is in the Measure command group in the sequence command bar. Set Datafile opens a dialog box that lists all .dat files.

3. Select the directory in which the data files will reside, if necessary. If you select a directory, all new data files will reside in that directory.

4. Enter only the base name of the new .dat file, and then select Open. The Select a Data File dialog box closes. The base name and file location of the .dat file appear on a single command line in the sequence editor. MPMS MultiVu has deleted any file extensions you added to the base file name.

5. Edit the sequence file in order to correctly position Set Datafile, if necessary. Set Datafile must precede a measurement command if you want to save the data generated by that command to the new files. Section 5.3.2 explains how you edit a sequence.

6. Modify the DC measurement commands, if necessary. In the command dialog box, select the Include Diagnostic Data and Include Raw Data check boxes if you want MPMS MultiVu to create the .diag and .raw files.

7. Save the sequence.
8. Select the Run button in the control center in order to run the sequence. MPMS MultiVu creates the .dat and .lastscan files when it completes the first measurement after it reads Set Datafile. MPMS MultiVu also creates the .diag and .raw files if you instructed it to do so. The files created with Set Datafile remain active throughout the sequence run unless MPMS MultiVu reads another Set Datafile command. During the sequence run, the base name of the data files created with Set Datafile appears in the Sequence Status panel and the sequence status panels, but does not appear in the Sequence Base Data File Name panel.

### 4.4.2 Creating an Environment Log File

1. Select Utilities ➤ Log MPMS Data. The Log Data dialog box opens.
2. Select the General tab. You use the General tab to select an environment log file and to specify how frequently MPMS MultiVu logs data to the file.

![Log Data Dialog Box](image)

Figure 4-1. General Tab in Log Data Dialog Box

3. Select Browse. The Select an Environment Data File dialog opens and lists all .env files.
4. Select the directory in which the .env file will reside, if necessary. If you select a directory, all new data files will reside in that directory.
5. Enter only the base name of the new .env file, then select Open. The full name of the .env file appears at the top of the Data File pull-down menu in the General tab. MPMS MultiVu has added the file extension to the base file name because it knows which type of data the file will store. Notice that you select the Overwrite check box if you want to overwrite an existing .env file. By default, MPMS MultiVu appends data to .env files.
6. Enter the time interval, in seconds, defining how frequently MPMS MultiVu logs data to the .env file. The time interval may be any length from 0.25 seconds to 99,999 seconds.
7. Select the **Standard Items** tab. You use the **Standard Items** tab to select the system data parameters that MPMS MultiVu logs to the .env file.

![Figure 4-2. Standard Items Tab in Log Data Dialog Box](image)

8. Select system parameters. Click on **Select All** to save all parameters. Click on **Unselect All** to deselect all parameters. When you select a parameter, its value appears in the **Standard Items** tab. If you select a large number of parameters, data logging occurs more slowly.

9. Select **Start** to begin logging the specified parameters. MPMS MultiVu creates the .env file when it begins logging data.

   At any time, you can specify different parameters for MPMS MultiVu to log. However, while MPMS MultiVu logs the data, you cannot redefine the time interval at which the data is logged. You cannot run multiple .env files.

10. Select **View Data** in the **General** tab in order to open the .env file.

11. Select **Stop** to stop logging data. MPMS MultiVu logs data until you instruct it to stop.

### 4.4.3 Changing the Sequence Base Data File Name

1. Select the **Sequence Base Data File Name Change** button in the control center. The **Select a Data File** dialog box opens. By default, the dialog box lists all .dat files.

2. Select a .dat file, then select **Open**. The base name of the .dat file appears in the **Sequence Base Data File Name** panel in the control center. The file does *not* open.
4.4.4 Creating a Graph Template File

1. Select an open data file, and verify that the graph view is active.
2. Modify the graph format, if necessary. Refer to section 4.6.
3. Select Graph ➤ Save Template As. The Save as a Graph Template File dialog box opens and lists all .tpl files. The full name of the data file you are using to create the template is displayed. However, MPMS MultiVu has replaced the original file extension with the .tpl extension.
4. Select Open or specify a different file name and then select Open. MPMS MultiVu creates the .tpl file.

4.4.5 Applying a Graph Template File

1. Select an open data file, and verify that the graph view is active.
2. Select Graph ➤ Apply Template. The Apply a Template to the Current Graph dialog box opens and lists all .tpl files.
3. Select a .tpl file, then select Open. MPMS MultiVu applies the .tpl file to the graph format of the data file, modifying the graph format so that it is defined by the template.
   If you apply a .tpl file created from a data file storing one type of measurement data to a file storing a different type of measurement data, MPMS MultiVu does not necessarily copy the full format of the template to the data file; the data file may not be able to use all format items defined in the .tpl file.

4.4.6 Printing a Graph

Before you print any graph view or sequence file, you can use the File ➤ Print Preview option to see what the graph or sequence file will look like when it is printed. The view window also includes a Print button.

1. Select an open data file, and verify that the graph view is active.
2. Select File ➤ Print. The Print Parameters dialog box opens. The dialog box defines the appearance of the printed graph.
3. Specify what labels, such as the name and path of the data file, you want to print on the graph. Also specify the printing options.
4. Select OK. The Print dialog box opens.
5. Select a printer and define the printer properties, specify the number of copies, and so on.
6. Select OK. The graph is printed.
4.5 Data-Viewing Formats

MPMS MultiVu includes four data-viewing formats—the graph view, record view, table view, and raw data view—that give you four different ways of examining the information stored in a data file. The graph view is the default viewing format. Every data file opens in the graph view. Once a data file is open, you can select any of the other three viewing formats. Multiple views of a data file or of several files may be open at one time.

Commands in the **View** menu and **Graph** pop-up menu open and select viewing formats. You open the **Graph** pop-up menu by right-clicking the mouse inside any graph window.

4.5.1 Graph View

The graph view is a plot of data points that MPMS MultiVu has saved to a data file. The graph plots only the specified data points and may not plot all data points saved to the file. MPMS MultiVu uses the current graph configuration, or .gph, file to plot the points.

![Graph View](image.png)

In the graph view, one data point is highlighted, or selected. If you double-click close to the selected data point, the record view opens and lists the values of all parameters for that data point. If you double-click a part of the graph area that is not near the selected data point, the table view opens and lists all parameters for all data points in the data file. To select a different data point, click on that data point.

The graph view automatically opens when you open a data file. If a data file is open and selected, but the graph view is not selected, you can open the graph view by selecting the **View** ➤ **Graph** option.
4.5.2 Record View

The record view is a table listing the value of all parameters for one data point that MPMS MultiVu has saved to a data file. Each row in the table displays the name and value of one parameter. The number in the left-hand column of every row helps separate the rows and identifies which column in the table-view table displays the same parameter data. The number of rows in the record-view table is determined by the number of parameters associated with the data point.

The header in the record window indicates which data point you are examining. The data point is always the last data point selected in the graph view or table view. To select a different data point, use the First, Prev, Next, and Last buttons that are at the bottom of the record window, or click on a data point in the graph view or on a row in the table view.

You can open the record view whenever a data file is open and selected, but the record view is not selected. To open the record view, you can select the View→Record option. You can also open the record view by double-clicking on any point in the graph view or by double-clicking on any row in the table view.
4.5.3 Table View

The table view is a table listing the value of all parameters for all data points that MPMS MultiVu has saved to a data file. Each row in the table displays all parameter data for one data point. The number in the left-hand column of a row identifies the order in which the data point was read in the sequence of data points comprising the data file. The number of data points read determines the number of rows in the table.

![Table View](image)

The highlighted, or selected, row in the table view identifies the last data point selected in the graph view or record view. If you double-click on the selected row, the record listing the value of all parameters for that data point opens. To select a different data point, click on another row in the table view.

You can open the table view whenever a data file is open and selected, but the table view is not selected. To open the table view, you can select the View ▶ Table option.

4.5.4 Raw Data View

The raw data view is a text editor view of a data file. You can open the raw data view whenever a data file is open and selected, but the raw data view is not selected. To open the raw data view, you can select the View ▶ Raw Data option.
4.6 Graph Formats

The graph format is the physical appearance and layout of the graph view of a data file. A graph’s appearance refers to the gridlines and data indicators the graph uses to plot different types of data stored in the file. The header section of a data file defines the default graph format of the file. You cannot change the default graph format. However, when the graph view is active, you can modify its appearance in multiple ways.

Commands in the Graph menu and Graph pop-up menu change the graph format. Graph menu and Graph pop-up menu options are nearly identical. However, Graph menu options emphasize opening and saving files; Graph pop-up menu options emphasize viewing data. The Graph pop-up menu is available only when the graph view is active. You open the Graph pop-up menu by right-clicking the mouse inside any graph window.

4.6.1 Selecting Gridlines and Data Indicators

1. Select an open data file, and verify that the graph view is active.
2. Select Graph ➤ Appearance. The Appearance submenu opens. The submenu can contain up to four numbered Plot options. One option is enabled for each plot in the graph view.
3. Select a Plot option. A pop-up dialog box opens and identifies which gridline and data indicator options define the format of the selected plot.
4. Select options in the Plot Appearance pop-up dialog box. If the active graph view has multiple plots, you can select Apply to All Plots to apply the format of the selected plot to all plots in the graph view.
5. Select Apply to apply the changes and keep the pop-up dialog box open or select OK to apply the changes and close the dialog box.

The Graph ➤ Auto Scale All Plots option or the Graph pop-up menu ➤ Auto Scale All Plots option adjusts the axis limits so that the plotted data points are comfortably spaced and you can see all of your data.

The Graph pop-up menu ➤ X Axis Auto Scale toggle option or Y Axis Auto Scale toggle option adjusts the x-axis gridlines or y-axis gridlines, respectively, so that the plotted data points are comfortably spaced.
### 4.6.2 Plotting Parameters

1. Select an open data file, and verify that the graph view is active.
2. Select **Graph ➤ Data Selection**. The **Data Selection** dialog box opens and lists all available axes and parameters that may appear in the graph.

![Data Selection Dialog Box](image)

3. Use the **Axis** pull-down menus to select the axes on which MPMS MultiVu plots data in the graph. Each graph must have one x-axis and one y-axis. A graph may have up to four y-axes. To remove an extra y-axis, select **off** in the corresponding pull-down menu.
4. Select the **Log** check box associated with each axis if you want to logarithmically scale the parameter data on that axis. If **Log** is not selected, MPMS MultiVu scales the data linearly.
5. Use the **Data** pull-down menu associated with each axis to select the type of parameter data plotted on the axis. If the graph includes multiple y-axes, you can select a different type of parameter data for each y-axis. When multiple y-axes plot different types of data, MPMS MultiVu creates a separate plot of each x-axis–y-axis combination within the graph window.

An asterisk appearing to the left of any parameter name in a **Data** pull-down menu indicates that MPMS MultiVu has not found data for that parameter.

The **Data** pull-down menus list only the types of parameter data that are in the specified data group. You use the **Data Group** pull-down menu to specify the data group. Refer to step 7.

6. Select the **Auto** check box associated with each axis in order to automatically scale the axis. If **Auto** is not selected, you can specify the minimum and maximum values for the axis. Enter the minimum and maximum values in the **Min** and **Max** text boxes, respectively. The default values appearing in the **Min** and **Max** text boxes represent the axis limits presently defined by the autoscale function.

7. Use the **Data Group** pull-down menu to specify the data group. The data group is a subgroup of similar data parameter types. Select **Longitudinal** to plot only parameters used by the longitudinal SQUID. Select **Transverse** to plot only parameters used by the transverse SQUID. Select **All** to plot all available parameters. MPMS MultiVu can plot only the data parameters in the specified data group.

8. Select the time interval the x-axis uses to represent time.
9. Select the method of displaying time in the graph. Select Relative to start the time scale at zero. Select Absolute to use the absolute timestamp value that is stored in the data file.

10. Select the graph’s display range. Select All Records to plot all data points. Select Last or From to display only specified data points.

11. Select Apply to apply the changes and keep the Data Selection dialog box open or select OK to apply the changes and close the dialog box.

### 4.6.3 Magnifying a Graph

1. Select an open data file, and verify that the graph view is active.

2. Click anywhere on the graph, drag the mouse through the graph so that you select the part of the graph you want to magnify, and then release the mouse. The selected part of the graph is magnified. You may repeat this procedure any number of times.

3. Select Graph ➤ Zoom Previous to return a magnified graph to its previous magnification. You can select Zoom Previous any number of times until the graph returns to its original size.

### 4.6.4 Restoring the Current Graph Configuration File

Select Graph ➤ Restore Graph to return the graph format of a data file to the format defined by the current graph configuration, or .gph, file. The current .gph file is the file created the last time the data file was closed. You may select Restore Graph at any time.

### 4.6.5 Restoring the Default Graph Format

Select Graph ➤ Default Graph to return the graph format of a data file to the default graph format defined in the data file header. You may select Default Graph at any time.
CHAPTER 5

Sequence Files

5.1 Introduction

This chapter contains the following information:

- Section 5.2 presents an overview of sequence files.
- Section 5.3 discusses sequence file management.
- Section 5.4 explains how to run a sequence.
- Section 5.5 explains how to run a partial sequence.
- Section 5.6 explains how to edit a paused sequence run.

5.2 Overview of Sequence Files

A sequence file automates MPMS operation by sequentially running multiple commands. A sequence file is comprised of any number of individual sequence commands, and the commands may appear in any order within the sequence. The sequence editor (see figure 5-2) lists all sequence commands and command parameters comprising one sequence file. The sequence command bar (see figure 5-1) lists all sequence commands. Many of the sequence command parameters are user definable.

MPMS MultiVu sequence files are saved to and executed only from disk. All MPMS MultiVu sequences are programmed sequences.

5.2.1 Sequence Commands

MPMS MultiVu has system, center, measure, and diagnostic sequence commands. Commands are grouped by type in the sequence command bar. Each MPMS option includes additional sequence commands that affect only that option. A sequence command instructs the MPMS or an MPMS option to perform one task. Chapter 6 discusses the sequence commands in detail.

When you select a sequence command, MPMS MultiVu prompts you to either review the command parameters or verify that you want to include the command in the sequence file. As soon as you select OK in the pop-up dialog box or pop-up message, the command and its parameters appear on a single line immediately above the highlight bar in the sequence editor. You may edit any command that is in the sequence editor.
5.2.2 Sequence Command Bar

The sequence command bar lists the names of all available sequence commands. In the command bar, commands are grouped according to type, and the command groups appear, from the top to the bottom of the bar, in the order you normally select them. There are System, Center, Measure, and Diagnostic command groups. A minus sign appearing to the left of a command group indicates the group is expanded. A plus sign indicates the group is collapsed.

The sequence command bar opens the first time you create or open a sequence file after you start up MPMS MultiVu. The command bar closes when you close the last open sequence editor window. While a sequence editor window is open, you can use the View Sequence Command Bar toggle option to hide or display the command bar.

The sequence command bar is movable and dockable. You may move it to any location and you may dock it to the right or left side of the MPMS MultiVu interface.

Scroll bars appear on the right side and at the bottom of the sequence command bar if the area inside the command bar cannot show the names of all available sequence commands.

5.2.3 Sequence Editor

The sequence editor shows all sequence commands and associated command parameters comprising one sequence file. When you open or create a sequence file, a sequence editor window showing all commands and parameters in that sequence file opens. The name of the sequence appears in the title bar of the sequence editor window. Multiple sequence editor windows—that is, multiple sequence files—may be open at any one time.

In the sequence editor, each sequence command and its configurable parameters appear on a separate line, called a command line. A highlight bar that is movable and expandable always highlights, or selects, at least one command line. The highlight bar indicates which sequence command or commands will be affected by the next editing command. The Line Number panel located immediately below the title bar in the sequence editor window also indicates which command line is selected or, if multiple lines are selected, which line was last selected. In figure 5-2 on the following page, the highlight bar highlights the first command line, and the Line Number panel indicates that command line “1” is selected.

You may move, resize, minimize, maximize, or duplicate the sequence editor. The Window New Window option opens another window that duplicates the active sequence editor.
5.2.4 Naming Conventions

Every sequence file has a .seq file extension. A sequence file with a base file name such as Sequence1 or Sequence2 has a default name, which MPMS MultiVu assigned to the sequence when the sequence was created. The number in the default base name identifies the chronological order in which the sequence was created since MPMS MultiVu was last started up. For example, a sequence with the default name Sequence5.seq is the fifth sequence created since MPMS MultiVu was started up. You may rename sequence files at any time.

When you restart MPMS MultiVu, the application begins to renumber, starting with Sequence1, the new sequence files you create. However, if the default name of a new file duplicates the name of an existing file, MPMS MultiVu prompts you to rename the new file so that you do not overwrite the existing file.

5.2.5 Selected Sequence and Active Sequence

The selected sequence file is the sequence that runs when you issue a Run command. The selected sequence is always the last sequence file opened or selected. The Selected Sequence panel in the control center displays the name of the selected sequence.

The active sequence file is the sequence actively running. The selected sequence becomes “active” when you issue a Run command. The active sequence remains active until the sequence run is aborted or completes. The Sequence Status panel in the control center and the sequence status panels in the status bar display the name of the active sequence.

The selected sequence usually identifies the active sequence. However, if you open or select another sequence after you begin a sequence run, the sequence you have just opened or selected becomes the selected sequence. The name of the active sequence still appears in the Sequence Status panel and the sequence status panels.
5.3 Sequence File Management

5.3.1 Creating a Sequence

1. Select **Sequence** ➤ **New**. The sequence editor for the new sequence file opens. The sequence command bar also opens unless it is hidden or already open.

   The **End Sequence** command is the only command in the sequence editor. MPMS MultiVu automatically inserts **End Sequence** to mark the conclusion of the sequence.

2. Select **View** ➤ **Sequence Command Bar** if the sequence command bar is hidden.

3. Add commands to the sequence. Do the following: (a) select a command in the sequence command bar, (b) review or modify the parameters as necessary, and then (c) select **OK**. Each new command and its parameters appear on a single line immediately above the highlight bar.

   Once you add a command to the sequence, an asterisk appears to the right of the sequence file name in the editor’s title bar. The asterisk indicates that the sequence has been modified but that the modifications have not been saved.

4. Edit the sequence as necessary. Refer to section 5.3.2.

5. Save the sequence. Do the following: (a) select **File** ➤ **Save**, (b) select the directory in which the sequence files will reside, (c) specify the name of the file, and then (d) select the **Save** button. The default sequence file directory is `C:\QdMpms\Sequence`. If you select a different directory, all new sequence files will reside in that directory.

   You must save any modifications you made to the sequence before you may run it. As soon as you select **Save**, the asterisk next to the sequence file name disappears.

6. Select **File** ➤ **Close** to close the sequence.

5.3.2 Editing a Sequence

You may edit any sequence—including the running sequence—at any time, even when the sequence status is locked. Edits you make to the active sequence, however, have no effect until you save and then rerun the sequence.

Complete the following steps to edit a sequence:

1. Open a sequence file. Do one of the following: (a) select the **Selected Sequence Edit** button in the control center to open the selected sequence or (b) select **Sequence** ➤ **Open** to open any other sequence.

2. Move the highlight bar so that it highlights the command or commands you want to edit or so that it marks the location where commands are inserted into the sequence. Any commands you add to the sequence are inserted immediately above the highlight bar.

   • To select a command, click on it, or use the arrow keys on the PC keyboard to move the highlight bar to the command. The up-arrow and left-arrow keys move the highlight bar upward. The down-arrow and right-arrow keys move the highlight bar downward.

   • To select a contiguous block of commands, click on a command and then drag the mouse through other commands; or click on a command, press <Shift>, and then click on another command or press the up-arrow or down-arrow key.
• To select multiple, noncontiguous commands or to select both a contiguous block of
commands and multiple, noncontiguous commands, press <Ctrl>, and then click on
other commands.

The highlight bar can highlight the End Sequence command, but you cannot cut, copy, or delete
End Sequence.

3. Edit the sequence as necessary by using the editing commands in the tool bar or in the Edit
menu or Edit pop-up menu. Open the Edit pop-up menu by right-clicking the mouse inside the
sequence editor.

Once you edit the sequence, an asterisk appears to the right of the sequence file name in the
editor’s title bar. The asterisk indicates that the sequence has been modified but that the
modifications have not been saved.

4. Add commands to the sequence. Do the following: (a) select a command in the sequence
command bar, (b) review or modify the parameters as necessary, and then (c) select OK. Each
new command and its parameters appear on a single line immediately above the highlight bar.

You can use the <Tab> key on the PC keyboard to switch back and forth between the sequence
editor and the sequence command bar.

5. Repeat steps 2 through 4 as necessary.

6. Select File\>Save. The changes to the sequence must be saved before you may run the sequence.

7. Select File\>Close to close the sequence.

### 5.3.3 Modifying Command Parameters within a Sequence

1. Open a sequence file. Do one of the following: (a) select the Selected Sequence Edit button in
the control center to open the selected sequence or (b) select Sequence\>Open to open any other
sequence.

2. Modify command parameters as necessary. Do the following: (a) double-click on a command in
the sequence editor, (b) modify the parameters, and then (c) select OK. The modified command
replaces the original command in the sequence editor.

Once you modify a command, an asterisk appears to the right of the sequence file name in
the editor’s title bar. The asterisk indicates that the sequence has been modified but that the
modifications have not been saved.

3. Edit the sequence as necessary. Refer to section 5.3.2.

4. Select File\>Save. The changes to the sequence must be saved before you may run the sequence.

5. Select File\>Close to close the sequence.

### 5.3.4 Printing a Sequence

*Before you print any sequence file or graph, you can use the File\>Print Preview option to see what
the sequence or graph will look like when it is printed. The view window also includes a Print button.*

1. Select an open sequence file.

2. Select File\>Print. The Print dialog box opens.

3. Select a printer and define the printer properties, specify the number of copies, and so on.

4. Select OK. The sequence file is printed.
5.3.5 Locking Sequence Status

You may lock the status of a sequence file so that the file’s status may not be changed. If you lock a sequence that is running, the sequence run may not be paused or aborted. If you lock a sequence that is not running, the sequence may not run.

Complete the following steps to lock the sequence status:

1. Select the Lock button in the control center. Lock is enabled only if the sequence file is unlocked. When you select Lock, the Lock Sequence dialog box opens.
2. Enter your name, in the Locked by text box, to indicate you are the person locking the sequence.
3. Enter an explanation, in the Other information text box, of why you are locking the sequence.
4. Select Lock. The sequence is locked. If the sequence is running, the Pause and Abort options are disabled. If the sequence is not running, the Run options are disabled. All Lock options read Unlock.

5.3.6 Unlocking Sequence Status

1. Select the Unlock button in the control center. Unlock is enabled only if the sequence file is locked. When you select Unlock, the Lock Sequence dialog box opens.
2. Select Unlock in the Lock Sequence dialog box. The sequence is unlocked. All sequence control command options are enabled, and MPMS MultiVu deletes the information previously entered in the Lock Sequence dialog box.
5.4 Running a Sequence: An Example

The control center lets you quickly control all sequence operations and review sequence status information. While the control center does not contain the only command buttons that let you work with sequences, the control center lets you perform sequence-related tasks most conveniently. The control center logically displays all sequence status information and commands controlling sequence operation in one location. The control center’s status panels and command buttons are grouped according to function and are arranged, from the top to the bottom of the control center, in the order you normally review or select them. The control center is a main component of the **MPMS MultiVu** window and may always be visible.

![Control Center Diagram](image)

The procedures in this section explain how you create and run a sequence in order to automate DC measurement. Section 3.3 explains how you perform an immediate DC measurement.
5.4.1 Prepare for the Measurement

Before you can run a sequence measurement, you must (1) attach the sample to a sample rod and (2) insert the sample into the sample chamber. Sections 3.3.1 and 3.3.2, respectively, explain these two operations.

Once you insert the sample into the sample chamber, you may also define the sample parameters. Defining the sample parameters is optional. However, MPMS MultiVu saves the parameters to a new measurement data file only if you define the parameters before you specify the base name of the data file and run the measurement. Refer to section 3.3.3 to define the sample parameters.

5.4.2 Create the Sequence

1. Select Sequence►New.
2. Select View►Sequence Command Bar if the sequence command bar is hidden.
3. Add the following DC centering commands to the sequence: (a) Initialize Transport, (b) DC Parameters, (c) DC Center, and (d) Adjust Position. All centering commands are in the Center group in the sequence commands bar. Refer to section 3.3.4 for a detailed discussion of how you define a centering measurement.

**NOTE**
Disable autotracking only if you are working with a sample that is very sensitive to centering or if you are using a custom-built sample rod. Quantum Design used a normal sample rod and a quartz sample holder to develop the sample-tracking algorithms. Sample holders and rods that respond to temperature differently than brass, steel, or quartz exhibit greater variations in the position of the sample.

**NOTE**
Disable autoranging only if you know the sample’s approximate EMU value and you want to define the normal or extended EMU range most closely matching that value. The Extended EMU range option is enabled only if the Extended Range (EDR) option is installed.

4. Add the Measure DC command to the sequence. All measurement commands are in the Measure group in the sequence commands bar. Refer to section 3.3.5 for a detailed discussion of how you define a measurement.

**CAUTION**
Avoid radically modifying the scan and SQUID parameters before you run the sample measurement. By using identical parameter values for the partial centering measurement and the sample measurement, you help ensure that the sample remains centered and that the partial centering measurement accurately reflects the conditions of the sample measurement.

5. Edit the sequence as necessary. Refer to section 5.3.2.

Commands that stabilize system conditions must precede Measure DC in order to stabilize conditions before the measurement runs.

6. Save the sequence. Do the following: (a) select File►Save, (b) select the directory in which the sequence files will reside, (c) specify the name of the file, and then (d) select the Save button. The default sequence file directory is C:\QdMpms\Sequence. If you select a different directory, all new sequence files will reside in that directory.
You must save any modifications you made to the sequence before you may run it. As soon as you select Save, the asterisk next to the sequence file name disappears.

![Example Sequence File](image)

**Figure 5-5. Example Sequence File**

### 5.4.3 Select the Data File

1. Select the **Sequence Base Data File Name Change** button in the control center if you want to save data to files other than the .dat files that are currently selected to store sequence measurement data.

   **Sequence Base Data File Name Change** opens the Select a Data File dialog box. By default, the dialog box lists the names of all .dat files. You must create a new .dat file if you want to save new sample parameter data to a .dat file. MPMS MultiVu saves sample parameter data to a data file header only while creating the .dat file. Consequently, no existing data file may contain sample parameter data that identifies your sample. If you want to append data to an existing .dat file, try to select a file whose header information identifies your sample.

2. Select the directory in which the data files will reside, if necessary. The default directory is C:\QdMpms\Data. If you select a different directory, all new data files will reside in that directory.

3. Select or create a file. You can select a file, and then select Open, or you can enter the base name of a file in the **File name** text box, and then select Open. The base name of the .dat file appears in the **Sequence Base Data File Name** panel. MPMS MultiVu will use the base name of this file to create the base names of all the files that will store the sequence measurement data.
5.4.4 Run the Sequence

1. Verify that the sequence you just created is still the selected sequence. If the name of the sequence does not appear in the Selected Sequence panel, click on the Selected Sequence Change button, select the sequence file, and then select Open. The sequence editor does not need to be open for you to run a sequence.

2. Select the Run button in the control center. By default, MPMS MultiVu executes all commands in the sequence. Refer to section 5.5 to run a partial sequence. The Sequence Status panel in the control center and the sequence data panels in the status bar indicate that a sequence is running. Clicking once in the Sequence Status panel opens the Sequence Status dialog box (figure 5-7), which lists all commands in the active sequence and identifies the command MPMS MultiVu is executing. The dialog box has control command buttons you can use to pause or abort a sequence or to edit a paused sequence. Refer to section 5.6 to edit a paused sequence.

You may continue to work in MPMS MultiVu while the sequence runs.

3. Lock the sequence if you want to ensure that its status is not modified during the sequence run. Refer to section 5.3.5.

4. Wait for the sequence run to finish. The commands in the sequence determine the length of time the sequence runs. When the run is complete, all Run options are enabled, and Idle appears in the Sequence Status panel and in the sequence data panels. If the Sequence Status dialog box is open, all command information in the dialog box disappears as soon as the run is complete.

5.4.4.1 PAUSING, RESUMING, OR ABORTING A SEQUENCE RUN

You may pause and resume an unlocked sequence run or abort an unlocked sequence run at any time.

To pause a sequence, issue a Pause command. There are Pause buttons in the control center, tool bar, and Sequence Status dialog box, and there is a Pause option in the Sequence menu. If you select Pause in the Sequence Status dialog box, you can edit the paused sequence (see section 5.6). Selecting Pause makes the toggle option read Resume. Select Resume to resume the sequence run.

To abort a sequence, you issue an Abort command. There are Abort buttons in the control center, tool bar, and Sequence Status dialog box, and there is an Abort option in the Sequence menu. You may abort a paused sequence.

5.4.4.2 VIEWING DATA FILES

Once a measurement is complete, you may open any of the data files that are storing the sequence measurement data. To open a data file, select the Sequence Base Data File Name View button in the control center. The button opens the Select a Data File dialog box, which by default lists the names of only the files that are either actively storing sequence measurement data or that will store data the next time a sequence runs. The files share the identical base name. You select a data file and then select the Open button. The graph view of the data file opens.
5.5 Running a Partial Sequence

1. Open a sequence file. Do one of the following: (a) select the **Selected Sequence Edit** button in the control center to open the selected sequence or (b) select **Sequence►Open** to open any other sequence.

2. Move the highlight bar so that it highlights the command or commands you want to run. To select a contiguous block of commands, click on a command and then drag the mouse through other commands; or click on a command, press <Shift>, and then click on another command or press the up-arrow or down-arrow key on the PC keyboard. You can select but you cannot run noncontiguous blocks of commands.

3. Select **Run**. The **Run Sequence** dialog box pops up. The options enabled in the dialog box are determined by the command or commands you have selected in the sequence.

4. Select the appropriate option—either **Run selected block** or **Run from cursor to end of sequence**—and then select **OK**. MPMS MultiVu runs only the selected commands.

5.6 Editing a Paused Sequence Run

1. Click once in the **Sequence Status** panel while a sequence is running. The **Sequence Status** dialog box opens and lists all commands in the active sequence. A highlight bar highlights the command MPMS MultiVu is executing.

2. Select **Pause** in the **Sequence Status** dialog box. The **Edit Remaining Cmds** and **Reload Remaining Cmds** buttons in the **Sequence Status** dialog box are enabled.

In the **Sequence Status** dialog box, the **Executing Sequence File** panel identifies the running sequence. The **Current Line** panel displays the line number of the highlighted command.

---

**Figure 5-6. Run Sequence Pop-up Dialog Box**

**Figure 5-7. Sequence Status Dialog Box Shown While Running Sequence Is Paused**
3. Select **Edit Remaining Cmds.** MPMS MultiVu copies all unexecuted commands to another sequence file, called the command list, or *CmdList.seq* file. If MPMS MultiVu was executing a control loop when you selected **Pause**, MPMS MultiVu copies all commands in the control loop—including the executed commands—to the *CmdList.seq* file.

**Edit Remaining Cmds** opens the sequence editor listing all commands in the *CmdList.seq* file. The commands highlighted in the sequence editor and in the **Sequence Status** dialog box are identical.

MPMS MultiVu has one *CmdList.seq* file that it creates the first time **Edit Remaining Cmds** is selected. MPMS MultiVu overwrites *CmdList.seq* each subsequent time **Edit Remaining Cmds** is selected. After MPMS MultiVu creates the *CmdList.seq* file, you may open it at any time, and you may save it as another file.

![Fig 5-8. Sequence Editor Showing Example of Command List Sequence File](image)

4. Edit the *CmdList.seq* file. Refer to section 5.3.2. Notice that you are editing the *CmdList.seq* file; the active sequence file you paused remains unmodified.

5. Select **File►Save** to save the *CmdList.seq* file. You must save any modifications you made to the file in order to run the modified version of the file. If you do not save the modified file, MPMS MultiVu runs the original *CmdList.seq* file, which contains only the unexecuted commands from the paused sequence.

6. Select **Reload Remaining Cmds** in the **Sequence Status** dialog box. MPMS MultiVu loads the commands from the *CmdList.seq* file into the **Sequence Status** dialog box and removes all commands that are part of the paused sequence.

7. Select **Resume**. MPMS MultiVu runs the *CmdList.seq* file, starting with the first command in the file.

The command buttons in the **Sequence Status** dialog box are enabled only while a sequence runs. The status information in the dialog box disappears when the sequence run completes or is aborted.

Selecting **Sequence►Status** also opens the **Sequence Status** dialog box.
Chapter 6

Sequence Commands

6.1 Introduction

This chapter contains the following information:

- Section 6.2 presents an overview of the sequence commands and includes a guide listing page numbers for the commands in this chapter.
- Section 6.3 discusses the scan sequence commands and control loop operation.
- Section 6.4 describes the system sequence commands.
- Section 6.5 describes the center sequence commands.
- Section 6.6 describes the measure sequence commands.
- Section 6.7 describes the diagnostic sequence commands.

6.2 Overview of Sequence Commands

A sequence command instructs the MPMS or an MPMS option to perform one task within a sequence of automated tasks. Any number of sequence commands initiating different tasks may appear in any order in a sequence file. Each sequence command works independently; a sequence command does not know which tasks are performed when the other commands in the sequence are executed.

MPMS MultiVu has system, center, measure, and diagnostic sequence commands. The sequence command bar (figure 5-1) lists the names of all sequence commands. In the command bar, commands are grouped according to type, and the command groups appear, from the top to the bottom of the bar, in the order you normally select them. Commands are alphabetized within each command group. A minus sign appearing to the left of a command group indicates the group is expanded. A plus sign indicates the group is collapsed.

When you select a sequence command, MPMS MultiVu prompts you to either review the command parameters or verify that you want to include the command in the sequence file. As soon as you select OK in the pop-up dialog box or pop-up message, the command and its parameters appear on a single line immediately above the highlight bar in the sequence editor (figure 5-2). Generally, whenever you select a sequence command in the sequence command bar, the parameters of that command duplicate the last command of the same type included in a sequence. The first time you select a sequence command, the command parameters are set to default values.

Section 5.3.2 explains how you edit a sequence. Section 5.3.3 explains how you modify the parameters of a command that is already in a sequence.
6.2.1 End Sequence Command

Every sequence includes the End Sequence command. End Sequence is always the final command in a sequence. When you create a sequence file, MPMS MultiVu inserts End Sequence into the sequence in order to mark the conclusion of the sequence. The highlight bar in the sequence editor may highlight, or select, End Sequence, but you cannot copy, remove, or insert End Sequence.

6.2.2 Similarities between Sequence Commands and Menu Options

Some sequence commands and MPMS MultiVu menu options perform identical tasks. For example, the Instrument Field menu option and the Set Field sequence command both set the magnetic field. Menu option commands execute immediately. Sequence commands execute only when the sequence in which the commands reside runs. You must manually select each menu option, but a sequence can automate any number of sequence commands. Menu option dialog boxes often display relevant status information. Sequence command dialog boxes do not display status information.
### 6.2.3 Guide to Location of Commands in Chapter

#### 6.2.3.1 System Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Sample</td>
<td>6-9</td>
<td>Scan Temperature</td>
<td>6-14</td>
</tr>
<tr>
<td>Remark</td>
<td>6-10</td>
<td>Set Field</td>
<td>6-16</td>
</tr>
<tr>
<td>Run Sequence</td>
<td>6-10</td>
<td>Set Temperature Undercool</td>
<td>6-16</td>
</tr>
<tr>
<td>Scan Field</td>
<td>6-10</td>
<td>Set Temperature</td>
<td>6-16</td>
</tr>
<tr>
<td>Scan Rotation</td>
<td>6-13</td>
<td>Wait For</td>
<td>6-17</td>
</tr>
</tbody>
</table>

#### 6.2.3.2 Center Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Position</td>
<td>6-18</td>
</tr>
<tr>
<td>DC Center</td>
<td>6-18</td>
</tr>
<tr>
<td>DC Parameters</td>
<td>6-18</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Full DC Scan</td>
<td>6-19</td>
</tr>
<tr>
<td>Initialize Transport</td>
<td>6-19</td>
</tr>
</tbody>
</table>

#### 6.2.3.3 Measure Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measure DC</td>
<td>6-20</td>
<td>Set Datafile</td>
<td>6-21</td>
</tr>
</tbody>
</table>

#### 6.2.3.4 Bridge Channel Diagnostic Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autorange</td>
<td>6-21</td>
<td>Max Excitation</td>
<td>6-22</td>
</tr>
<tr>
<td>Autoscan</td>
<td>6-22</td>
<td>User Mode</td>
<td>6-22</td>
</tr>
</tbody>
</table>
### 6.2.3.5 CALIBRATION FACTOR DIAGNOSTIC COMMANDS

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>PAGE</th>
<th>COMMAND</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magnet</td>
<td>6-22</td>
<td>Fill Power</td>
<td>6-24</td>
</tr>
<tr>
<td>SQUID</td>
<td>6-23</td>
<td>Oven Factor</td>
<td>6-24</td>
</tr>
<tr>
<td>Field Penetration</td>
<td>6-23</td>
<td>Maximum Temperature</td>
<td>6-24</td>
</tr>
<tr>
<td>SQUID Extended Range</td>
<td>6-23</td>
<td>Minimum Warming Rate</td>
<td>6-25</td>
</tr>
<tr>
<td>SQUID Regression</td>
<td>6-23</td>
<td>Maximum Rate on Pot</td>
<td>6-25</td>
</tr>
<tr>
<td>Minimum Data Points</td>
<td>6-23</td>
<td>Low-Temp. Heater Factor</td>
<td>6-25</td>
</tr>
<tr>
<td>Trans. Rotator Steps/Degree</td>
<td>6-23</td>
<td>Reservoir Fill</td>
<td>6-25</td>
</tr>
<tr>
<td>SQUID Settle Time</td>
<td>6-23</td>
<td>Therm. Consistency Tol.</td>
<td>6-25</td>
</tr>
<tr>
<td>Temperature Tolerance</td>
<td>6-24</td>
<td>Inductance</td>
<td>6-26</td>
</tr>
<tr>
<td>Low Temperature</td>
<td>6-24</td>
<td>Charge Rate</td>
<td>6-26</td>
</tr>
<tr>
<td>Fill Temperature</td>
<td>6-24</td>
<td>Quench Time</td>
<td>6-26</td>
</tr>
<tr>
<td>Fill Time</td>
<td>6-24</td>
<td>Cool Time</td>
<td>6-26</td>
</tr>
</tbody>
</table>

### 6.2.3.6 CHAMBER DIAGNOSTIC COMMANDS

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>PAGE</th>
<th>COMMAND</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cooling Valve</td>
<td>6-27</td>
<td>Start Valve Sequence</td>
<td>6-28</td>
</tr>
<tr>
<td>Flush Valve</td>
<td>6-27</td>
<td>Valve Sequencing</td>
<td>6-28</td>
</tr>
<tr>
<td>Impedance Heater</td>
<td>6-27</td>
<td>Valve/Heater Select</td>
<td>6-28</td>
</tr>
<tr>
<td>Level Meter</td>
<td>6-28</td>
<td>Vent Valve</td>
<td>6-28</td>
</tr>
</tbody>
</table>

### 6.2.3.7 DRIVER CHANNEL DIAGNOSTIC COMMANDS

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>PAGE</th>
<th>COMMAND</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned Input</td>
<td>6-29</td>
<td>Output Power</td>
<td>6-30</td>
</tr>
<tr>
<td>Balance Point</td>
<td>6-29</td>
<td>PID Differentiator</td>
<td>6-31</td>
</tr>
<tr>
<td>Feedback Mode</td>
<td>6-29</td>
<td>PID Gain</td>
<td>6-31</td>
</tr>
<tr>
<td>Maximum Power</td>
<td>6-30</td>
<td>PID Integrator</td>
<td>6-31</td>
</tr>
<tr>
<td>Minimum Power</td>
<td>6-30</td>
<td>PID Preset</td>
<td>6-31</td>
</tr>
<tr>
<td>Output Range</td>
<td>6-30</td>
<td>Updates</td>
<td>6-31</td>
</tr>
</tbody>
</table>
### 6.2.3.8 MAGNET DIAGNOSTIC COMMANDS

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>PAGE</th>
<th>COMMAND</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Charging Mode</td>
<td>6-32</td>
<td>Magnet Relay</td>
<td>6-33</td>
</tr>
<tr>
<td>High-Resolution Mode</td>
<td>6-32</td>
<td>Magnet Reset</td>
<td>6-33</td>
</tr>
<tr>
<td>High-Resolution Relay</td>
<td>6-32</td>
<td>Switch Heater</td>
<td>6-33</td>
</tr>
<tr>
<td>Magnet Current</td>
<td>6-32</td>
<td>Update Magnetic Field</td>
<td>6-33</td>
</tr>
<tr>
<td>Magnet Power</td>
<td>6-32</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 6.2.3.9 SQUID DIAGNOSTIC COMMANDS

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>PAGE</th>
<th>COMMAND</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Reset</td>
<td>6-34</td>
<td>SQUID Gain</td>
<td>6-35</td>
</tr>
<tr>
<td>Group Reset</td>
<td>6-34</td>
<td>SQUID Heater</td>
<td>6-35</td>
</tr>
<tr>
<td>Select Mode</td>
<td>6-34</td>
<td>SQUID Quench</td>
<td>6-35</td>
</tr>
<tr>
<td>Select Power</td>
<td>6-34</td>
<td>SQUID Range</td>
<td>6-35</td>
</tr>
<tr>
<td>Select Tune</td>
<td>6-34</td>
<td>SQUID Reset</td>
<td>6-35</td>
</tr>
<tr>
<td>SQUID Filter</td>
<td>6-34</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 6.2.3.10 DATA LOGGING COMMANDS

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>PAGE</th>
<th>COMMAND</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Data Logging</td>
<td>6-36</td>
<td>Stop Data Logging</td>
<td>6-36</td>
</tr>
</tbody>
</table>

### 6.2.3.11 TRANSPORT DIAGNOSTIC COMMANDS

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>PAGE</th>
<th>COMMAND</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Tracking</td>
<td>6-36</td>
<td>Rotate to Zero</td>
<td>6-37</td>
</tr>
<tr>
<td>Calibrate Long</td>
<td>6-36</td>
<td>Set Long Acceleration</td>
<td>6-37</td>
</tr>
<tr>
<td>Calibrate Rotator</td>
<td>6-37</td>
<td>Set Long Initial Rate</td>
<td>6-38</td>
</tr>
<tr>
<td>Define Long</td>
<td>6-37</td>
<td>Set Long Power</td>
<td>6-38</td>
</tr>
<tr>
<td>Move Long</td>
<td>6-37</td>
<td>Set Long Slew</td>
<td>6-38</td>
</tr>
<tr>
<td>Move Rotator</td>
<td>6-37</td>
<td>Stop Rotator</td>
<td>6-38</td>
</tr>
</tbody>
</table>
### 6.2.3.12 VOLTMETER DIAGNOSTIC COMMANDS

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>PAGE</th>
<th>COMMAND</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Readings to Average</td>
<td>6-39</td>
<td>Set Gain</td>
<td>6-39</td>
</tr>
<tr>
<td>Sampling Rate</td>
<td>6-39</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
6.3 Scan Commands

Scan Field, Scan Rotation, and Scan Temperature are special sequence commands called scan commands. Scan commands are in the System commands group. Scan commands, unlike other sequence commands, can instruct the MPMS to perform multipart tasks, such as setting a range of magnetic fields, within a control loop. The scan command automatically creates the control loop. A control loop may include any number of other sequence commands, including other types of scan commands. A Scan Temperature control loop, for example, may include Scan Field and Scan Rotation commands, but it should not include another Scan Temperature command.

6.3.1 Operation of Control Loop

When MPMS MultiVu works in a control loop, it executes commands cyclically. Immediately after performing one part of the multipart task, MPMS MultiVu sequentially executes all other commands in the control loop. After reading the End Scan command, MPMS MultiVu returns to the beginning of the loop and performs the next part of the multipart task and then sequentially executes the other commands in the loop. MPMS MultiVu repeats this cycle until it performs all parts of the multipart task defined by the scan command.

Each command line listing a command that is inside a control loop is slightly indented from the left side of the sequence editor. The scan command beginning the loop and the End Scan command concluding the loop are not indented. Figure 6-1 illustrates a Scan Temperature control loop nested inside a Scan Field control loop.

![Figure 6-1. Illustration of Control Loop in Sequence Editor](image-url)
6.3.2  End Scan Command

MPMS MultiVu adds the **End Scan** command to the end of every control loop to mark the conclusion of the loop. When MPMS MultiVu reads **End Scan**, it returns to the beginning of the loop unless it has completed the multipart task defined by the scan command. **End Scan** does not instruct the MPMS to perform a task.

Any edits you apply to **End Scan** affect the entire control loop. If you copy **End Scan**, you copy all commands in the control loop. If you try to cut or delete **End Scan**, a warning message pops up. The message states that the edit will cut or delete the entire control loop.
6.4 System Commands

System commands control the basic operation of the MPMS hardware and perform advanced sequence-editing functions. All system commands, except Scan Rotation, are standard on every MPMS unit. Scan Rotation is available only if the Horizontal Rotator option or Vertical Rotator option is active.

Several system commands pause a sequence run until the condition or conditions affected by the command stabilize. Scan Field, Set Field, and Wait For automatically pause a sequence run. Scan Temperature pauses a sequence run when the settle approach mode is active. Including any of these commands in a sequence ensures that system conditions stabilize during the sequence run.

The three scan commands—Scan Field, Scan Temperature, and Scan Rotation—are system commands. Section 6.3 discusses the operation of the scan commands in detail.

6.4.1 Move Sample

Move Sample moves the sample transport or redefines the location of the transport.

If a position to which the sample transport cannot move is specified, a warning message pops up when MPMS MultiVu reads Move Sample.

![Move Transport Dialog Box]

**Figure 6-2. Move Transport Dialog Box**

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DEFINITION</th>
<th>VALUES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>Position to which transport moves or position MPMS MultiVu redefines.</td>
<td>(Variable) cm</td>
</tr>
<tr>
<td>Movement Mode</td>
<td>Task or tasks performed.</td>
<td>• Move to position</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Move to limit and define</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Redefine present position</td>
</tr>
</tbody>
</table>

PARAMETER DEFINITION VALUES

Position Position to which transport moves or position MPMS MultiVu redefines. (Variable) cm

Movement Mode Task or tasks performed.

• Move to position
• Move to limit and define
• Redefine present position
### 6.4.1 MOVEMENT MODES

- **Move to position.** Move-to-position mode moves the sample transport to the specified position. The transport moves in absolute coordinates.
- **Move to limit and define.** Move-to-limit-and-define mode moves the sample transport to the lower-travel-limit switch. When the transport is at the switch, MPMS MultiVu defines the switch as the specified position.
- **Redefine present position.** Redefine present position mode instructs MPMS MultiVu to redefine the transport’s present position as the specified position.

### 6.4.2 Remark

**Remark** inserts a text string, called a *remark*, or a blank line into a sequence file. A remark, which clarifies a sequence operation for other MPMS users, may have up to 1000 characters. A blank line separates consecutive commands. Neither a remark nor a blank line is a command that instructs the MPMS to perform a task.

### 6.4.3 Run Sequence

**Run Sequence** inserts a sequence file into another sequence file so that the added sequence file runs as a single command when the parent sequence runs. You may insert a sequence file into itself.

### 6.4.4 Scan Field

**Scan Field** stabilizes a series of magnetic fields in a specified field range and pauses the sequence run until each field set point is stable. The superconducting magnet limits the maximum possible field.

*Scan Field* is a scan command. Section 6.3 discusses the scan commands in detail.

---

**CAUTION**

Changing the field when the helium level is less than 30% may quench and thus damage the magnet. Before changing the field, MPMS MultiVu checks the level of helium in the dewar and generates a warning message if the helium level is less than 30%.
6.4.4.1 SPACING MODES

The spacing mode and steps mode parameters are interdependent. The selected spacing mode determines which steps mode parameter option is available.

- **Number of steps.** In number-of-steps mode, MPMS MultiVu uses the number of set points in the field range to determine the incremental spacing between the set points. MPMS MultiVu calculates an increment that evenly spaces the set points and that ensures the last field set equals the final field specified.

- **Increments.** In increments spacing mode, MPMS MultiVu uses the incremental change of the field intensity to determine the spacing between the set points. MPMS MultiVu calculates the number of set points that are evenly spaced by the increment and that ensures the last field set equals the final field specified. MPMS MultiVu may modify the increment value to ensure that the last field set and the final field specified are identical.

- **Inverse field.** In inverse-field spacing mode, MPMS MultiVu uses the inverse of each set point in the field range to determine the incremental spacing between the set points. MPMS MultiVu calculates the increment that spaces the inverse of the set points and that ensures the last field set equals the final field specified. The set points are not evenly spaced; spacing decreases as the field approaches zero.
6.4.4.2 STEPS MODES

- **Steps.** Steps mode indicates the number of set points in the field range. Only integers greater than zero may represent the number of set points. **Steps** is the available option only if **Number of Steps** or **Inverse Field** is the selected spacing mode.

- **Increment.** Increment mode indicates the incremental change between the field set points. Any positive, nonzero integer or decimal value may represent the incremental change. **Increment** is the available option only if **Increments** is the selected spacing mode.

6.4.4.3 APPROACH MODES

- **Oscillate.** In oscillate mode, the field oscillates, in decreasing amplitude oscillations, around the set point until the field is within 80 G of the set point, and then the MPMS sets the field. Once the field is set, the Model 1822 MPMS Controller turns off the magnet power supply, so the magnet is superconducting again.

- **No overshoot.** In no-overshoot mode, the field charges to 70% of the difference between the set point and the present field, and then slowly approaches the set point, from one direction, in continuous 70% increments. The field slowly approaches the set point until it is close enough to the set point to drive directly to it. Once the field is set, the Model 1822 turns off the magnet power supply, so the magnet is superconducting again.

- **Hysteresis mode.** In hysteresis mode, the field charges directly to the set point. The control PC keeps the magnet power supply turned on, so current constantly flows to the magnet, and the persistence switch heater remains warm. Hysteresis mode sets fields more rapidly but less accurately than oscillate mode or no-overshoot mode.

<table>
<thead>
<tr>
<th>MODE</th>
<th>WHEN TO USE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oscillate</td>
<td>• To set fields accurately.</td>
</tr>
<tr>
<td></td>
<td>• To eliminate magnetic relaxation effects in superconducting magnets.</td>
</tr>
<tr>
<td></td>
<td>• To allow MPMS to immediately work at high sensitivities following large changes in fields.</td>
</tr>
<tr>
<td></td>
<td>• To avoid excessive helium boil-off.</td>
</tr>
<tr>
<td>No Overshoot</td>
<td>• To prevent field from oscillating between positive and negative fields.</td>
</tr>
<tr>
<td></td>
<td>• To prevent field from exceeding set point.</td>
</tr>
<tr>
<td></td>
<td>• To avoid excessive helium boil-off.</td>
</tr>
<tr>
<td>Hysteresis</td>
<td>• To set fields rapidly.</td>
</tr>
</tbody>
</table>

6.4.4.4 RESOLUTION MODES

- **Hi res disabled.** When high resolution is disabled, MPMS MultiVu sets each set point within 1 G of the value of the set point.

- **Hi res enabled.** When high resolution is enabled, MPMS MultiVu sets each set point within 0.10 G of the value of the set point when the MPMS operates at fields of 5000 G or less.
### 6.4.5 Scan Rotation

**Scan Rotation** moves the rotator motor to a series of positions that are within a specified range of angular movement. All positions set with **Scan Rotation** are equally spaced. **Scan Rotation** is available only if the Horizontal Rotator or the Vertical Rotator option is active.

**Scan Rotation** is a scan command. Section 6.3 discusses the scan commands in detail.

![Scan Rotation Dialog Box](image)

**Figure 6-4. Scan Rotation Dialog Box**

<table>
<thead>
<tr>
<th><strong>PARAMETER</strong></th>
<th><strong>DEFINITION</strong></th>
<th><strong>VALUES</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Position</td>
<td>First set point in range.</td>
<td>0−360°</td>
</tr>
<tr>
<td>Final Position</td>
<td>Last set point in range.</td>
<td>0−360°</td>
</tr>
<tr>
<td>Spacing</td>
<td>Mode of spacing set points.</td>
<td>• Steps</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Increment (deg)</td>
</tr>
<tr>
<td>• Steps</td>
<td>Number of set points.</td>
<td>• Steps</td>
</tr>
<tr>
<td>• Increment</td>
<td></td>
<td>• Increment (deg)</td>
</tr>
</tbody>
</table>

#### 6.4.5.1 SPACING MODES

The spacing mode and steps mode parameters are interdependent. The selected spacing mode determines which steps mode parameter option is available.

- **Steps.** In steps spacing mode, MPMS MultiVu uses the number of set points in the range of angular movement to determine the incremental spacing between the set points. MPMS MultiVu calculates an increment that evenly spaces the set points and that ensures the last position set equals the final position specified.

- **Increment.** In increment spacing mode, MPMS MultiVu uses the incremental change of the set points to determine the spacing between the set points. MPMS MultiVu calculates the number of set points that are evenly spaced by the increment and that ensures the last position set equals the final position specified.
6.4.5.2 STEPS MODES

- **Steps.** Steps mode indicates the number of set points in the range of angular movement. Only integers greater than zero may represent the number of set points. **Steps** is the available option only if **Steps** is the selected spacing mode.

- **Increment.** Increment mode indicates the incremental change between the set points. Any positive, nonzero integer or decimal value may represent the incremental change. **Increment** is the available option only if **Increments** is the selected spacing mode.

6.4.6 Scan Temperature

Scan Temperature sets a series of temperatures in a specified temperature range. When the settle approach mode is active, Scan Temperature pauses the sequence run until each temperature set point is stable. The state of the MPMS and the maximum system temperature limit the maximum possible temperature.

Scan Temperature is a scan command. Section 6.3 discusses the scan commands in detail.

![Figure 6-5. Scan Temperature Dialog Box](image)

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DEFINITION</th>
<th>VALUES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Temp</td>
<td>First set point in range.</td>
<td>1.7–400 K</td>
</tr>
<tr>
<td>Final Temp</td>
<td>Last set point in range.</td>
<td>1.7–400 K</td>
</tr>
<tr>
<td>Spacing</td>
<td>Mode of spacing set points.</td>
<td>• Number of Steps</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Increments (K)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Inverse Temp</td>
</tr>
<tr>
<td>• Steps</td>
<td>Number of set points.</td>
<td>• Steps</td>
</tr>
<tr>
<td>• Increment</td>
<td></td>
<td>• Increment</td>
</tr>
<tr>
<td>Rate</td>
<td>Rate of approaching set points.</td>
<td>0.001–10 K/min.</td>
</tr>
<tr>
<td>Approach Mode</td>
<td>Mode of approaching set points.</td>
<td>• Settle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Sweep</td>
</tr>
</tbody>
</table>

If the MPMS Oven is installed, the temperature range varies from the range displayed above.
6.4.6.1 SPACING MODES

The spacing mode and steps mode parameters are interdependent. The selected spacing mode determines which steps mode parameter option is available.

- **Number of steps.** In number-of-steps mode, MPMS MultiVu uses the number of set points in the temperature range to determine the incremental spacing between the set points. MPMS MultiVu calculates an increment that evenly spaces the set points and that ensures the last temperature set equals the final temperature specified.

- **Increments.** In increments mode, MPMS MultiVu uses the incremental change of the set points to determine the spacing between the set points. MPMS MultiVu calculates the number of set points that are evenly spaced by the increment and that ensures the last temperature set equals the final temperature specified. MPMS MultiVu may modify the increment value to ensure that the last temperature set and the final temperature specified are identical.

- **Inverse temperature.** In inverse-temperature mode, MPMS MultiVu uses the inverse of each set point in the temperature range to determine the incremental spacing between the set points. MPMS MultiVu calculates the increment that spaces the inverse of the set points and that ensures the last temperature set equals the final temperature specified. The set points are not evenly spaced; spacing decreases as the temperature approaches zero.

6.4.6.2 STEPS MODES

- **Steps.** Steps mode indicates the number of set points in the temperature range. Only integers greater than zero may represent the number of set points. **Steps** is the available option only if **Number of Steps** or **Inverse Temp** is the selected spacing mode.

- **Increment.** Increment mode indicates the incremental change between the set points. Any positive, nonzero integer or decimal value may represent the incremental change. **Increment** is the enabled option only if **Increments** is the selected spacing mode.

6.4.6.3 APPROACH MODES

- **Settle.** In settle mode, the temperature stabilizes at each set point before MPMS MultiVu executes the other commands in the control loop.

- **Sweep.** In the sweep mode, the temperature sweeps through all set points without stabilizing at any temperature. The temperature continues to sweep while MPMS MultiVu executes the other commands in the control loop.

<table>
<thead>
<tr>
<th>MODE</th>
<th>WHEN TO USE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settle</td>
<td>• To set temperatures accurately.</td>
</tr>
<tr>
<td></td>
<td>• To stabilize temperature at each set point.</td>
</tr>
<tr>
<td></td>
<td>• To measure samples that are highly sensitive to temperature.</td>
</tr>
<tr>
<td>Sweep</td>
<td>• To quickly sweep through all set points.</td>
</tr>
</tbody>
</table>

Table 6-2. Suggested Use of Temperature Approach Modes
### 6.4.7 Set Field

**Set Field** sets the magnetic field and pauses the sequence run until the field set point is stable. The superconducting magnet limits the maximum possible field.

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DEFINITION</th>
<th>VALUES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Set point.</td>
<td>(Variable) Oe</td>
</tr>
<tr>
<td>Approach</td>
<td>Mode of approaching set point.</td>
<td>• Oscillate</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• No Overshoot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Hysteresis Mode</td>
</tr>
<tr>
<td>Mode</td>
<td>Resolution mode for set point.</td>
<td>• Hi Res Disabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Hi Res Enabled</td>
</tr>
</tbody>
</table>

Section 6.4.4.3 discusses the approach modes. Section 6.4.4.4 discusses the resolution modes.

### 6.4.8 Set Temperature Undercool

**Set Temperature Undercool** turns on undercool mode for non-ETC (Enhanced Temperature Control) systems. When **Set Temperature Undercool** is enabled, the target temperature is reached more quickly by cooling past it and then oscillating back towards it.

### 6.4.9 Set Temperature

**Set Temperature** sets the system temperature. The state of the MPMS and the maximum system temperature limit the maximum possible temperature.

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DEFINITION</th>
<th>VALUES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>Set point.</td>
<td>1.7–400 K</td>
</tr>
<tr>
<td>Rate</td>
<td>Rate of approaching set point.</td>
<td>0.001–10 K/min.</td>
</tr>
</tbody>
</table>

If the MPMS Oven is installed, the temperature range varies from the range displayed above.
6.4.10 **Wait For**

**Wait For** pauses a sequence run for a specified length of time after all selected system conditions stabilize. If no system condition is selected, **Wait For** pauses the sequence run the specified length of time. **Wait For** can pause a sequence run up to 1 hour.

![Wait For Dialog Box](image)

**Figure 6-6. Wait For Dialog Box**

**Table 6-3. System Conditions Affected by Wait For Command**

<table>
<thead>
<tr>
<th>CONDITION</th>
<th>DEFINITION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temp Stable</td>
<td>System waits for temperature to stabilize.</td>
</tr>
<tr>
<td>Temperature</td>
<td>System waits for temperature to be reached but does not wait for temperature to stabilize unless temperature is target temperature.</td>
</tr>
<tr>
<td>Field</td>
<td>System waits for field to stabilize.</td>
</tr>
<tr>
<td>Position</td>
<td>System waits for transport to stop moving.</td>
</tr>
</tbody>
</table>
6.5 Center Commands

Center commands perform all system operations related to centering a sample in the SQUID pickup coils. Center commands prepare the MPMS to perform a sample measurement. In a sequence, center commands generally precede a measure command.

DC centering commands are standard on all MPMS units. AC centering commands are available only when the AC option is installed. RSO centering commands are available only when the RSO option is installed. Refer to the Magnetic Property Measurement System: AC Option User’s Manual for specific information about AC centering commands. Refer to the Magnetic Property Measurement System: Reciprocating Sample Option User’s Manual for specific information about RSO centering commands.

6.5.1 Adjust Position

Adjust Position automatically adjusts the position of a sample that was not fully centered when a centering measurement was run. Adjust Position typically follows a DC Center command.

6.5.2 DC Center

DC Center runs a DC centering measurement in accordance with the specified DC centering parameters. DC Center follows the DC Parameters command and precedes the Adjust Position command.

6.5.3 DC Parameters

DC Parameters defines the scan and SQUID parameters MPMS MultiVu uses during a partial DC centering measurement. DC Parameters precedes the DC Center command.

Figure 6-7. DC Center Parameters Dialog Box
### Chapter 6  Section 6.5  Sequence Commands

#### Center Commands

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DEFINITION</th>
<th>VALUES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan Length</td>
<td>Length of transport’s travel path that is scanned.</td>
<td>0.1–12 cm</td>
</tr>
<tr>
<td>Data Points</td>
<td>Individual voltage readings taken during scan.</td>
<td>2–64</td>
</tr>
<tr>
<td>Autotracking</td>
<td>Automatic adjustment of sample’s position to keep sample centered.</td>
<td>• Enabled</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Disabled</td>
</tr>
<tr>
<td>Measurement Axis</td>
<td>SQUID axis from which measurements are taken.</td>
<td>• Longitudinal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Transverse(^1)</td>
</tr>
<tr>
<td>EMU Range</td>
<td>Maximum magnetic moment system can measure without saturating SQUID detector</td>
<td>• Autoranging</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Normal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Extended(^2)</td>
</tr>
</tbody>
</table>

\(^1\) The **Transverse** option is enabled only if the Transverse SQUID is installed.

\(^2\) The **Extended** option is enabled only if the EDR option is installed.

#### 6.5.3.1 EMU MODES

- **Autoranging.** When autoranging is enabled, MPMS MultiVu changes the EMU range as necessary so that it is appropriate for the SQUID output. By default, autoranging is enabled. Disable autoranging only if you know the sample’s approximate EMU value.

- **Normal.** In normal mode, MPMS MultiVu uses whatever normal EMU range is selected. You select the range that is appropriate for the sample. Normal is enabled only when auto-ranging is disabled.

- **Extended.** In extended mode, MPMS MultiVu uses whatever extended EMU range is selected. You select the range that is appropriate for the sample. Selecting an extended range is mandatory if the sample has a very high magnetic moment. Extended is enabled only when autoranging is disabled and the Extended Range (EDR) option is installed.

#### 6.5.4 Full DC Scan

**Full DC Scan** runs a full DC centering measurement.

#### 6.5.5 Initialize Transport

**Initialize Transport** initializes, or calibrates, the sample transport by first lowering the transport to the lower-travel-limit switch, which is defined as zero, and then raising the transport until it is in a known position that is just above the lower-travel-limit switch.
6.6 Measure Commands

Measure commands control all system operations related to measuring the SQUID’s response to the magnetic moment of the sample.

The Measure DC command and Set Datafile command are standard on all MPMS units. Other measurement commands are available when MPMS measurement options are installed. For information about any of the measurement option sequence commands, refer to the appropriate option manual.

6.6.1 Measure DC

Measure DC measures the SQUID’s response to the magnetic moment of the sample and defines the scan and SQUID parameters MPMS MultiVu uses during a DC sample measurement.

![Measure DC Dialog Box for Sequence Measurement](image)

Figure 6-8. Measure DC Dialog Box for Sequence Measurement

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DEFINITION</th>
<th>VALUES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan Length</td>
<td>Length of transport’s travel path that is scanned.</td>
<td>0.1–12 cm</td>
</tr>
<tr>
<td>Scans to Average</td>
<td>Number of scans run for one measurement.</td>
<td>1–50</td>
</tr>
<tr>
<td>Data Points</td>
<td>Individual voltage readings taken during scan.</td>
<td>2–64</td>
</tr>
<tr>
<td>Autotracking</td>
<td>Automatic adjustment of sample’s position to keep sample centered.</td>
<td>Enabled, Disabled</td>
</tr>
<tr>
<td>Measurement Axis</td>
<td>SQUID axis from which measurements are taken.</td>
<td>Longitudinal, Transverse1</td>
</tr>
<tr>
<td>Algorithm</td>
<td>Measurement algorithm used to calculate sample moment.</td>
<td>Iterative Regression, Full Scan, Linear Regression</td>
</tr>
<tr>
<td>EMU Range</td>
<td>Maximum magnetic moment system can measure without saturating SQUID detector.</td>
<td>Autoranging, Normal, Extended2</td>
</tr>
</tbody>
</table>

1 The Transverse option is enabled only if the Transverse SQUID is installed.
2 The Extended option is enabled only if the EDR option is installed.
6.6.2 Set Datafile

Set Datafile makes different or new data files the active files that store data generated during a sequence run. Set Datafile must precede a measurement command in order to instruct MPMS MultiVu to save the data generated by that measurement to the new files.

6.7 Diagnostic Commands

Diagnostic commands are low-level commands that directly control the hardware in the MPMS sample chamber. Diagnostic commands are grouped according to type. The subgroups are alphabetized, and the commands are alphabetized within each subgroup. Bridge channels, chamber, driver channels, magnet, SQUID, transport, voltmeter, and some calibration factor commands are always available. Additional commands are available only when measurement options are installed. For information about any of the measurement option sequence commands, refer to the appropriate option manual.

When a diagnostic parameter is changed, the system temperature control may also be changed. The MPMS resets the system temperature if a parameter value that creates an unacceptable temperature is specified.

Use diagnostic commands only if you are thoroughly familiar with the MPMS and its operation. Misuse of the diagnostic commands can damage the system hardware.

CAUTION

6.7.1 Bridge Channels Commands

The bridge channels commands change the sensor parameters of the four physical channels on the Model 1802 Digital R/G Bridge.

6.7.1.1 AUTORANGE

Autorange enables or disables autoranging on the specified bridge channel. Autoranging instructs the Model 1802 to change the channel’s gain and excitation values as necessary so that the channel produces a nonsaturated reading. If autoranging is enabled, the Model 1802 sets the maximum excitation current for the specified channel.
6.7.1.2 AUTOSCAN

Autoscan enables or disables autoscanning on the specified bridge channel. Autoscanning instructs the Model 1802 to read the bridge channel once during a control loop. If autoscanning is disabled, the Model 1802 reads the channel only when specifically requested to do so. Disabling autoscanning on noncontrolling bridge channels accelerates the control loop. Autoscanning must be enabled if the bridge channel will be the input sensor for a driver channel.

6.7.1.3 MAX EXCITATION

Max Excitation sets the maximum excitation current for the specified bridge channel. The maximum excitation current may be 0.05, 0.5, 5.0, or 50.0 \( \mu \text{A} \). If autoranging is enabled on the specified bridge channel, the MPMS automatically sets the maximum excitation current for that channel.

6.7.1.4 USER MODE

User Mode determines whether the data read by the specified bridge channel is expressed as conductance or resistance—that is, as ohms or millimhos, respectively. If the specified bridge channel is the input sensor for a driver channel, the bridge channel’s user mode determines whether the driver control parameters are expressed as conductance or resistance.

6.7.2 Calibration Factor Commands

The calibration factor commands change the calibration factors of the MPMS and of any installed MPMS options. For information about any of the measurement option sequence commands, refer to the appropriate option manual.

CAUTION

Calibration factors may be changed only if a later calibration test has been performed on the MPMS or if the MPMS must complete nonstandard tasks. Only personnel who are thoroughly familiar with the MPMS and its operation should change calibration factors. The default calibration factors are set so that the system calibration reflects the unique attributes of the individual MPMS unit.

6.7.2.1 MAGNET

Magnet sets the magnet calibration factor, which is the field-to-current, or B/I, ratio. Each MPMS has a unique default B/I ratio.
6.7.2.2  SQUID

*SQUID* sets the SQUID calibration factor for a SQUID axis. Each MPMS has a unique default SQUID calibration factor.

6.7.2.3  FIELD PENETRATION

*Field Penetration* sets the field-penetration calibration factor, which adjusts the SQUID calibration factor for the current magnetic field.

6.7.2.4  SQUID EXTENDED RANGE

*SQUID Extended Range* sets the extended range for a SQUID axis. Each SQUID axis has a unique default extended range.

6.7.2.5  SQUID REGRESSION

*SQUID Regression* sets the regression factor for a SQUID axis.

6.7.2.6  MINIMUM DATA POINTS

*Minimum Data Points* sets the minimum number of data points MPMS MultiVu reads during a scan.

6.7.2.7  TRANSVERSE ROTATOR STEPS/DEGREE

*Transverse Rotator Steps/Degree* sets the number of steps per degree that the transverse sample rotator moves. Each transverse sample rotator has a unique default number of steps per degree.

6.7.2.8  SQUID SETTLE TIME

*SQUID Settle Time* sets the settle time for a SQUID filter. The settle time is the delay the SQUID electronics require in order to provide accurate readings.
6.7.2.9 TEMPERATURE TOLERANCE

Temperature Tolerance sets the temperature tolerance. The temperature is stable when it remains within the temperature tolerance for 1 minute. A temperature tolerance of .005 is recommended.

6.7.2.10 LOW TEMPERATURE

Low Temperature sets the low temperature, which is the minimum temperature that can be set without the MPMS using the helium reservoir, or “pot,” to control the temperature. At sea level, the low temperature is 4.43 K.

6.7.2.11 FILL TEMPERATURE

Fill Temperature sets the fill temperature, which is the temperature the MPMS maintains while the helium reservoir is being filled. At sea level, the fill temperature is 4.15 K.

6.7.2.12 FILL TIME

Fill Time sets the fill time, which is the length of time the helium reservoir collects helium. A fill time of 650 seconds is recommended.

6.7.2.13 FILL POWER

Fill Power sets the fill power, which is the amount of power sent to the proportional valve while the helium reservoir is being filled. The fill power determines the reservoir’s rate of helium collection. A fill power of 3.5 mW/Ω is recommended.

6.7.2.14 OVEN FACTOR

Oven Factor sets the oven calibration factor, which is the calibration factor allowing the MPMS to accurately report the temperature of the sample chamber when the Oven option is installed. Each oven has a unique default oven calibration factor.

6.7.2.15 MAXIMUM TEMPERATURE

Maximum Temperature sets the maximum system temperature.
6.7.2.16 MINIMUM WARMING RATE

Minimum Warming Rate sets the minimum warming rate, which is the rate at which the temperature changes while being warmed by the sample chamber heater. The minimum warming rate is not checked if the current temperature is less than 50 K and the maximum power that can be applied to the sample chamber heater is less than 12 mW/Ω.

6.7.2.17 MAXIMUM RATE ON POT

Maximum Rate on Pot sets the maximum rate on the “pot,” or helium reservoir. The maximum rate on the pot is the rate at which the temperature changes while it operates below the low temperature. The maximum rate on the pot cannot be less than the minimum warming rate.

6.7.2.18 LOW-TEMPERATURE HEATER FACTOR

Low-Temperature Heater Factor sets the low-temperature heater factor, which modifies the heating characteristics of the MPMS when the MPMS operates at low temperatures.

6.7.2.19 RESERVOIR FILL

Reservoir Fill determines whether the Continuous Low-Temperature Control (CLTC) system fills the cold reservoir. Selecting On instructs the CLTC system to fill the cold reservoir before setting the target temperature, and selecting Off allows the CLTC system to sweep to low temperatures.

6.7.2.20 THERMOMETER CONSISTENCY TOLERANCE

Thermometer Consistency Tolerance sets the thermometer consistency tolerance, which is half the minimum difference (less than 4 K) required between the germanium and platinum thermometers before they are checked for failures. If a thermometer fails, both Model 1802 drivers are shut down. The recommended tolerance is 3 K.

Thermometer Consistency Tolerance is available only on systems that do not include the Enhanced Temperature Control (ETC) option.
6.7.2.21 INDUCTANCE

Inductance sets the magnet inductance factor for the 7-T magnet.

6.7.2.22 CHARGE RATE

Charge Rate sets the magnet charging rate for the 7-T magnet. The magnet charging rate controls how quickly the magnet current is charged.

6.7.2.23 QUENCH TIME

Quench Time sets the number of seconds the quench heater remains on when the 7-T magnet is being quenched at 0 G. Quench times at other fields are calculated from the value set with Quench Time.

6.7.2.24 COOL TIME

Cool Time sets the number of seconds the 7-T magnet cools after being quenched at zero field. If the magnet is quenched at a field other than zero, the magnet is cooled for double the time set with Cool Time.

6.7.3 Chamber Commands

The chamber commands provide direct, low-level control of the MPMS gas system.

6.7.3.1 COOLING VALVE

Cooling Valve opens or closes the cooling valve. The cooling valve should normally remain closed. You open the cooling valve to quickly clear the large pumping line, to initiate a high-speed cooling process, or to obtain the lowest possible temperatures in the temperature control system. The cooling valve has the largest capacity of all valves connecting the vacuum pump and the cooling annulus.

6.7.3.2 FLUSH VALVE

Flush Valve opens or closes the flush valve. The flush valve should normally remain open. You close the flush valve during a purge sequence. The flush valve connects the vacuum pump to the airlock space.
6.7.3.3 IMPEDANCE HEATER

Impedance Heater sets the operating mode for the impedance heater. The impedance heater warms the impedance, which is a small tube controlling the flow of gas from the helium bath into the probe. The specified mode for the impedance heater determines how much helium flows into the probe. As power to the impedance heater increases, the heated and expanding gas blocks the narrow passage of the impedance.

<table>
<thead>
<tr>
<th>OPERATING MODE</th>
<th>DEFINITION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Heater is off, so impedance is completely open. Helium flows freely into probe.</td>
</tr>
<tr>
<td>Low</td>
<td>Heater is in low-power mode, so impedance is partially open. Restricted amount of helium flows into probe.</td>
</tr>
<tr>
<td>High</td>
<td>Heater is in high-power mode, so impedance is closed. Helium cannot flow into probe.</td>
</tr>
</tbody>
</table>

6.7.3.4 LEVEL METER

Level Meter turns on or off the helium level meter, which is a perforated tube running the length of the probe and measuring the level of liquid helium in the dewar. The helium level meter should normally be turned off. You turn it on only to plot or update the helium level. When you turn on the helium level meter, it remains on until you turn it off.

⚠️ CAUTION

Turn on the helium level meter only to plot or update the helium level. By keeping the meter off at all other times, you minimize both the loss of helium and the risk of damaging the meter.

MPMS MultiVu automatically turns on the helium level meter once every 30 minutes in order to read the level of helium. MPMS MultiVu also keeps the meter on during a helium fill.

6.7.3.5 START VALVE SEQUENCE

Start Valve Sequence runs or stops a purge or vent valve sequence. The valve sequences control the flush and vent valves.
6.7.3.6 VALVE SEQUENCING

Valve Sequencing enables or disables the automatic purge and vent valve sequences that occur when the “Purge Airlock” button is used to open or close the airlock valve. Automatic valve sequencing should be disabled before a pumping line is disconnected.

6.7.3.7 VALVE/HEATER SELECT

Valve/Heater Select selects the output device—either the proportional solenoid cooling valve or the high-power chamber heater—for driver channel 2 on the Model 1802. The proportional solenoid cooling valve controls the high cooling rate in the MPMS by regulating the amount of gas flowing through the system. The chamber heater creates a high heating rate by applying up to 15 W of heat to the main sample-space heater.

6.7.3.8 VENT VALVE

Vent Valve opens or closes the vent valve, which connects the dewar to the airlock space. The vent valve should normally remain closed. You open the vent valve during a purge sequence. When the vent valve is open, helium flows from the dewar into the airlock space and—if the airlock valve is open—into the sample chamber.

6.7.4 Driver Channels Commands

The driver channels commands configure the two Model 1802 output driver channels as controllers or programmable current sources. The driver channels control the heater output in the MPMS and thus control system temperature.

The driver channels commands include the Proportional-Integral-Differential (PID) commands, which modify the time-constants and power preset values that optimize the performance of the Model 1802 in diverse thermal environments. For detailed information about PID control, refer to the “Applications and Use of PID Control” section in the Model 1802 Digital R/G Bridge Operating Manual.

The units in which many of the driver parameters are expressed depend on both the feedback mode (see section 6.7.4.3) of the driver channel and the user mode (see section 6.7.1.4) of the bridge channel that is the input sensor for the driver channel.

The temperature control software in MPMS MultiVu can change many of the driver channels parameters. Putting the MPMS in standby mode prevents MPMS MultiVu from changing these parameters.

6.7.4.1 ASSIGNED INPUT

Assigned Input selects the bridge channel that functions as the input sensor for the specified driver channel. Only bridge channels that operate in the autoscan mode (see section 6.7.1.2) may be input
sensors for driver channels. It is recommended that you assign bridge channel 1 to driver channel 1, and bridge channel 6 to driver channel 2.

If you change a channel assignment, the driver channel’s dynamic information—present output, filter accumulators, and present error input—is reset to zero. PID operational parameters are not affected by channel reassignment. You must change a channel assignment if the thermometer on the controlling bridge channel malfunctions.

6.7.4.2 BALANCE POINT

Balance Point sets the target, or balance, temperature that the specified driver channel tries to maintain.

6.7.4.3 FEEDBACK MODE

Feedback Mode determines whether the output current from the specified driver channel is expressed as current or power—that is, as milliamps or milliwatts per ohm of heater resistance. The selected feedback mode also determines whether the Model 1802 interprets the parameter values of some input commands as current or power.

Select the feedback mode before you set the other output driver parameters. Failure to select the feedback mode first can create erroneous settings for the feedback control parameters.

6.7.4.4 MAXIMUM POWER

Maximum Power sets the absolute maximum power the specified driver channel can deliver. Maximum Power instructs the Model 1802 to set the power limit and to then decrease the driver’s present output value if the output value is not within the limits specified by Maximum Power.

If the driver channel is operating in the current feedback mode, the Model 1802 expresses the output current as milliamps. If the driver channel is operating in the power feedback mode, the Model 1802 expresses the output current as milliwatts per ohm of heater resistance.

6.7.4.5 MINIMUM POWER

Minimum Power sets the absolute minimum power the specified driver channel can deliver. Minimum Power instructs the Model 1802 to set the power limit and to then increase the driver’s present output value if the output value is not within the limits specified by Minimum Power.

If the driver channel is operating in the current feedback mode, the Model 1802 expresses the output current as milliamps. If the driver channel is operating in the power feedback mode, the Model 1802 expresses the output current as milliwatts per ohm of heater resistance.
6.7.4.6 OUTPUT RANGE

Output Range sets the maximum output range of the specified driver channel. The low range allows for more granularity in the power settings and in the control loop than the high range.

Table 6-5. Maximum Output Range

<table>
<thead>
<tr>
<th>OUTPUT RANGE</th>
<th>VALUES IN CURRENT FEEDBACK MODE</th>
<th>VALUES IN POWER FEEDBACK MODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>0–31.6 mA</td>
<td>0–10 mW/ohm</td>
</tr>
<tr>
<td>High</td>
<td>0–316 mA</td>
<td>0–100 mW/ohm</td>
</tr>
</tbody>
</table>

If the driver channel is operating in the current feedback mode, the Model 1802 expresses the output current as milliamps. If the driver channel is operating in the power feedback mode, the Model 1802 expresses the output current as milliwatts per ohm of heater resistance.

6.7.4.7 OUTPUT POWER

Output Power sets the immediate output power of the specified driver channel.

If the driver channel is being updated when MPMS MultiVu reads Output Power, the power specified by Output Power is active only until the channel is updated again during the normal control function. If you want to specify and hold a specific output value, disable the driver updates and then set the correct output. Section 6.7.4.12 discusses the Updates command.

If the driver channel is operating in the current feedback mode, the Model 1802 expresses the output current as milliamps. If the driver channel is operating in the power feedback mode, the Model 1802 expresses the output current as milliwatts per ohm of heater resistance.

6.7.4.8 PID DIFFERENTIATOR

PID Differentiator sets the differentiator time-constant for the PID filter that is on the specified driver channel. A value of zero seconds removes the differentiator time-constant variable from the PID equation.

The differentiator time-constant helps define the PID control loop. If the proper PID gain and PID integrator settings are selected, the differentiator time-constant reduces the risk of overshooting the balance-point temperature.

6.7.4.9 PID GAIN

PID Gain applies power to the active input sensor in direct proportion to the error signal that is the difference between the actual temperature and the balance-point temperature. The PID gain helps define the PID control loop. A value of zero for the PID gain prevents the PID equation from computing an output.
6.7.4.10  PID INTEGRATOR

PID Integrator sets the integrator time-constant for the PID filter that is on the specified driver channel. A value of zero seconds removes the integrator time-constant variable from the PID equation.

The integrator time-constant helps define the PID control loop. The integrator time-constant allows the Model 1802 to determine the fixed amount of power that is necessary to keep the MPMS at the balance-point temperature once the balance point is reached. The integrator term accumulates value as a function of the error signal.

6.7.4.11  PID PRESET

PID Preset sets the preset power for the specified driver channel. When the driver channel is updated, the preset power is added, as a constant power offset, to the proportional and filter terms that the Model 1802 uses to determine the value of the power actually delivered by the output driver. A value of zero removes the preset-power variable from the PID equation.

6.7.4.12  UPDATES

Updates enables or disables PID control of the specified driver channel. For normal temperature control, driver updates are enabled so that the Model 1802 can control output. When PID control is disabled, the current output level is unaffected by changes in the error signal of the assigned input channel.

6.7.5  Magnet Commands

Magnet commands control the power supply for the superconducting magnet, specify how the MPMS sets target fields, and update the field-intensity data stored in the Model 1822 MPMS Controller.

CAUTION

Improper use of the magnet commands can damage the superconducting magnet and/or the magnet power supply. Damage caused by improper use of the magnet commands is not covered by the system warranty. Only personnel who are thoroughly familiar with the magnet charging system should use the magnet commands.

6.7.5.1  CHARGING MODE

Charging Mode defines how the MPMS approaches a field set point. Section 6.4.4.3 discusses the approach modes in detail.
6.7.5.2  HIGH-RESOLUTION MODE

High-Resolution Mode enables or disables high-resolution mode. High-resolution mode starts up a high-resolution sensor that allows the MPMS to set more precise fields at lower currents. For example, when \( B < 5000 \) G in the 5.5-T magnet, high resolution specifies that the field be set within 0.1 G of the set point, and normal resolution specifies that the field be set within 1.0 G of the set point.

6.7.5.3  HIGH-RESOLUTION RELAY

High-Resolution Relay selects the magnet relay mode that determines the magnet resolution mode. The magnet relay can be changed only if the current from the magnet’s power supply is set to zero.

6.7.5.4  MAGNET CURRENT

Magnet Current specifies the amount of current flowing from the magnet’s power supply. The output current may be set to a nonzero value only if the magnet’s power supply is on, the high-resolution relay status is active, and the magnet polarity is set to the positive or negative mode.

6.7.5.5  MAGNET POWER

Magnet Power turns on or off the magnet’s power supply. The state of the power supply may be changed only if the current from the power supply is set to zero. The power supply should be off unless the MPMS is setting a new field or performing measurements in hysteresis mode.

6.7.5.6  MAGNET RELAY

Magnet Relay instructs the magnet control relays to set the magnet polarity. The magnet polarity defines the direction in which the magnet current flows.

<table>
<thead>
<tr>
<th>POLARITY MODE</th>
<th>DEFINITION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Negative</td>
<td>Magnet current flows in negative direction.</td>
</tr>
<tr>
<td>Positive</td>
<td>Magnet current flows in positive direction.</td>
</tr>
<tr>
<td>Off</td>
<td>Persistent switch heater is short-circuited.</td>
</tr>
</tbody>
</table>
### 6.7.5.7 **MAGNET RESET**

*Magnet Reset* minimizes the magnet’s remnant field by heating and then cooling the magnet. For 5.5-T systems, the magnet is effectively quenched only if the DC field is between 2.5 and 3.5 T and the helium level is at least 50%. For all other magnets, the magnet is effectively quenched only if the DC field is between 0.0 and 3.0 T. MPMS MultiVu does not execute *Magnet Reset* if system conditions prevent an effective quench.

### 6.7.5.8 **SWITCH HEATER**

*Switch Heater* turns on or off the persistent switch heater. When the persistent switch heater is on, current flows from the power source to the magnet. The state of the persistent switch heater may be changed only if the current being delivered by the power supply matches the current in the magnet.

### 6.7.5.9 **UPDATE MAGNETIC FIELD**

*Update Magnetic Field* corrects the field-intensity data stored in MPMS MultiVu and in the Model 1822. *Update Magnetic Field* does not set the magnet current.

**CAUTION**

Use *Update Magnetic Field* only when the field value displayed by MPMS MultiVu differs from the known magnetic field of the superconducting magnet. The superconducting magnet can be damaged if the actual field and displayed field are different.

### 6.7.6 **SQUID Commands**

SQUID commands adjust the amount of power controlling the SQUID.

#### 6.7.6.1 **AUTO RESET**

*Auto Reset* forces the longitudinal and transverse SQUIDs to be reset whenever their voltage outputs are being logged with the MPMS Data Logger (see section 7.8.3) and their output voltages reach ±10 V.

#### 6.7.6.2 **GROUP RESET**

*Group Reset* enables or disables the global reset function on the SQUID axis. A group reset can simultaneously reset all SQUID sensors that receive data from the serial transmission line.
6.7.6.3 SELECT MODE

Select Mode sets the SQUID mode for the SQUID axis. Run mode reconnects the input circuit so that measurements can be taken. Setup mode tunes the SQUID and maximizes the SQUID sensitivity.

6.7.6.4 SELECT POWER

Select Power sets the RF-bias power level for the SQUID axis. The power level may be any value from 0 to 255, which corresponds to 1 to 100% of the drive level. Select Power must be sent to the Model 1822 repeatedly with varying values to effectively “scan” the RF power level.

6.7.6.5 SELECT TUNE

Select Tune sets the tuning level required to tune the RF-bias frequency of the SQUID axis. Select Tune must be sent to the Model 1822 repeatedly with varying values in order to effectively “scan” the tuning level for a SQUID sensor.

6.7.6.6 SQUID FILTER

SQUID Filter selects the anti-alias filter that is applied to the detector output of the SQUID axis. The None filter option allows you to see the raw signal from the SQUID.

6.7.6.7 SQUID GAIN

SQUID Gain sets the SQUID electronics gain factor for the SQUID axis. The gain factor, which amplifies the signal from the SQUID, is applied to the output of the SQUID control unit. Some gain is necessary to amplify the SQUID signal. Too much gain distorts the signal. MPMS MultiVu automatically sets the gain if autoranging is enabled.

6.7.6.8 SQUID HEATER

SQUID Heater turns on or off the SQUID flux transformer heaters so that persistent currents in the SQUID sensor pickup coils can be eliminated. The Model 1822 automatically turns on the SQUID heaters during any field change.

6.7.6.9 SQUID QUENCH

SQUID Quench quenches the SQUID external feedback loop.
6.7.6.10 SQUID RANGE

SQUID Range sets the feedback range on the SQUID axis. The feedback ranges have amp-per-volt ratios of $1 \times 10^{-6}$ to $1 \times 10^{-3}$. When the sensor is set to the internal feedback mode, the feedback ranges correspond to transfer ratios of 1 to 1000 flux quanta per volt. The smallest range is the most sensitive.

6.7.6.11 SQUID RESET

Table 6-7. Reset Modes for SQUID

<table>
<thead>
<tr>
<th>RESET MODE</th>
<th>DEFINITION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release</td>
<td>Allows SQUID to respond to input.</td>
</tr>
<tr>
<td>Hold</td>
<td>Keeps SQUID in state of being constantly reset so that voltage read is zero.</td>
</tr>
<tr>
<td>Momentary</td>
<td>Momentarily resets and then releases SQUID.</td>
</tr>
</tbody>
</table>

SQUID Reset resets a SQUID sensor flux-locked-loop such that the locked-loop detector output is zero to within 1 flux quantum. The time required to reset the sensor or sensors depends on how much feedback current is flowing when the reset is initiated. Single quantum resetting occurs in approximately 10 µsec.

6.7.7 Data Logging Commands

6.7.7.1 START DATA LOGGING

Start Data Logging saves time-based system data parameters to the specified environment log file. When MPMS MultiVu reads Start Data Logging, it logs the specified parameters continuously. MPMS MultiVu stops logging data only when it reads the Stop Data Logging command.

6.7.7.2 STOP DATA LOGGING

Stop Data Logging stops logging data to the specified environment log file.

6.7.8 Transport Commands

CAUTION

The transport commands allow the sample transport to be moved manually and must therefore be used with caution. Before you use a transport command to move the sample transport, you should note the transport’s location so that you do not try to move it beyond the defined travel limits.
6.7.8.1 AUTO TRACKING

Auto Tracking enables or disables autotracking. Autotracking compensates for thermal expansion and contraction in the sample rod and automatically moves the sample transport in order to keep the sample centered in the SQUID pickup coils. Disable autotracking only if (a) you are working with a sample that is not very sensitive to centering, (b) you are using a custom-built sample rod, or (c) the temperature will not change during the measurement.

The effectiveness of autotracking depends on the type of sample holder you are using. Quantum Design used a normal sample rod and a quartz sample holder to develop the sample-tracking algorithms. Sample holders that respond to temperature differently than quartz exhibit greater variations in the position of the sample.

6.7.8.2 CALIBRATE LONG

Calibrate Long moves the sample transport to the lower-travel-limit switch and establishes the lower-travel-limit switch as the transport’s zero position. Calibrate Long is available only if the standard sample transport is installed.

6.7.8.3 CALIBRATE ROTATOR

Calibrate Rotator initiates a series of rotations that locate and redefine the zero-reference orientation of the rotator transport. Calibrate Rotator is available only if the Horizontal Rotator option or Vertical Rotator option is active.

6.7.8.4 DEFINE LONG

Define Long redefines the position of the sample. The available range of positions is determined by the sample’s current position. MPMS MultiVu computes subsequent positioning commands according to the value specified by Define Long. Define Long is available only if the standard sample transport is installed.

6.7.8.5 MOVE LONG

Move Long moves the sample to the specified position. The available range of positions is determined by the sample’s current position. A positive value moves the sample upward, and a negative value moves the sample downward. If you move the sample transport drive mechanism to its travel limit, the drive mechanism’s reference position is lost and subsequent position data will be in error. Move Long is available only if the standard sample transport is installed.
6.7.8.6  **MOVE ROTATOR**

*Move Rotator* moves the rotator to the specified absolute position. *Move Rotator* is available only if the Horizontal Rotator option or Vertical Rotator option is active.

6.7.8.7  **ROTATE TO ZERO**

*Rotate to Zero* moves the sample transport to its most recently defined zero position.

6.7.8.8  **SET LONG ACCELERATION**

*Set Long Acceleration* sets the acceleration rate of the sample transport drive mechanism. The acceleration rate is the rate at which the motor speed ramps from the initial rate to the slew rate and then decelerates from the slew rate to the initial rate. An acceleration rate of 8.0 cm/sec. is recommended. *Set Long Acceleration* is enabled only when the standard sample transport is installed.

6.7.8.9  **SET LONG INITIAL RATE**

*Set Long Initial Rate* sets the initial rate of the sample transport drive mechanism. The initial rate is the rate at which the stepper motor begins to move. An initial rate of 2.0 cm/sec. is recommended. In normal operation, the initial rate is slightly smaller than the slew rate. *Set Long Initial Rate* is available only if the standard sample transport is installed.

The initial rate is particularly important when the sample transport moves in very small increments. When the increments are very small, movement may be so short that the sample transport never accelerates up to the slew rate, so the initial rate almost entirely controls the speed of the stepper motor.

6.7.8.10  **SET LONG POWER**

*Set Long Power* turns on or off the power to the sample transport drive mechanism. The power to the drive mechanism should always remain on. *Set Long Power* is available only if the standard sample transport is installed.

6.7.8.11  **SET LONG SLEW**

*Set Long Slew* sets the slew rate of the sample transport drive mechanism. The slew rate is the rate at which the stepper motor moves after having accelerated its speed according to the acceleration rate. A slew rate of 5.0 cm/sec. is recommended. In normal operation, the slew rate is slightly larger than the initial rate. *Set Long Slew* is available only if the standard sample transport is installed.
6.7.8.12 STOP ROTATOR

Stop Rotator immediately stops the movement of the sample drive mechanism. When Stop Rotator executes, the longitudinal or transverse reference position is lost. Stop Rotator is enabled only if the Horizontal Rotator option or Vertical Rotator option is active.

6.7.9 Voltmeter Commands

Voltmeter commands configure the eight-channel, digital-to-analog converter that is in the Model 1822 so that the converter reads back the SQUID detector output, the current control voltages for the MPMS magnet control system, the voltage for the helium level meter, and the thermocouple output monitoring the pressure in the sample chamber.

6.7.9.1 READINGS TO AVERAGE

Readings to Average sets the number of readings the Model 1822 averages together each time it reads the specified voltmeter. To allow the maximum rejection of 60-Hz noise, you should specify a number that is an integer multiple of 3. It is recommended that the Model 1822 average 30 readings per point.

6.7.9.2 SAMPLING RATE

Sampling Rate sets the sampling rate of the analog-to-digital converter that is on the specified voltmeter. A sampling rate of 180 Hz is recommended.

6.7.9.3 SET GAIN

Set Gain sets the maximum voltage, or gain, the specified voltmeter can read. The value specified by Set Gain overrides the gain the MPMS has set for the voltmeter.
CHAPTER 7

System Operations

7.1 Introduction

This chapter contains the following information:

- Section 7.2 explains how to set the system temperature.
- Section 7.3 explains how to set the magnetic field.
- Section 7.4 explains how to control the atmosphere in the sample chamber.
- Section 7.5 explains how to tune the SQUID.
- Section 7.6 explains how to monitor helium transfers.
- Section 7.7 explains how to make the MPMS enter standby mode.
- Section 7.8 explains how to perform several advanced system operations.

7.2 Setting the Temperature

1. Do one of the following: (a) select Instrument > Temperature or (b) click on any temperature status panel in the status bar. The Temperature Parameters dialog box opens. The dialog box indicates the status of the temperature and includes temperature control commands.

2. Specify the new temperature set point. The state of the MPMS and the maximum system temperature limit the maximum temperature you can specify.

3. Specify the rate at which the MPMS attempts to ramp to the set point. For systems without the Enhanced Temperature Control (ETC) option, you can specify the use of Temperature Undercool.

4. Select Set. The temperature immediately begins to ramp to the set point. The system monitors the changing temperature and temperature status. The Temperature Parameters dialog box and the temperature status panels display the temperature and status.

If a sequence runs while the Temperature Parameters dialog box is open, the Status panel in the dialog box indicates the status of any Set Temperature or Scan Temperature commands that are executed as part of the sequence.


### 7.3 Setting the Magnetic Field

1. Do one of the following: 
   (a) select **Instrument ➤ Field** or 
   (b) click on any field status panel in the status bar. 
   The **Magnetic Field** dialog box opens. The dialog box indicates the status of the magnetic field and includes field control commands.

2. Specify the new field set point. The type of superconducting magnet limits the maximum field the system can accept.

3. Select the process by which the magnet charges to the set point. The oscillate, no-overshoot, and hysteresis approach modes are available. Table 7-1 defines and suggests when you should use each mode.

   **Table 7-1. Suggested Use of Field Approach Modes**

<table>
<thead>
<tr>
<th>MODE</th>
<th>DEFINITION</th>
<th>WHEN TO USE</th>
</tr>
</thead>
</table>
   | Oscillate  | Field oscillates around set point until it is within 80 G of set point, then field is set. | • To set fields accurately. 
   |            |                                                                            | • To eliminate magnetic relaxation effects in superconducting magnets. 
   |            |                                                                            | • To allow MPMS to immediately work at high sensitivities following large changes in fields. 
   |            |                                                                            | • To avoid excessive helium boil-off.                                                                |
   | No Overshoot | Field charges to 70% of difference between set point and present field, then slowly approaches set point until close enough to drive directly to it. | • To prevent field from oscillating between positive and negative fields. 
   |            |                                                                            | • To prevent field from exceeding set point.                                                          |
   |            |                                                                            | • To avoid excessive helium boil-off.                                                                 |
   | Hysteresis | Field charges directly to set point.                                         | • To set fields rapidly.                                                                            |

4. Select the resolution mode of the set point.

5. Select **Set**. The field immediately begins to ramp to the set point. The system monitors the changing field and field status. The **Magnetic Field** dialog box and the field status panels display the field and status.

   **CAUTION**

   Changing the field when the helium level is less than 30% may quench and thus damage the magnet. Before changing the field, MPMS MultiVu checks the level of helium in the dewar and generates a warning message if the helium level is less than 30%.

   If a sequence runs while the **Magnetic Field** dialog box is open, the **Status** panel in the dialog box indicates the status of any **Set Field** or **Scan Field** commands that are executed as part of the sequence.
7.4 Controlling the Chamber Atmosphere

1. Do one of the following: (a) select Instrument►Chamber or (b) click on any chamber status panel in the status bar when the status bar is displaying chamber status data (see section 2.3.5.4). The Chamber dialog box opens. The dialog box indicates the level of helium in the dewar and gives the present state of the sample chamber. The dialog box also includes chamber control commands.

2. Select any chamber control command. If you select Vent or Purge, the state of the sample chamber immediately begins to change.

![Figure 7-3. Chamber Dialog Box](image)

7.5 Tuning the SQUID

You should tune the SQUID when the MPMS probe has been warmed to room temperature. You should also tune the SQUID if you believe the results of your measurements are incorrect, for example, your data show unusually large standard deviations.

1. Select Instrument►SQUID Tune. The SQUID Tuning dialog box opens. The Status display shows the Drive and Tune values for that SQUID. These are the two variables used to tune the SQUID detector. Drive is the amount of power being sent to the SQUID while Tune is the frequency at which the SQUID is being driven.

2. Select the appropriate tab—Longitudinal or Transverse—for your type of SQUID.

![Figure 7-4. SQUID Tuning Dialog Box Showing Longitudinal Tab](image)
3. Choose either **Automatic Tuning** or **Manual Tuning**.
   
   - **Automatic Tuning** varies the Drive and Tune values up to the **Max Drive** and **Max Tune** specified. The **Drive** level is incremented while scanning the **Tune** level to find the maximum SQUID output for the lowest **Drive** Value.
   
   - **Manual Tuning** can be used to adjust **Drive** and **Tune** levels until the **Tune Value** (displayed at the top of the submenu) is at a maximum. A value of 0.6 or greater indicates that the SQUID is in tune. To tune the SQUID manually, follow these steps:
     
     a. Scan **Drive** down, looking for the lowest Drive level that produces a peak.
     
     b. Scan **Tune** up and down, looking for the highest peak.
     
     c. Repeat steps a and b above iteratively until you have the maximum peak possible with the lowest drive level.
7.6 Monitoring Helium Transfers

1. Select Utilities >> Helium Fill. The Helium Fill Status screen and the graph view of the blank helium data, or heliumgr.dat, file open. The heliumgr.dat file stores the helium-level data from the last helium fill. The file is overwritten whenever another helium fill is run.

![Helium Fill Status Screen]

2. Select Start in the Helium Fill Status screen to begin collecting and plotting data from the helium level meter.

   MPMS MultiVu plots, in the heliumgr.dat file, the level of helium in the dewar against the amount of time of the helium-filling operation. The Helium Fill Status screen indicates the helium fill rate, the level of helium in the dewar, and how much time remains before the helium meter is automatically shut off and monitoring is terminated. By clicking on the arrows next to the time display, you may increase or decrease the remaining time before the meter shuts off.

3. Select Done in the Helium Fill Status screen when the acceptable helium level is reached.

7.7 Entering Standby Mode

Standby mode conserves helium by disabling all temperature control heaters in the Model 1802 Digital R/G Bridge and all other heaters that the MPMS does not require. Standby mode also turns off power to the sample transport.

To make the MPMS enter standby mode, you select the Instrument >> Standby option, and then you select OK in the pop-up message. The MPMS may not enter standby mode while the magnetic field is unstable or while a sequence or measurement is running.
7.8 Advanced System Operations

7.8.1 Correcting the Field-Intensity Data

You use the Utilities ➤ Update Field option to correct the field-intensity data stored in MPMS MultiVu and in the Model 1822 MPMS Controller. Utilities ➤ Update Field opens the Update Field dialog box, which lists the magnetic field range. Update Field does not set the magnet current.

⚠️ Use the Update Field option only when the field value displayed by MPMS MultiVu differs from the known magnetic field of the superconducting magnet. The superconducting magnet can be damaged if the actual field and displayed field are different.

7.8.2 Resetting the Magnet

The Utilities ➤ Reset Magnet option minimizes the magnet’s residual, or remnant, field by heating a portion of the magnet above its critical temperature, and then cooling the magnet. Reset Magnet is disabled during a sequence run or an immediate measurement.

Utilities ➤ Reset Magnet opens the Reset Magnet dialog box. You select the Start button to begin the magnet reset. During the reset, status messages appearing in the dialog box indicate what task the MPMS is performing and how many seconds remain before the task is complete.

7.8.3 Logging Data Parameters

1. Select Utilities ➤ Log MPMS Data. The Log Data dialog box opens.
2. Select the General tab if the General tab is not visible. The General tab indicates which environment log file will save the data and how often data will be logged to this file.

![Figure 7-6. General Tab in Log Data Dialog Box](image)
3. Select or create an environment log file, if necessary.
4. Click on the Overwrite check box if you want to overwrite the environment log file.
5. Specify how frequently data is logged to the file. Data can be saved in intervals as brief as 0.25 seconds or as long as 99,999 seconds. The default interval is 2 seconds.
6. Select the Standard Items tab if you want to change or review the system data parameters that are saved to the environment log file. As soon as you select a parameter, the value of that parameter appears in the Standard Items tab. You can use the Select All and Unselect All buttons, which are at the bottom of the tab, to select and deselect all system data parameters.

![Log Data Dialog Box](image)

Figure 7-7. Standard Items Tab in Log Data Dialog Box

7. Select Start to begin logging data.
8. Select the General tab and then select View Data to open the graph view of the environment log file. The graph is updated continuously while data is logged.
9. Select Stop to stop logging data. Data is logged continuously until you instruct the system to stop logging the data.

### 7.8.4 Reviewing Calibration Factors

The **Calibration Factors** dialog box lists the current calibration factors of the MPMS unit and of the installed MPMS options. The **Utilities ➤ Calibration** option opens the dialog box. Table 7-2 identifies the standard MPMS calibration factors. Table 7-3 lists default values for the calibration factors. For information about the calibration factors for any MPMS option, refer to the appropriate option manual.

Changing calibration factors should generally be unnecessary. However, you can change a calibration factor by double-clicking on it in the **Calibration Factors** dialog box and then entering the new value in the pop-up dialog box.

**CAUTION**

Calibration factors may be changed only if a later calibration test has been performed on the MPMS or if the MPMS must complete nonstandard tasks. Only personnel who are thoroughly familiar with the MPMS and its operation should change calibration factors. The default calibration factors are set so that the system calibration reflects the unique attributes of the individual MPMS unit.
### Table 7-2. Standard MPMS Calibration Factors

<table>
<thead>
<tr>
<th>CALIBRATION FACTOR</th>
<th>WHAT CALIBRATION FACTOR SETS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magnet</td>
<td>Magnet calibration factor (B/I).</td>
</tr>
<tr>
<td>SQUID</td>
<td>SQUID calibration factor for SQUID axis.</td>
</tr>
<tr>
<td>Field Penetration</td>
<td>Field-penetration calibration factor, which adjusts SQUID calibration factor for current magnetic field.</td>
</tr>
<tr>
<td>Extended Range</td>
<td>Extended range for SQUID axis.</td>
</tr>
<tr>
<td>Regression Factor</td>
<td>Regression factor for SQUID axis.</td>
</tr>
<tr>
<td>Minimum Data Points</td>
<td>Minimum number of data points read during scan.</td>
</tr>
<tr>
<td>Transverse Rotator Steps/Degree</td>
<td>Number of steps per degree transverse sample rotator moves. Value varies with each rotator.</td>
</tr>
<tr>
<td>SQUID Settle Times</td>
<td>Settle time for specified SQUID filter.</td>
</tr>
<tr>
<td>Temperature Tolerance</td>
<td>Temperature tolerance value.</td>
</tr>
<tr>
<td>Low Temperature</td>
<td>Minimum temperature that can be set without using pot to control temperature.</td>
</tr>
<tr>
<td>Fill Temperature</td>
<td>Temperature while helium reservoir is filled.</td>
</tr>
<tr>
<td>Fill Time</td>
<td>Length of time helium reservoir collects helium.</td>
</tr>
<tr>
<td>Fill Power</td>
<td>Amount of power sent to proportional valve while helium reservoir is filled.</td>
</tr>
<tr>
<td>Oven Factor</td>
<td>Cal factor allowing MPMS to accurately report sample chamber temperature when Oven is installed.</td>
</tr>
<tr>
<td>Maximum Temperature</td>
<td>Maximum system temperature.</td>
</tr>
<tr>
<td>Minimum Warm Rate</td>
<td>Rate at which temperature changes while being warmed by sample chamber heater.</td>
</tr>
<tr>
<td>Maximum Rate on Pot</td>
<td>Rate at which temperature changes while operating below low temperature.</td>
</tr>
<tr>
<td>Low Temp Heater Factor</td>
<td>Low-temperature heater factor, which modifies heating characteristics of MPMS when MPMS operates at low temperatures.</td>
</tr>
<tr>
<td>Reservoir Fill</td>
<td>Determines whether Continuous Low-Temperature Control system fills cold reservoir.</td>
</tr>
<tr>
<td>Thermometer Consistency Tolerance</td>
<td>Half the minimum difference required between germanium and platinum thermometers before they are checked for failures. Used for systems without Enhanced Temperature Control option.</td>
</tr>
<tr>
<td>7-T Magnet Inductance</td>
<td>Magnet inductance factor.</td>
</tr>
<tr>
<td>7-T Magnet Charging Rate</td>
<td>Magnet charging rate, which controls how quickly magnet current is charged.</td>
</tr>
<tr>
<td>7-T Magnet Zero Field Quench Time</td>
<td>Number of seconds quench heater remains on when quenching at 0 G. Times at other fields are calculated from this value.</td>
</tr>
<tr>
<td>7-T Magnet Zero Field Cool Time</td>
<td>Number of seconds for magnet to cool after being quenched at zero field.  If magnet is quenched at field other than zero, magnet is cooled for double this time.</td>
</tr>
</tbody>
</table>
## Table 7-3. Default Values for Standard MPMS Calibration Factors

<table>
<thead>
<tr>
<th>CALIBRATION FACTOR</th>
<th>DEFAULT VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>7-T MAGNET</td>
</tr>
<tr>
<td>Magnet*</td>
<td>2000.000</td>
</tr>
<tr>
<td>Longitudinal SQUID*</td>
<td>7500.000</td>
</tr>
<tr>
<td>Transverse SQUID*</td>
<td>7500.000</td>
</tr>
<tr>
<td>Field Penetration*</td>
<td>0.000</td>
</tr>
<tr>
<td>Longitudinal Extended Range*</td>
<td>300.000</td>
</tr>
<tr>
<td>Transverse Extended Range*</td>
<td>300.000</td>
</tr>
<tr>
<td>Longitudinal Regression Factor</td>
<td>1.825</td>
</tr>
<tr>
<td>Minimum Data Points</td>
<td>8</td>
</tr>
<tr>
<td>Transverse Rotator Steps/Degree*</td>
<td>96.000</td>
</tr>
<tr>
<td>SQUID Settle Time—20000 Hz</td>
<td>0.050</td>
</tr>
<tr>
<td>SQUID Settle Time—5000 Hz</td>
<td>0.050</td>
</tr>
<tr>
<td>SQUID Settle Time—1200 Hz</td>
<td>0.050</td>
</tr>
<tr>
<td>SQUID Settle Time—80 Hz</td>
<td>0.050</td>
</tr>
<tr>
<td>SQUID Settle Time—10 Hz</td>
<td>0.080</td>
</tr>
<tr>
<td>SQUID Settle Time—5 Hz</td>
<td>0.800</td>
</tr>
<tr>
<td>SQUID Settle Time—Elliptical</td>
<td>0.800</td>
</tr>
<tr>
<td>SQUID Settle Time—No Filter</td>
<td>0.050</td>
</tr>
<tr>
<td>Temperature Tolerance</td>
<td>0.005</td>
</tr>
<tr>
<td>Low Temperature</td>
<td>4.430</td>
</tr>
<tr>
<td>Fill Temperature</td>
<td>4.150</td>
</tr>
<tr>
<td>Fill Time</td>
<td>650.000</td>
</tr>
<tr>
<td>Fill Power</td>
<td>3.500</td>
</tr>
<tr>
<td>Oven Factor*</td>
<td>15.000</td>
</tr>
<tr>
<td>Maximum Temperature*</td>
<td>400.000</td>
</tr>
<tr>
<td></td>
<td>(800 for Oven)</td>
</tr>
<tr>
<td>Minimum Warm Rate</td>
<td>0.001</td>
</tr>
<tr>
<td>Maximum Rate on Pot</td>
<td>2.000</td>
</tr>
<tr>
<td>Low Temp Heater Factor</td>
<td>2.000</td>
</tr>
<tr>
<td>Reservoir Fill</td>
<td>Off</td>
</tr>
<tr>
<td>7-T Magnet Inductance</td>
<td>8.50</td>
</tr>
<tr>
<td>7-T Magnet Charging Rate</td>
<td>1.00</td>
</tr>
<tr>
<td>7-T Magnet Zero Field Quench Time*</td>
<td>15.00</td>
</tr>
<tr>
<td>7-T Magnet Zero Field Cool Time*</td>
<td>45.00</td>
</tr>
</tbody>
</table>

* The value displayed in table 7-3 is the default software value. The actual calibration factor value is unique to the individual MPMS unit and is calibrated at the Quantum Design factory.
7.8.5 Configuring the Message Display

MPMS MultiVu generates error messages to describe errors that occur during system operation. You can select what types of error messages are displayed and the length of time the messages appear on the screen. Complete the following steps:

WARNING

Disabling the display of error messages may prevent MPMS MultiVu from informing you of certain failures in the MPMS system. Disabling message displays should be done only by personnel thoroughly familiar with the operation of the MPMS and should be done only on a temporary basis.

1. Select Utilities ➤ Message Display. The Configure Error Handling dialog box opens. The dialog box indicates which types of system error messages are displayed and the length of time the error messages are displayed.

![Configure Error Handling Dialog Box](image)

Figure 7-8. Configure Error Handling Dialog Box

2. Select which types of system error messages are displayed. By default, all four types of messages are selected. Table 7-4 describes and gives an example of each type of message.

3. Select the length of time each error message is displayed. A message can be displayed until you close it, or it can be displayed a specified length of time.

<table>
<thead>
<tr>
<th>MESSAGE</th>
<th>PURPOSE</th>
<th>EXAMPLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Informational</td>
<td>Informs you of an event.</td>
<td>Magnet hysteresis mode is being turned on.</td>
</tr>
<tr>
<td>Warning</td>
<td>Informs you an error has been encountered that may be corrected with your intervention. No immediate loss of data is expected.</td>
<td>Helium level is too low to start sequence.</td>
</tr>
<tr>
<td>Error</td>
<td>Informs you an error has been encountered that may seriously affect system usage or the measurement in progress.</td>
<td>Current data file cannot be opened, so measurement data will be lost.</td>
</tr>
<tr>
<td>Fatal Error</td>
<td>Informs you MPMS MultiVu has either crashed or cannot continue to run.</td>
<td>Out of memory.</td>
</tr>
</tbody>
</table>

Table 7-4. System Messages
7.8.6 Logging Events

All informational messages, warnings, errors, and fatal errors generated since MPMS MultiVu was last started up can be logged to an event log file. The event log, which you open by selecting the Utilities ► Event Log option, describes the messages, warnings, and errors logged to the event log file and indicates when each message, warning, and error occurred. Event.log is the default event log file. The .log extension identifies an event log file.

The event log may remain open while you work in MPMS MultiVu.

You can select what types of system messages are saved to the event log file. You can also create new event log files. Complete the following steps:

1. Select Utilities ► Event Log ► Configure. The Configure Logging dialog box opens and identifies which event log file is storing system messages and indicates which types of messages are saved.

2. Select or create an event log file, if necessary.
   To select an event log file, select Change, then select any file in the Select a Log File dialog.
   To create an event log file, select Change, enter a name in the File name text box, and then select Open. MPMS MultiVu adds the .log extension to the base file name.
   After you select or create an event log file, the Configure Logging dialog box appears again.

3. Use the Display last text box to specify how many entries are displayed in the event log. The default number of entries is 50.

4. Select the types of system messages logged to the event log file and thus displayed in the event log. By default, all four types of system messages—informational messages, warnings, errors, and fatal errors—are logged. Logging all four types of messages is recommended and can assist you if you must troubleshoot the system. Table 7-4 describes each type of system message.
7.8.7 Installing and Activating Options

The *Configure Option* dialog box lists all purchased options that are included with your MPMS and indicates whether each option is installed. Selecting *Utilities* ➤ *Options* opens the *Configure Option* dialog box.

When you select, in the *Configure Option* dialog box, an option whose status you can change, an additional command button appears in the upper right corner of the dialog box. The title of the button, such as *Install* or *Change Axis*, identifies the task you can perform. Simply select the command button, and then follow the on-screen prompts.

7.8.8 Converting MPMSR2 DOS Files

Selecting the *Utilities* ➤ *Convert Sequence* option opens the Convert Sequence File utility. You use the utility to convert an MPMSR2 DOS sequence to the MPMS MultiVu sequence format.

Selecting the *Utilities* ➤ *Convert Data File* option opens the Convert Data File utility. You use the utility to convert an MPMSR2 DOS data file to the MPMS MultiVu data file format.
CHAPTER 8

Diagnostics

8.1 Introduction

This chapter contains the following information:

- Section 8.2 presents an overview of the diagnostic commands.
- Section 8.3 discusses the bridge channel diagnostics.
- Section 8.4 discusses the chamber diagnostics.
- Section 8.5 discusses the driver channel diagnostics.
- Section 8.6 discusses the GPIB diagnostics.
- Section 8.7 discusses the magnet diagnostics.
- Section 8.8 discusses the serial port diagnostics.
- Section 8.9 discusses the SQUID diagnostics.
- Section 8.10 discusses the transport diagnostics.
- Section 8.11 discusses the voltmeter diagnostics.
- Section 8.12 discusses the temperature control diagnostics.

8.2 Overview of Diagnostics

Diagnostic commands are low-level commands that directly control the hardware in the MPMS sample chamber. Diagnostic commands are in the Utilities>Diagnoses submenu. Several of the MPMS measurement options include their own diagnostic commands, which also appear in the Diagnoses submenu. For information about any of the measurement option diagnostic commands, refer to the appropriate option manual.

When a diagnostic parameter is changed, the system temperature control may also be changed. The MPMS resets the system temperature if a parameter value that creates an unacceptable temperature is specified.

⚠️

CAUTION

Use diagnostic commands only if you are thoroughly familiar with the MPMS and its operation. Misuse of the diagnostic commands can damage the system hardware.
8.3 Bridge Channel Diagnostics

The bridge channel diagnostic commands change the sensor parameters of the four physical channels on the Model 1802 Digital R/G Bridge. The bridge channel diagnostic commands control such measurement functions as the maximum excitation level that is applied to the sensor, setting the units in which the measurement is reported, and enabling the autoscan and autorange functions of the bridge.

Selecting Utilities ➤ Diagnostics ➤ Bridge Channels opens the Bridge Channels Diagnostics dialog box. Status information at the top of the dialog box displays the current readings from the bridge channels. The physical control channel commands set the sensor parameters for the bridge channels. Changes to any channel controls are initiated only when you select the channel’s Set button.

The Set Table Files button opens another dialog box that you use to download thermometer translation files for the physical bridge channels.

![Bridge Channel Diagnostics Dialog Box](image)

Figure 8-1. Bridge Channel Diagnostics Dialog Box

In addition to the four physical bridge channels, you can configure two virtual channels. Channel 5 can read the average temperature from all the physical bridge channels that are active. Channel 6 blends the temperature output of two physical bridge channels.

Virtual bridge channel 6 is used by MPMS MultiVu to control the system temperature. Modifying the settings for this channel may adversely affect system temperature control.

CAUTION
Table 8-1. Physical Channel Control Parameters

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>SETTINGS</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autoscan</td>
<td>• Enabled • Disabled</td>
<td>Enables or disables autoscanning. Autoscanning instructs Model 1802 to read channel once during control loop. If autoscanning is disabled, Model 1802 reads channel only when requested to do so.</td>
</tr>
<tr>
<td>User Mode</td>
<td>• Conductance • Resistance</td>
<td>Determines whether data read by channel is expressed as conductance or resistance.</td>
</tr>
<tr>
<td>Autoranging</td>
<td>• Enabled • Disabled</td>
<td>Enables or disables autoranging. Autoranging instructs Model 1802 to change gain and excitation values as necessary so that channel produces nonsaturated reading.</td>
</tr>
<tr>
<td>Max Excitation</td>
<td>0.05 µA 5.0 µA 0.5 µA 50.0 µA</td>
<td>Sets maximum excitation current for channel.</td>
</tr>
</tbody>
</table>

For more detailed information about the operation of the Model 1802 and the Model 1802 parameters, refer to the *Model 1802 Digital R/G Bridge Operating Manual*.

8.4 Chamber Diagnostics

The chamber diagnostic commands provide direct, low-level control of the MPMS gas system.

Selecting Utilities ➤ Diagnostics ➤ Chamber opens the Chamber/Gas Controls Diagnostics dialog box. Status information at the top of the dialog box indicates the current state of the gas system. The control commands change the state of the individual components of the gas system. Changes to any setting are initiated only when you select the corresponding Set button.

![Figure 8-2. Chamber/Gas Control Diagnostics Dialog Box](image)
### Table 8-2. Settings for Gas System

<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>SETTINGS</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Driver Channel 2</td>
<td>• Proportional valve  • Chamber heater</td>
<td>Selects output device for driver channel 2.  Proportional valve controls high cooling rate. Chamber heater creates high heating rate.</td>
</tr>
<tr>
<td>Flush Valve</td>
<td>• Open • Closed</td>
<td>Opens or closes valve. Close valve only during purge sequence.</td>
</tr>
<tr>
<td>Vent Valve</td>
<td>• Open • Closed</td>
<td>Opens or closes valve. Open valve only during purge sequence.</td>
</tr>
<tr>
<td>Cooling Valve</td>
<td>• Open • Closed</td>
<td>Opens or closes valve. Open valve to quickly clear large pumping line, initiate high-speed cooling, or obtain lowest possible temperatures.</td>
</tr>
<tr>
<td>Impedance Heater</td>
<td>• Low • High • Off</td>
<td>Determines helium flow. Low mode allows restricted flow. High mode prevents flow. Helium flows freely when heater is off.</td>
</tr>
<tr>
<td>Valve Sequencing</td>
<td>• Enable • Disable</td>
<td>Enables or disables purge and vent sequences initiated with “Purge Airlock” button.</td>
</tr>
<tr>
<td>Helium Level Meter</td>
<td>• On • Off</td>
<td>Turns helium level meter on or off.</td>
</tr>
</tbody>
</table>

**CAUTION**

Turn on the helium level meter only to plot or update the helium level. By keeping the meter off at all other times, you minimize both the loss of helium and the risk of damaging the meter. When the helium level meter is turned on, it remains on until it is turned off.
8.5 Driver Channel Diagnostics

The driver channel diagnostic commands configure the two Model 1802 output driver channels as controllers or programmable current sources. The driver channels control the heater output in the MPMS and thus control system temperature.

Much of the inherent flexibility of the Model 1802 arises from the ability to directly set and modify the parameters that determine the characteristics of the feedback control loops provided by the two output drivers. However, you must ensure that the parameters configuring the output drivers are consistent with the user mode selected for the input sensor, and with the power or current feedback mode selected for the drivers.

Selecting Utilities ➤ Diagnostics ➤ Driver Channels opens the Bridge Driver Diagnostics dialog box. The Driver 1 tab (see figure 8-3) in the dialog box displays the status information and includes the control commands changing settings for driver channel 1. The Driver 2 tab displays the status information and includes the control commands changing settings for driver channel 2. Changes to any setting are initiated only when you select the corresponding Set button.

Figure 8-3. Bridge Driver Diagnostics Dialog Box
Table 8-3. Driver Control Settings

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>SETTINGS</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Updates</td>
<td>• On • Off</td>
<td>Enables or disables PID control of driver channel.</td>
</tr>
<tr>
<td>Input Sensor</td>
<td>All bridge channels</td>
<td>Selects bridge channel that functions as input sensor for driver channel. For normal control, the bridge channel autoscanning function must be enabled.</td>
</tr>
<tr>
<td>Output Range</td>
<td>• Low • High</td>
<td>Sets maximum output range of driver channel. Low range allows more granularity in power settings and in control loop.</td>
</tr>
<tr>
<td>Feedback Mode</td>
<td>• Power • Current</td>
<td>Determines whether output current from driver channel is expressed as current or power.</td>
</tr>
<tr>
<td>Minimum Power</td>
<td>(Variable) mW/ohm</td>
<td>Sets minimum power driver channel can deliver.</td>
</tr>
<tr>
<td>Maximum Power</td>
<td>(Variable) mW/ohm</td>
<td>Sets maximum power driver channel can deliver.</td>
</tr>
<tr>
<td>Output</td>
<td>(Variable) mW/ohm</td>
<td>Sets immediate output power of driver channel.</td>
</tr>
</tbody>
</table>

Selecting the feedback mode before you set the other driver channel parameters is important. The feedback mode determines whether some of the other driver channel parameters are interpreted as current or power. Failure to select the feedback mode first can create erroneous settings for the feedback control parameters.

Table 8-4. Control Parameters Settings

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balance Point</td>
<td>Sets target temperature driver channel tries to maintain.</td>
</tr>
<tr>
<td>Gain</td>
<td>Applies power to input sensor in direct proportion to error signal that is difference between actual and balance-point temperature. Value of zero prevents PID equation from computing output.</td>
</tr>
<tr>
<td>Integrator</td>
<td>Sets integrator time-constant for PID filter on driver channel. Value of zero seconds removes integrator variable from PID equation.</td>
</tr>
<tr>
<td>Differentiator</td>
<td>Sets differentiator time-constant for PID filter on driver channel. Value of zero seconds removes differentiator variable from PID equation.</td>
</tr>
<tr>
<td>Preset</td>
<td>Sets preset power for driver channel. Value of zero removes preset-power variable from PID equation.</td>
</tr>
<tr>
<td>Use Offset</td>
<td>Lets balance point for one driver channel be set as offset of the balance point for other driver channel.</td>
</tr>
</tbody>
</table>

The Proportional-Integral-Differential (PID) commands modify the time-constants and power preset values that optimize the performance of the Model 1802 in diverse thermal environments. For detailed information about PID control, refer to the “Applications and Use of PID Control” section in the Model 1802 Digital R/G Bridge Operating Manual.
8.6 GPIB Diagnostics

8.6.1 Viewing GPIB Activity

Selecting Utilities ➤ Diagnostics ➤ GPIB ➤ View GPIB Activity opens the GPIB Status dialog box. As soon as the GPIB Status dialog box opens, it displays a scrolling list of all GPIB commands executed on all active GPIB devices connected to the MPMS. You may stop and restart command tracking at any time, and you may select which GPIB devices are polled. Enable the Output to File check box in order to save the command information to a data file (GPIB.txt).

![GPIB Status Dialog Box](image)

**Figure 8-4. GPIB Status Dialog Box**

8.6.2 Sending GPIB Commands

1. Select Utilities ➤ Diagnostics ➤ GPIB ➤ Send GPIB Commands. The Send GPIB Commands dialog box opens.
2. Enter the GPIB command in the Send text box.
3. Specify which GPIB device receives the command.
4. Select a command terminator, if necessary.
5. Select Send or Send and Read. The command is sent to the GPIB device. The device’s response appears in the Response panel located in the Send GPIB Commands dialog box.

![Send GPIB Commands Dialog Box](image)

**Figure 8-5. Send GPIB Commands Dialog Box**
8.7 Magnet Diagnostics

Magnet diagnostic commands control the power supply and the persistent switch for the superconducting magnet and update the field-intensity data stored in the Model 1822 MPMS Controller.

![Figure 8-6. Magnet Diagnostics Dialog Box](image)

### Table 8-5. Magnet Control Parameters

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>SETTINGS</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>• Low</td>
<td>Enables or disables high-resolution mode. High-resolution mode allows more precise fields to be set at lower currents.</td>
</tr>
<tr>
<td></td>
<td>• High</td>
<td></td>
</tr>
<tr>
<td>Power Supply</td>
<td>• Off</td>
<td>Turns magnet power supply on or off. Power supply should be off unless MPMS is setting new field or performing measurements in hysteresis mode. State of power supply may be changed only if current from power supply is set to zero.</td>
</tr>
<tr>
<td></td>
<td>• On</td>
<td></td>
</tr>
<tr>
<td>Switch Heater</td>
<td>• Off</td>
<td>Turns on or off persistent switch heater. State of persistent switch heater may be changed only if current being delivered by power supply matches current in magnet.</td>
</tr>
<tr>
<td></td>
<td>• On</td>
<td></td>
</tr>
</tbody>
</table>

![Table continues](image)
Table 8-5. Magnet Control Parameters (Continued)

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>SETTINGS</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polarity</td>
<td>• Negative</td>
<td>Specifies direction in which magnet current flows.</td>
</tr>
<tr>
<td></td>
<td>• Positive</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Off</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>When polarity is off, persistent switch heater is short-circuited.</td>
</tr>
<tr>
<td>Set Current</td>
<td>(Variable)</td>
<td>Specifies amount of current flowing from magnet power supply.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Output current may be set to nonzero value only if magnet power supply is</td>
</tr>
<tr>
<td></td>
<td></td>
<td>on, high-resolution relay status is active, and magnet polarity is set to</td>
</tr>
<tr>
<td></td>
<td></td>
<td>positive or negative mode.</td>
</tr>
<tr>
<td>Update Field</td>
<td>(Variable)</td>
<td>Corrects field-intensity data stored in MPMS MultiVu and in the Model 1822.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Does not set magnet current.</td>
</tr>
</tbody>
</table>

Use the **Update Field** command only when the field value displayed by MPMS MultiVu differs from the known magnetic field of the superconducting magnet. The superconducting magnet can be damaged if the actual field and displayed field are different.

For more detailed information about the operation of the Model 1822, refer to the *Model 1822 MPMS Controller User's Manual*.

### 8.8 Serial Port Diagnostics

Selecting **Utilities** ➤ **Diagnostics** ➤ **Serial Port** opens the **Monitor Communication Port** dialog box. You use this dialog box to monitor communications with the serial port. Enable the **Write to file** check box to write the collected data to a serial log file.

![Figure 8-7. Monitor Communication Port Dialog Box](image)
8.9 SQUID Diagnostics

In the normal MPMS configuration, SQUID sensor 1 detects the longitudinal magnetic moment of the sample, and SQUID sensor 2 detects the transverse moment of the sample; that is, the magnetic moment that is parallel to the magnetic field and the magnetic moment that is perpendicular to the field, respectively. All SQUID setup and control functions are accessible through the Model 1822 command set.

Selecting Utilities ➔ Diagnostics ➔ SQUID opens the SQUID Diagnostics dialog box. The control commands changing settings for the longitudinal SQUID are in the Longitudinal tab (see figure 8-8). The control commands changing settings for the transverse SQUID are in the Transverse tab. Changes to any setting are initiated only when you select the corresponding Set button.

![Figure 8-8. Longitudinal Tab in SQUID Diagnostics Dialog Box](image)

Table 8-6. SQUID Control Commands

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMU Range</td>
<td>Allows you to define normal or extended SQUID range.</td>
</tr>
<tr>
<td>Range</td>
<td>Sets feedback range on SQUID axis. Feedback ranges have amp- \per-volt ratios of $1 \times 10^{-6}$ to $1 \times 10^{-3}$. Smallest range is most sensitive.</td>
</tr>
<tr>
<td>Gain</td>
<td>Sets SQUID electronics gain factor for SQUID axis. Some gain is necessary to amplify SQUID signal. Too much gain distorts signal. MPMS MultiVu sets gain if autoranging is enabled.</td>
</tr>
<tr>
<td>Filter</td>
<td>Selects anti-alias filter applied to detector output of SQUID axis. The None option allows raw signal from SQUID to be viewed.</td>
</tr>
<tr>
<td>RF Power</td>
<td>Sets RF-bias power level for SQUID axis. Power level may be any value from 0 to 255, which corresponds to 1 to 100% of drive level. Command must be sent to Model 1822 repeatedly with varying values to “scan” RF power level.</td>
</tr>
</tbody>
</table>

(table continues)
Table 8-6. SQUID Control Commands (Continued)

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tuning Level</td>
<td>Sets tuning level required to tune RF-bias frequency of SQUID axis. Command must be sent to Model 1822 repeatedly with varying values in order to “scan” tuning level for SQUID sensor.</td>
</tr>
<tr>
<td>Quench</td>
<td>Quenches SQUID external feedback loop.</td>
</tr>
<tr>
<td>Auto Reset</td>
<td>Forces longitudinal and transverse SQUIDs to be reset whenever their voltage outputs are being logged with the MPMS Data Logger (see section 7.8.3) and their output voltages reach ±10 V.</td>
</tr>
<tr>
<td>Reset</td>
<td>Sets preset power for driver channel. Value of zero removes preset-power variable from PID equation.</td>
</tr>
<tr>
<td>Heater</td>
<td>Turns on or off SQUID flux transformer heaters so that persistent currents in SQUID sensor pickup coils can be eliminated.</td>
</tr>
</tbody>
</table>

For more detailed information about the operation of the Model 1822, refer to the Model 1822 MPMS Controller User’s Manual.

8.10 Transport Diagnostics

The transport diagnostics control the movement of the sample transport. When the Reciprocating Sample option (RSO) or the Horizontal or Vertical Rotator option is active, the transport diagnostics include additional commands that affect the movement of the RSO sample transport or the rotator transport. For specific information about the RSO transport commands, refer to the Magnetic Property Measurement System: Reciprocating Sample Option User’s Manual. For specific information about the rotator transport commands, refer to the MPMS Horizontal Rotator User’s Manual.

CAUTION

The transport commands allow the sample transport to be moved manually and must therefore be used with caution. Before you use a transport command to move the sample transport, you should note the transport’s location so that you do not try to move it beyond the defined travel limits.

Selecting Utilities ➤ Diagnostics ➤ Transport opens the Sample Transport tab in the Transport Diagnostics dialog box. The Sample Transport tab indicates the status and position of the stepper motor that controls the sample’s movement. The tab also includes movement control commands. Select any movement control command (see table 8-7) or reconfigure the stepper motor parameters (see table 8-8) as necessary.
Table 8-7. Movement Control Commands

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>DESCRIPTION</th>
<th>ACTIVATING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move To</td>
<td>Motor moves to specified position.</td>
<td>• Enter value in Move To text box, then click on Move To Set button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Drag slide bar button, then click on Move To Set button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Click on slide bar arrows, then click on Move To Set button.</td>
</tr>
<tr>
<td>Redefine Current Position</td>
<td>System redefines motor’s current position as specified position.</td>
<td>Enter value in Redefine Current Position text box, then click on Redefine Current Position Set button.</td>
</tr>
<tr>
<td>Autotracking</td>
<td>MPMS tracks and adjusts position of sample to keep sample centered in SQUID coils.</td>
<td>Enable Autotracking check box.</td>
</tr>
<tr>
<td>Initialize</td>
<td>Transport moves to lower-travel-limit switch, then rises to known position just above lower-travel-limit switch.</td>
<td>Select Initialize button.</td>
</tr>
</tbody>
</table>

NOTE

Disable autotracking only if you are working with a sample that is very sensitive to centering or if you are using a custom-built sample rod. Quantum Design used a normal sample rod and a quartz sample holder to develop the sample-tracking algorithms. Sample holders and rods that respond to temperature differently than brass, steel, or quartz exhibit greater variations in the position of the sample.
Selecting the **Configure** button in the **Sample Transport** tab opens the **Motor Configuration** dialog box.

![Motor Configuration Dialog Box](image)

**Figure 8-10. Motor Configuration Dialog Box**

**Table 8-8. Motor Configuration Parameters**

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
<td>Turns on or off power to sample transport drive mechanism.</td>
</tr>
<tr>
<td>Slew Rate</td>
<td>Sets slew rate of transport drive mechanism. Slew rate is rate at which stepper motor moves after having accelerated its speed according to acceleration rate. Slew rate of 5.0 cm/sec. is recommended. Slew rate is usually slightly larger than initial rate.</td>
</tr>
<tr>
<td>Initial Rate</td>
<td>Sets initial rate of transport drive mechanism. Initial rate is rate at which stepper motor begins to move. Initial rate of 2.0 cm/sec. is recommended. Initial rate is usually slightly smaller than slew rate.</td>
</tr>
<tr>
<td>Acceleration Rate</td>
<td>Sets acceleration rate of transport drive mechanism. Acceleration rate is rate at which motor speed ramps from initial rate to slew rate and then decelerates from slew rate to initial rate. Acceleration rate of 8.0 cm/sec. is recommended.</td>
</tr>
</tbody>
</table>
8.11 Voltmeter Diagnostics

The voltmeter diagnostics configure the eight-channel, digital-to-analog converter in the Model 1822 so that the converter reads back the SQUID detector output, the current control voltages for the MPMS magnet control system, the voltage for the helium level meter, and the thermocouple output monitoring the pressure in the sample chamber.

Selecting Utilities >> Diagnostics >> Voltmeter opens the Voltmeter Diagnostics dialog box. Changes to any setting are initiated only when you select the Set button in the dialog box.

![Voltmeter Diagnostics Dialog Box]

Figure 8-11. Voltmeter Diagnostics Dialog Box

Table 8-9. Voltmeter Diagnostic Parameters

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Scale Voltage</td>
<td>Sets maximum voltage specified voltmeter can read. Value set by this parameter overrides gain MPMS has set for voltmeter.</td>
</tr>
<tr>
<td>Sampling Rate</td>
<td>Sets sampling rate of analog-to-digital converter on specified voltmeter. Sampling rate of 180 Hz is recommended.</td>
</tr>
<tr>
<td>Readings to Average</td>
<td>Sets number of readings Model 1822 averages together each time it reads specified voltmeter. To allow maximum rejection of 60-Hz noise, a number that is an integer multiple of 3 should be specified. Averaging 30 readings per point is recommended.</td>
</tr>
</tbody>
</table>
8.12 Temperature Control

Selecting Utilities ➤ Diagnostics ➤ Temperature Control opens the Temperature Control dialog box. This dialog box summarizes the current state of the system temperature control, and if it is open while the temperature is ramping to a new set point, monitors the progress of the changing temperature.

You cannot use the Temperature Control dialog box to change the state of the system temperature.

![Temperature Control Dialog Box](image)

Figure 8-12. Temperature Control Dialog Box
A P P E N D I X A

Installation Instructions

A.1 Introduction

This appendix contains the following information:

- Section A.2 presents an overview of the installation procedure.
- Section A.3 explains how to install MPMS MultiVu.

A.2 Overview of Installation

To install MPMS MultiVu, you must have the following:

- Pentium 75 processor running Windows 95 and with a minimum of 16 MB of RAM.
- Screen resolution of 800×600 pixels.
- National Instruments GPIB software for Windows 95.
- National Instruments AT-GPIB/TNT board.
- Quantum Design MPMS MultiVu installation disks.
- Quantum Design firmware EPROMs, rev. 3.21 or higher, for the Model 1822 MPMS Controller and the Model 1802 Digital R/G Bridge.

A.2.1 Configuration Files and the Machine State

The MPMSR2 DOS software and MPMS MultiVu do not share configuration files. When you switch from one software package to the other, changes that have been made to calibration values and to state-specific information, like the present temperature setting or the magnetic field, are lost. It is your responsibility to keep both software packages current. This task generally involves (1) using the Update Field utility to update the field to the appropriate persistent field level and (2) setting a new temperature.
A.3 Installing MPMS MultiVu

A.3.1 Install the GPIB Software


A.3.2 Install the GPIB Board

Refer to the “Install the Non Plug and Play GPIB Hardware” section in chapter 2 of the Getting Started with Your Non Plug and Play GPIB Hardware and Software for Windows 95: AT-GPIB [and] EISA-GPIB manual (National Instruments 1996). Table 2-1 lists the base I/O address switch settings in reverse order; settings for switch A9 are listed first, and settings for switch A5 are listed last.

A.3.3 Install MPMS MultiVu

1. Verify that Windows 95 is installed on the control PC. MPMS MultiVu is a 32-bit application and requires Windows 95 to run.
2. Verify that the screen resolution is 800×600 pixels. Without the appropriate screen resolution, MPMS MultiVu is difficult to use. To configure the screen resolution, use the Display option in the Windows 95 control panel.
3. Print a list of all calibration factors you want to use with MPMS MultiVu. In the MPMSR2 DOS software, select <Print Screen> to print a screen.
4. Close all Windows applications.
5. Insert MPMS MultiVu Disk 1 into the PC.
7. Select Setup.exe. The setup program prepares the InstallShield Wizard. The InstallShield Wizard contains step-by-step instructions explaining each task you perform to install MPMS MultiVu. When the InstallShield Wizard is set up, the Welcome screen appears.
8. Read the instructions in the Welcome screen, and then select Next.
9. Read the software license agreement, and then select Yes. You must accept the software license agreement in order to install MPMS MultiVu.
10. Select the folder into which the setup program installs MPMS MultiVu if you do not want to use the default folder. Then select Next when you have chosen the folder.
11. Select the program folder to which the setup program adds icons if you do not want to use the default folder. Then select Next when you have chosen the folder.
12. Review the setup information. Select Back if you need to modify any settings.
13. Select Next. The setup program begins to copy files to the specified folder.
14. Insert MPMS MultiVu Disk 2 into the PC when you are prompted to do so.
15. Insert MPMS MultiVu Disk 3 into the PC when you are prompted to do so.
16. Select Yes to create an icon for the MPMS MultiVu simulation mode.
17. Install the calibration files. Either (a) insert the disk containing the files and then select OK, or (b) select the directory containing the files. If you do not have the calibration files, select Enter and ignore the pop-up warning; default values will be used for the calibration factors.
18. Select Finish when the setup program has copied the calibration files. Installation is complete.

A.3.4 Change the EPROMs

1. Change the firmware EPROM in the Model 1822 MPMS Controller as follows: (a) remove the EPROM that is in slot U27 on the CPU board, and then (b) insert the new EPROM, version 3.21 or higher, into slot U27 on the CPU board. Refer to Quantum Design Service Note 1014-806, *Replacing the Hardware Configuration Option EPROM on the 1822*. The new EPROM is compatible with the MPMSR2 DOS code.
2. Change the firmware EPROM in the Model 1802 Digital R/G Bridge as follows: (a) remove the EPROM that is in slot U27 on the CPU board, and then (b) insert the new EPROM, version 3.21 or higher, into slot U27 on the CPU board. Refer to Quantum Design Service Note 1014-806. The new EPROM is compatible with the MPMSR2 DOS code.

A.3.5 Update the Calibration Files

1. Open the MPMSR2 DOS software.
2. Generate a sequence that sets all calibration factors.
3. Open the MPMS MultiVu application.
4. Select Utilities►Convert Sequence. Use the Convert Sequence File utility to convert the MPMSR2 DOS sequence to the MPMS MultiVu sequence format.
5. Use MPMS MultiVu to run the sequence you have just converted.

A.3.6 Set the SQUID Drive and Tune Levels

1. Select Instrument►SQUID Tune in the MPMS MultiVu interface. The SQUID Tuning dialog box opens (figure 7-4 illustrates the dialog box).
2. Select the appropriate tab for the installed SQUID.
3. Use the Drive text box to specify the value of the SQUID drive level used in MPMSR2 DOS.
4. Select the Drive Set button.
5. Use the Tune text box to specify the value of the SQUID tuning level used in MPMSR2 DOS.
6. Select the Tune Set button.
7. Select OK.
APPENDIX B

Data File Format

B.1 Introduction

This appendix contains the following information:

- Section B.2 presents an overview of the data file format.
- Section B.3 discusses the data file header.
- Section B.4 discusses the data section in the data file.
- Section B.5 discusses the data types.

B.2 Overview of Data File Format

Every data file consists of two main sections: the header and the data section. The data file header defines the type of data file and the type of data stored in the file. The header also defines the file’s default graph format. The data section lists the actual data stored in the file. Data file headers contain the identical type of information. Data sections list data that is specific to the measurement option that generated the data and to the type of data the file stores.

The format of the data files is designed such that the files may be easily imported by other graphic applications, such as Microsoft Excel. The data file format is comma delimited.
B.3 Data File Header

The data file header is created when the data file is created and can never be overwritten.

The header is preceded by the following bracketed keyword:

[Header]

The Title line contains the string that appears at the top of the graph view of the data file.

TITLE, MPMS DC Measurement

The ByApp line specifies which application and measurement option created the file.

BYAPP, MPMS Measurement, 1.0, Summary

The FileOpenTime line indicates the numerical timestamp and the timestamp’s formatted text of the time at which the file was created.


The Info lines supply additional information about the measurement. MPMS MultiVu does not use this information when it plots the data.

INFO, NAME, My Sample
INFO, WEIGHT, 1.000
INFO, AREA, 1.000
INFO, LENGTH, 1.000
INFO, SHAPE, 0
INFO, COMMENT,
INFO, SEQUENCE FILE: Pause.MV.Seq

The StartupAxes lines specify which two axes are displayed in the graph view of the data file and which data item is assigned to each axis. The StartupAxes lines also specify whether data is scaled logarithmically or linearly, whether the axis is scaled automatically or manually, and the minimum and maximum values for the axis.

STARTUPAXIS, X, 4, LINEAR, AUTO, 0.000000, 0.000000
STARTUPAXIS, Y1, 5, LINEAR, AUTO, 0.000000, 0.000000

The StartupGroup line specifies which field group is the default group for the graph data selection.

STARTUPGROUP, Longitudinal

The FieldGroup lines specify which data selection items are included in each field group and list the data items in the numerical order of their appearance in the file.

FIELDGROUP, Longitudinal, 1, 2, 3, 4, 5, 6, 7, 8, 9 19
FIELDGROUP, Transverse, 1, 2, 3, 4, 10, 11, 12, 13, 14 19

The PlotAppearance line specifies the plot appearance of the graph view of the data file.

PLOT_APPEARANCE, ALL, HORZ_GRID_ON, VERT_GRID_ON, MARKERS_AND_LINES
B.4 Data Section

The data section is preceded by the following bracketed keyword:

[Data]

The data section keyword is immediately followed by one line specifying the titles to be used for the data fields for every line of data that follows. Each different data file may specify a different list of fields that are appropriate for the type of measurement data stored in the file.

B.4.1 Data Section Field Names in Each Type of Data File

Helium Data File: heliumgr.dat

Time, Helium Level

Environment Log File: FileName.env

Time, Temperature (K), Field (Oe), Helium Level (%), Impedance, Heater, Driver2 Select, Helium Meter (V), High Res. Current (V), Low Res. Current (V), TC gauge (V), Not Assigned (V), Long. SQUID (V), Trans. SQUID (V), External Input (V), Bridge 1 (K), Bridge 2 (K), Bridge 3 (K), Bridge 4 (K), Driver 1 (mW/ohm), Driver 2 (mW/ohm), Dewar Pres. (kPa),

DC Measurement Data File: BaseName.dc.dat

Time, Comment, Field (Oe), Temperature (K), Long Moment (EMU), Long Std Dev, Long Algorithm, Long Reg Fit, Long Percent Error (%), Trans Moment (EMU), Trans Std. Dev, Trans Algorithm, Trans Reg Fit, Trans Percent Error (%), Points per Scan, Number of Scans, Scan Length, Delta Temp (K), Rot Position, Error, EC Comp. Running,

DC Diagnostic Data File: BaseName.dc.diag

Time, Comment, Field (Oe), Average Temperature (K), Target Temperature (K), Long Moment (EMU), Long Analysis, Long Range, Long Gain, Long Filter, Long Voltmeter Gain, Long Digitizer Rate, Trans Moment (EMU), Trans Analysis, Trans Range, Trans Gain, Trans Filter, Trans Voltmeter Gain, Trans Digitizer Rate, Start Temperature (K), Delta Temperature (K), End Temperature (K), Scan Length, Number of Points, Number of Scans, Scans Rejected, High Resolution Mode, Hysteresis, SQUID Number, Digitizer Readings, Helium Level (%), Rot Pos,
DC Raw Data File: BaseName.dc.raw and BaseName.dc.lastscan

Time, Comment, Field (Oe), Start Temperature (K), End Temperature (K), Scan, Rejected, Position (cm), Rot Position, Long Voltage, Long Average Voltage, Long Detrended Voltage, Long Demeaned Voltage, Long Regression Fit, Long Detrended Fit, Long Demeaned Fit, Long Moment (EMU), Trans Voltage, Trans Average Voltage, Trans Detrended Voltage, Trans Demeaned Voltage, Trans Regression Fit, Trans Detrended Fit, Trans Demeaned Fit, Trans Moment (EMU),
B.5 Data Types

B.5.1 Numerical Data

Numerical data in a data file may be stored in any standard floating point or integer format with the fields separated by commas. Note, however, that when data is read from the file, any floating point number that is read into an integer variable is truncated.

B.5.2 Strings

Strings are not delimited by quotation marks, apostrophes, or commas. Furthermore, only one string should be assigned to each line and no other fields should be on that line. In this format, strings may then contain any punctuation and can be entered by the appropriate line-entry command in the language of choice.

B.5.3 Boolean

Boolean variables should be represented as integers 0 or 1, where 0 indicates FALSE and 1 indicates TRUE.

B.5.4 Additional Information

This section describes some of the data file fields in more detail.

High Res Mode Enabled (Boolean):

0 = Disabled
1 = Enabled

This only returns the software status and does not reflect the fact that above 5000 G the system charges the magnet with the Low Resolution resistor.

Rotator Position:

If the rotator option is not installed, 0 is always returned.

Hysteresis:

0 = Magnet is persistent
1 = Magnet is not persistent

SQUID Number:

2 = Transverse
1 = Longitudinal
Range + (X_Range * 10):
  Range is an integer:
    0 = X1
    1 = X10
    2 = X100
    3 = X1000
  X_Range is a Boolean:
    0 = OFF
    1 = ON
  Values for "Range + (X_Range * 10)" are
  Extended range OFF = 0, 1, 2, 3
  Extended range ON  = 10, 11, 12, 13

Gain (Integer):
  0 = X1
  1 = X2
  2 = X5
  3 = X10

Voltmeter Digitizer Gain:
  See Gain

Filter (Integer):
  0 = 20,000 Hz (AC or RSO)
  1 = 5000 Hz (AC or RSO)
  2 = 1200 Hz (AC or RSO)
  3 = 100 Hz
    = 80 Hz (AC or RSO)
  4 = 10 Hz
  5 = 1 Hz
    = 5 Hz (AC or RSO)
  6 = Elliptical
  7 = None

Rate (Integer):
  1 = 60 Hz
  2 = 180 Hz

Scan Type (Integer):
  1 = Full scan
  2 = Linear regression
  3 = Iterative regression


———. 1996. Service note 1014-806, Replacing the hardware configuration option EPROM on the 1822.
Index

7-tesla magnet calibration factors, 7-8
  default values, 7-9
  sequence commands, 6-26
AC sample measurement, 3-2
Active sequence, 5-3
Adjust Position command, 6-18
Autoranging
  caution against disabling, 3-8, 3-13
  definition, 3-6, 6-21, 8-3
  in immediate mode, 8-2–8-3
  sequence command, 6-21
Auto Reset command, 6-34
Autoscanning, definition of, 6-22, 8-3
Autotracking
  affect on sample transport initialization, 3-7
  caution against disabling, 3-8, 3-13
  definition, 3-6, 6-36
  in immediate mode, 8-11–8-12
  sequence command, 6-36
Bridge channel diagnostics. See Model 1802: Bridge channel diagnostics
Calibration factors
  avoiding changing, 6-22, 7-7
  default values, 7-9
  sequence commands, 6-22–6-26
  standard, list of, 7-8
Centering measurement. See also Sample measurement computing magnetic moment from. See Measurement algorithms
description, 3-9, 3-10
parameters, 3-6
procedures, 3-7–3-11. See also Center sequence commands
running prior to sample measurement, 3-6, 6-18
saving data from, 3-9. See also Scan data files
types, 3-6. See also Full centering measurement; Partial centering measurement
Center sequence commands, 6-18–6-19
Chamber diagnostics. See Gas system diagnostics
Chamber status panels
data in, 2-9
  in illustration of status bar, 2-7
CmdList.seq file, 5-12
Command list sequence file, 5-12
Control center
  and controlling sequence operation, 2-6, 5-7
  illustration of, when sequence is running, 5-7
  opening, 2-6, 2-7
Control loop operation, 6-7–6-8. See also Autoscanning;
  Scan Field command; Scan Rotation command;
  Scan Temperature command
Data files
  data-viewing formats, 2-9, 4-1, 4-14. See also Graph view; Raw data view; Record view; Table view
default directory for, 4-3
  file extension identifying type of, 4-2–4-3
  format, 4-1–4-2, B-1, B-5. See also Data section;
  Header
  identifying active, 2-6, 2-7, 4-4
types, 4-1, 4-5. See also Diagnostic data files; EDC
data files; Environment log files; Field profile scan files; Helium data file; Measurement data files;
Raw data files; Scan data files
Data points, minimum number of
  calibration factor setting, 7-8
  default value, 7-9
  sequence command, 6-23
Data points parameter, definition of, 3-6
Data section, in data file
  field names in, example of, B-3–B-4
  listing stored data, 4-1, B-1
.dat files. See Measurement data files
DC Center command, 6-18
DC Parameters command, 6-18–6-19
DC sample measurement. See Sample measurement
.diag files. See Diagnostic data files
Diagnostic data files
  association with single measurement data file, 4-7
  creating, 4-7, 4-9, 4-10
  as sample measurement data file, 4-5
  storing data from multiple scans, 4-5, 4-7
Diagnostics
  in immediate mode, 8-1–8-15
  sequence commands, 6-21–6-39
Driver channel diagnostics. See Model 1802: Driver channel diagnostics
Index

EDC data files, 4-5, 4-8
End Scan command, 6-7, 6-8
End Sequence command, 5-4, 6-2
.env files. See Environment log files
Environment log files. See also Logging data
creating, 4-11–4-12
storing time-based parameters, 4-7–4-8
Extended-range calibration factor, 7-8
default value, 7-9
sequence command, 6-23
Error messages, configuring, 7-10
Event log files, 7-11
EverCool status data, in chamber status panels, 2-9
Field-penetration calibration factor, 7-8
default value, 7-9
sequence command, 6-23
Field profile scan files, 4-5, 4-8
Field status panels
data in, 2-8
in illustration of status bar, 2-7
Full centering measurement
parameters, 3-6, 3-8
running, 3-9. See also Full DC Scan command
using full scan algorithm, 3-9
Full DC Scan command, 6-19
Full scan algorithm
definition, 3-15, 3-16
during full centering measurement, 3-9, 3-15, 3-16
suggested use, 3-15, 3-16
Gas system diagnostics
in immediate mode, 8-3–8-4
sequence commands, 6-26–6-28
settings, list of, 8-4
.gph file. See Graph configuration file
GPIB diagnostics, 8-7
Graph configuration file
automatically saving graph format, 4-4
default file defining graph view, 4-14
restoring current, 4-19
Graph template file
applying to graph view, 4-13
creating, 4-13
as user-created template, 4-4
Graph view
as default viewing format, 4-14
in illustration of MPMS MultiVu interface, 2-2
magnifying, 4-19
modifying appearance, 4-17
plotting specified data points, 4-14
printing, 4-13
restoring default, 4-19
selecting parameters plotted in, 4-18–4-19
with two plots, illustration of, 4-14
Header, in data file
defining default graph format, 4-1, 4-17, B-1
defining file type, 4-1, B-1
lines in, example of, B-2
Helium data file, 4-5, 4-7, 7-5
Heliumgr.dat file. See Helium data file
Helium level meter, minimizing time turned on, 6-27, 8-4
Helium transfer, monitoring, 7-5
Hysteresis approach mode, suggested use of, 6-12, 7-2
Immediate mode
centering measurement in, procedures for, 3-7–3-11
definition, 1-1–1-2
sample measurement in, procedures for, 3-12–3-14
Impedance heater operating modes, 6-27
Initialize Transport command, 6-19
Installation. See MPMS MultiVu: Installing
Iterative regression algorithm
default algorithm during partial centering measurement,
3-9, 3-15, 3-16. See also Linear regression
algorithm
definition, 3-15
suggested use, 3-15, 3-16
.lastscan file. See Scan data files
Low-temperature heater factor, 7-8
default value, 7-9
sequence command, 6-25
Linear regression algorithm
definition, 3-15, 3-16
substituting for iterative regression algorithm, 3-9,
3-14, 3-15, 3-16
suggested use, 3-15, 3-16
Logging data, 7-6–7-7. See also Environment log files;
Start Data Logging command; Stop Data Logging
command
Logging system messages, 7-11
Magnet
7-tesla, calibration factors for. See 7-tesla magnet
 calibration factor, 6-22, 7-8, 7-9
correcting field-intensity data from, 6-33, 7-6, 8-9
diagnostics
effect of misuse, 6-31, 8-8
in immediate mode, 8-8–8-9
parameters, list of, 8-8–8-9
sequence commands, 6-31–6-33
resetting, 6-33, 7-6
Magnet polarity modes, 6-32
Magnetic field
approach modes, suggested use, 6-12, 7-2
avoiding changing when helium is low, 6-10, 7-2
resolution modes, definition of, 6-12
setting, 7-2. See also Set Field command
stabilizing series of, 6-10–6-12
status, displayed in field status panels, 2-7, 2-8
Magnetic moment calibration, determining, 3-1
Measure DC command, 6-20
Measurement. See Sample measurement
Measurement algorithms. See Sample measurement algorithms, summary of functions, 3-15
Measurement data files
  creating
to store immediate-mode data, 4-9
to store sequence data, 4-10–4-11
determining name of active files, 4-2, 4-6
as sample measurement data file, 4-5
storing option-specific measurement data, 4-5, 4-6
Measure sequence commands, 6-20–6-21
Menus, in MPMS MultiVu, function of, 2-1, 2-3. See also Tool bar buttons: Equivalent menu commands
Message display, configuring, 7-10
Model 1802
  bridge channel diagnostics
    in immediate mode, 8-2–8-3
    parameters, list of, 8-3
    sequence commands, 6-21–6-22
  driver channel diagnostics
    in immediate mode, 8-5–8-6
    parameters, list of, 8-6
    sequence commands, 6-29–6-31
Move Sample command, 6-9–6-10
MPMS MultiVu
  activating options in, 7-12
  automating system operation. See Sequence files:
    Automating system operation
  installing, A-1–A-3
  interface, illustration of, 2-2
  logging system messages generated by, 7-11
  as MDI Windows application, 2-1
  message display, configuring, 7-10
  new features, 1-2
  overview, 1-1–1-2
  starting up, 1-3
  system messages, list of, 7-10
  as Windows 95 application, 1-1
MPMSR2 DOS files, converting to MPMS MultiVu format, 1-2, 7-12
No-overshoot approach mode, suggested use of, 6-12, 7-2
Options, activating, 7-12
Oscillate approach mode, suggested use of, 6-12, 7-2
Output range, for driver channel, 6-30, 8-6
Oven calibration factor, 7-8
  default value, 7-9
  sequence command, 6-24
Partial centering measurement
  defined by user-set parameters, 3-6, 3-8
  importance of prior to sample measurement, 3-6, 3-12
  running, 3-9. See also DC Center command; DC Parameters command
  using iterative regression algorithm, 3-9
PID commands, 6-30, 6-31, 8-6
Pop-up menus, opening, 2-3
Raw data files
  association with single measurement data file, 4-7
  creating, 4-7, 4-9, 4-10
  as sample measurement data file, 4-5
  storing raw voltages from multiple scans, 4-5, 4-7
Raw data view, 4-16
   .raw files. See Raw data files
  Raw measurement data, definition of, 3-1
Record view
  listing parameters for single data point, 4-15
  selecting data point for, 4-14, 4-15, 4-16
Regression calibration factor, 7-8
  default value, 7-9
  sequence command, 6-23
Remark command, 6-10
RSO sample measurement, 3-2
Run Sequence command, 6-10
Sample
  attaching to sample rod, 3-2
  centering, procedures for, 3-6–3-11
  inserting in sample chamber, 3-3–3-5
  name of installed, displayed in control center, 2-6, 5-7
  parameters, defining, 3-5, 5-8
Sample chamber atmosphere, controlling, 7-3
Sample measurement. See also Centering measurement;
  Sample computing magnetic moment from. See Measurement algorithms
  considerations during, 3-17
  description, 3-1, 3-14
  procedures
    in immediate mode, 3-12–3-14
    in sequence mode, 5-8–5-10
  saving data from, 3-13, 3-14, 5-9. See also Sample measurement data files
  using parameters from partial centering measurement, 3-12, 5-8
Sample measurement data files, 4-5. See also Diagnostic data files; Measurement data files; Raw data files; Scan data files
Sample transport
  diagnostics
    in immediate mode, 8-11–8-13
    motor configuration parameters, 8-13
    movement control commands, 8-12
    sequence commands, 6-36–6-38
    initializing, 3-7. See also Initialize Transport command
  moving with Move Sample command, 6-9–6-10
Scan commands. See also Scan Field command; Scan Rotation command; Scan Temperature command
  and control loop operation, 6-7–6-8
  performing multipart tasks, 6-7
Scan data files
  association with single measurement data file, 4-6
  as sample measurement data file, 4-5
  storing raw voltages from most recent scan, 4-5, 4-6
Index

Scan Field command
parameters, 6-11–6-12
pausing sequence run, 6-9, 6-10
as scan command, 6-7, 6-9, 6-10
stabilizing series of magnetic fields, 6-10
Scan length parameter, definition of, 3-6
Scan parameters
list of, 3-6
using identical for partial centering and sample measurements, 3-12, 5-8
Scan Rotation command
parameters, 6-13–6-14
as scan command, 6-7, 6-9, 6-13
Scan Temperature command
parameters, 6-14–6-15
pausing sequence run, 6-9, 6-14
as scan command, 6-7, 6-9, 6-14
setting series of temperatures, 6-14
Selected sequence
definition, 2-6, 5-3
identified in MPMS MultiVu interface, 2-6, 2-7, 5-3
opening, 5-4, 5-5, 5-11
Sequence command bar
displaying, 5-2
listing sequence commands, 2-9, 5-1, 5-2, 6-1
Sequence commands
modifying parameters of, 5-5
in sequence command bar, 2-9, 5-1, 5-2, 6-1
similarities with menu options, 6-2
types, 5-1, 6-1. See also Center sequence commands;
Diagnostic sequence commands; Measure sequence commands; System sequence commands
Sequence editor
duplicating active, 5-2
in illustration of MPMS MultiVu interface, 2-2
listing commands in sequence file, 2-9, 5-1, 5-2
Sequence files. See also Sequence command bar; Sequence editor
automating system operation, 5-1
creating, 5-4
default directory, 5-4
editing, 5-4–5-5. See also Sequence run: Editing paused
locking status, 5-6
naming conventions, 5-3
printing, 5-5
running, example of, 5-8–5-10. See also Sequence run:
Performing partial
Sequence mode
centering measurement in, 5-8
definition, 1-1–1-2
sample measurement in, procedures for, 5-8–5-10
Sequence run
aborting, 5-10
editing paused, 5-11–5-12
initiating, 5-10
performing partial, 5-11
Sequence Status dialog box
and editing paused sequence run, 5-11–5-12
listing commands in active sequence, 5-10, 5-11
opening, 5-10, 5-11, 5-12
Sequence status, displaying
in control center, 2-6, 5-7, 5-10
in status bar, 2-7, 5-10
Sequence status panels, 2-7
Serial port diagnostics, 8-9
Set Datafile command
changing data files during sequence run, 4-4, 6-21
using, example of, 4-10–4-11
Set Field command
parameters, 6-16
pausing sequence run, 6-9, 6-16
Set Temperature command, 6-16
Set Temperature Undercool command, 6-16
Settle approach mode, suggested use of, 6-15
Settle time calibration factor, 7-8
default values, 7-9
sequence command, 6-23
Slide seal clamps, illustration of, 3-3, 3-4
SQUID
calibration factors, 7-8
default values, 7-9
sequence commands, 6-23
diagnostics
in immediate mode, 8-10–8-11
sequence commands, 6-33–6-35
tuning, 7-3
SQUID parameters
list of, 3-6
using identical for partial centering and sample measurements, 3-12, 5-8
Standby mode, entering, 7-5
Start Data Logging command, 6-35
Status bar, 2-7–2-9
Stop Data Logging command, 6-35
Sweep approach mode, suggested use of, 6-15
System operation, automating. See Sequence files:
Automating system operation
System sequence commands, 6-9–6-17. See also Scan commands
Table view
function, 4-16
opening, 4-14, 4-16
Temperature
approach modes, suggested use, 6-15
calibration factors, 7-8
default values, 7-9
sequence commands, 6-24–6-25
calibration factor, 7-8
default values, 7-9
diagnostics
in immediate mode, 8-10–8-11
sequence commands, 6-33–6-35
tuning, 7-3
status
displayed in Temperature Control dialog box, 8-15
displayed in temperature status panels, 2-7, 2-8

Index-4
Temperature status panels
data in, 2-8
  in illustration of status bar, 2-7
Thermometer consistency tolerance, 6-25, 7-8
Thermometer translation files, downloading, 8-2
Tool bar buttons, in MPMS MultiVu
  equivalent menu commands, 2-5
  function, 2-1, 2-4
.tpl file. See Graph template file
Transverse Rotator Steps/Degree calibration factor, 7-8
  default value, 7-9
  sequence command, 6-23

Virtual bridge channels, on Model 1802, 8-2
Voltmeter diagnostics
  in immediate mode, 8-14
  sequence commands, 6-38

Wait For command
  conditions affected by, 6-17
  pausing sequence run, 6-9, 6-17